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About this Manual

Purpose

This manual is a referencemanual to Xedio CleanEdit.

It should provide you with general contextual and conceptual information, as well as
detailed descriptive information on the various features available in Xedio CleanEdit.

This referencemanual will include procedural information onmore complex actions, even
though not systematically. However, it will not contain procedures on simple or usual
actions, which should be covered by video tutorials.

Sections on Main Areas on the User Interface

The following table shows where you can find detailed information on the various areas of
the user interface:

User Interface Area See Section...

Project area – its four zones "Managing Projects and Project Elements"
on page 40.

Work area – Edit tab "MainWorkspace for Editing" on page 61.

Work area – VoiceOver tab "Adding Voiceover" on page 201.

Work area – Text tab "Adding Integrated Text andGraphics or
Subtitles" on page 214.

Work area – Header Maker tab "Header Maker" on page 230.

Work area – Scheduler tab See Xedio Ingest Organizer user manual.

Work area – Control VTR tab See Xedio Ingest Organizer user manual.

Work area – Playout tab "Playing Out an Edit" on page 234.

Work area –MediaManager, Edit
Manager, Project Manager

"Searching for andManagingMedia" on
page 24.

Work area – Export tab "Exporting an Edit or aMedia" on page 237.

Work area –Media Importer tab "ImportingMedia" on page 21.

Work area – Devices tab "Editing in Place" on page 170.

Work area – Task Viewer tab "Monitoring Tasks" on page 248.
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What's New?
In the user manual, the icon has been added on the left margin to highlight
information on new and updated features.

The sections updated to reflect the new andmodified features on Xedio CleanEdit from
Xedio Suite 4.40 (compared to Xedio Suite 4.35) are listed below.

Active Directory integration

The Xedio workstationmay be integrated into an Active Directory domain.

• See section "Starting CleanEdit" on page 5.

Advanced Video Editing

A new video clip effect has been added: Blur.

• See section "Video Clip Effects With Key Frames" on page 162.

• See section "Adding Key Frames for an Effect" on page 164.

Graphics, logos and integrated text and graphics (CG)

Possibility to quickly duplicate tags (logo or graphic) and CG tags.

• See section "Duplicating a Tag" on page 213.

• See section "Possible Actions from the Page List Tab" on page 229.

Integration of subtitles

The Character Generator tool can be used to import subtitles files into an edit.

• See section "Text TabOverview" on page 215.

• See section "Importing a Subtitle File" on page 226.
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1. Introduction

1.1. General Description
Xedio CleanEdit is a non-linear editing system offering full integration with remote
camcorders – Sony XDCAM™, XDCAM EX™and Panasonic P2™ in SD and HD. Xedio
CleanEdit enables journalists to edit stories in standard and high-definition from remote
locations. As soon as the editor is back in the newsroom, the edit can be shared through
this integrated news production system. In addition, Xedio CleanEdit can be operated
remotely on a laptop or installed on a PC.

1.2. Main Window

Illustration

The CleanEdit user interface contains the areas highlighted on the screenshot below.

Each zone contains well defined functions in the workflow of the CleanEdit application.
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Area Description

The table below describes the various parts of the CleanEdit window:

Part Name Description

1. Project area See section "Zones in the Project Area" on page 2.

2. Work area See section "Tabs in theWork Area" on page 4.

Note
The color of some user interface elements may vary with the Xedio skin
installed.

1.3. Zones in the Project Area
The left hand part of the interface is called the Project area. Its function is to permit the
user to manage a project and all the elements within the projects, multiple edits, media
used within the project and clips andmedia used on the timeline of edits within the project.

The Project area contains the projects created by the logged-on editor. The Project area is
divided into four zones to sort the different elements of each project:

• TheProject zone contains a list of the projects for the logged on user. The open
project is displayed in bold characters.

• TheMedia zone contains the original media files that are used in the open project. The
media loaded is displayed in bold characters.

• TheEdit zone contains the list of edits that have been created on the open project.
The edit loaded is displayed in bold characters.

• TheClip zone contains list of clips stored in preparation for the edit.

2 1. Introduction
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Each project only contains the elements that have been deemed to be relevant to it. The
ability to access elements from anywhere in the database of an installation and declare
them relevant to a project, to allow sharing of media amongst several workstations, is a
fundamental part of the structure of CleanEdit.
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1.4. Tabs in the Work Area

Introduction

TheWork area has tabs for themodes that the user could be working in, such as timeline
or voiceover modes used in the edit process, or other modes which are for other areas of
the CleanEdit workflow, frommedia ingest and import, to playout as video, or rendering a
completed edit to one specific format for the use of another system.

Note
The number of tabs displayed in theWork Area depends on options purchased,
which allows the customers to have a system customized to their requirements
and avoid workingmodes that are not needed in their workflow.

Selecting a Tab in the Work Area

Any tab in theWork area is automatically selected by placing themouse over a tab at the
top of theWork area until the tab becomes visible or by clicking the tab.

4 1. Introduction
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2. The Basics

2.1. Introduction
This part will guide you through a simple workflow for the CleanEdit application to produce
a simple edit, and either play it out from the application or create a standard file for use or
playout by another system.

The steps are:

1. See section "Starting CleanEdit" on page 5.

2. See section "Opening a New Project" on page 6.

3. See section "FindingMedia for the Project" on page 7.

4. See section "AddingMedia to the Project" on page 11.

5. See section "RefiningMedia Into Clips" on page 12.

6. See section "Placing Clips onto the Timeline" on page 14.

7. See section "Checking the Edit" on page 16.

8. See section "Playing out or Exporting an Edit" on page 17.

Each step is described at its most basic only using on screen controls. Any keyboard
shortcuts, which could be used, will be detailed in the following chapters.

The edit created using the techniques in this chapter will be video with associated audio
clips only and edited with a cut as the transition.

2.2. Starting CleanEdit
To start the CleanEdit application, select the application from Start > Programs >
EVS Broadcast Equipment or click on theCleanEdit icon on the desktop.

The Xedio workstationmay be integrated into an Active Directory domain. In this case,
Xedio CleanEdit will automatically open without requesting additional access codes when
the user starts it.

The user group the user belongs to in theWindows domainmust be linked to a user role in
XedioManager. This determines the set of user rights and user settings the user will have
in the application. In case a user belongs to several Windows groups, the system retrieve
them in alphabetical order and checks whether the first groupmatches a user role. The
use of Windows authenticationmust have been enabled in XedioManager. See the Xedio
Manager user manual for more information.

In case the auto-log off mode is activated and theWindows authentication by Active
Directory mode is used, the auto-log off becomes an auto-quit function.
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If the Xedio workstation is not integrated into an Active Directory domain, a login screen
will display, where users have to enter their own Xedio username and password.

Note
The system administrator creates login names and passwords in the Xedio
Manager application. Please refer to that product user manual for more details.

2.3. Opening a New Project

Initial Window Display

On startup, the application will open as shown below with logos in the video windows and
all buttons disabled, showing an inactive state. There will be names in the Project zone if
this login has been used to previously work on a Project.

Project Definition

A project, in the Xedio environment, is a kind of workspace for a given story. It is a flat
structure. A project always belongs to 0 or 1 user. A project cannot be shared between
users (duplicate is mandatory in this case).

How to Create a New Project

See sections "Creating a New Project" on page 44 and "Opening an Existing Project" on
page 43.
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2.4. Finding Media for the Project

2.4.1. Making Media Available in Xedio CleanEdit
During this workflow, it will be assumed that themedia is available in Xedio CleanEdit. To
be available in Xedio CleanEdit, themedia needs to be "imported" into Xedio CleanEdit
and set to "Publish", in other words defined in the Xedio database. A media which is not
published is only visible through XedioManager, Xedio Browse and Xedio Approval.

Importingmedia into CleanEdit can be done, among others, via theMedia Importer. See
section "ImportingMedia" on page 21 for more information. Importingmedia always
implies that themedia is defined in the Xedio database but does not always mean that it is
physically imported to the Xedio storage system.

Other ways to import or reference a new media in Xedio are: XTAccess, IPDGateway,
Xedio Dispatcher, and Xedio AutoFileImporter.

2.4.2. Where to Find Media in Xedio CleanEdit
TheMediaManager tab in theWork area is used to bring themedia that is defined in the
database into a project.

Note
The XT clips are listed with the other media in theMediaManager tab.

You will search themedia in this tab, then drag and drop it to theMedia zone of your
project.

You will find below a general description on themedia that can be available in this tab.

You will findmore details on the search filters available and possible operations in the
MediaManager tab in the section "Searching for andManagingMedia" on page 24.

TheMediaManager tab lists themedia available in Xedio CleanEdit.

Themedia listed are all the publishedmedia that have the correct bitrate.

This can be:

• video, stills (full frame or with a key layer) and audio files imported via the Xedio
Importer or theMedia Importer tab from an external storage system. Themetadata
related to the file is added at the time of import or recording. For more information, refer
to the Xedio Importer user manual.

• media files imported via the Xedio Importer or theMedia Importer tab from a Sony
XDCAM or XDCAM EX or Panasonic P2 cameras.

• clips referenced in the Xedio database and physically stored an XT or XS server on
the network.
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• clips transferred from XFile, XStream, XTAccess or IPD Gateway

• media files ingested from the Xedio encoders using the Xedio Ingest Organizer

• media files imported automatically via the Xedio AutoFile Importer.

Note
Xedio CleanEdit can work with high resolution and low resolutionmedia. There
is no restriction on the resolution of the low resolutionmedia.
The default video resolution for proxy video browsing, editing and encoding is
specified in the Software parameters > General > General tab in XedioManager.

2.4.3. Viewing Media Before Adding it to the
Project
When you want to view any media available on these tabs prior to adding it to theMedia
zone of a project, select the requiredmedia and double-click on it. The CleanEdit Media
Player window will open with familiar controls to view thematerial:

A section of themedia could be selected here to be placed onto the timeline. However,
this is more usual to take the wholemedia into a project and select sections of themedia
using the right media display in the Edit tab, which is called the Player area. See section
"Player Pane" on page 62 for more information.
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2.5. Creating an Edit
You first need to create a new edit or open an existing edit before you can addmedia to the
timeline related to a given edit, or add effects on the timeline.

Right-clicking in the Edit zone opens a contextual menu. When you select New in this
menu, a New Edit dialog box is displayed, which allows you to create a new edit.

You can accept the default name or enter a new name. A description and other metadata
can be saved with the Edit definition into the database. You will find detailed information
on the fields in the New Edit window, in the section "Creating an Edit" on page 51.

When you validate the new edit definition clickingOK, the edit characteristics are
recorded in the database.

When an edit is active (open), its name is displayed in bold in the Edit zone and the
timeline buttons are enabled.
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2.6. Adding Media to the Project
When you have identified themedia required in the database using theMediaManager
tab, you can add it to your media, to your edit, or directly to the timeline by clicking on it
and dragging it onto one of the Project sub-zones.

Each drag action produces a different result. The possible actions are explained in the
table below.

Note
If you do not want to place themedia directly in the timeline, ensure that the Fill

button is not active .
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Adding the media to the project, without further action

Drag and drop themedia to theMedia zone.

Adding the media to your project and in the Clip zone, but not to the timeline

Drag and drop themedia to the Edit zone or Clip zone without activating the Fill button.

Adding the media to your project, in the Clip zone, and placing it at the end of the
timeline

Activate the Fill button, then drag and drop themedia to the Clip zone.

2.7. Refining Media Into Clips
Tomark clips from themedia in a project, it is necessary to view themedia in the Player
window on the Edit tab.

Once you are in the Edit tab, proceed as follows to view themedia andmark sections for
inclusion on the timeline:

1. Select the requestedmedia from theMedia zone and double-click on it or drag it to the
Player window. It will open in the Player window.

12 2. The Basics
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2. Play themedia using

◦ the transport controls on the panel,

◦ the keyboard shortcuts or

◦ the optional remote control panel (ShuttlePRO).

3. Mark an IN point by clicking on the button on the panel.

4. Optionally, add a name for the clip in the text field.

5. Mark anOUT point by clicking on the button on the panel.

The duration of the clip will then be displayed.

The top area represents the whole length of the original media.

The current position within the clip is shown by a bluemarker.

The IN point is displayed below the Player window as a greenmarker.

TheOUT point will be represented by a redmarker line.

See section "Overview" on page 62 for more information on these items.

Note
IN andOUT points can bemoved by selecting themarks on themedia bar and
dragging them to the required position, or by typing directly the timecode fields
besides themark IN andmark OUT buttons.
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2.8. Placing Clips onto the Timeline

Introduction

There aremany different ways to add clips onto your edit. Themainmethods for placing a
clip to your edit are one of the following:

• Dragging the clip into the Clip zone when the Fill button (next to the Editing
buttons in the timeline area) is active.

This adds the clip to the end of the timeline.

• Dragging the clip from the Clip zone to a given position in the edit.

• Dragging the clip from the Player to a given position in the edit.

You will find comprehensive information on the various ways to place clips into an edit in
the section "Placing Clips onto the Timeline" on page 118.
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Marking Position on the Timeline

Using the buttons displayed on the screenshot below, you canmark points to edit
accurately on the timeline. You can use thesemarks to place your clips into the timeline.

The followingmarks can be defined in the timeline:

Name Description To define the mark, …

Nowline Blue vertical line, which
displays the current position on
the timeline.

click on the timeline ruler where you
want to place the nowline.

Mark IN Green vertical line, which
displays the position of amark
IN point.

place the nowline at the requested
position and click theMark IN button

.

Mark OUT Red vertical line, which
displays the position of amark
OUT point.

place the nowline at the requested
position and click theMark OUT
button .
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Mode to Place the Clip onto the Timeline

Before you drag a clip onto the timeline, you need to define the way you want to insert it.
Twomodes are available: Overwrite or Insert.

You select themode by clicking theOverwrite/Insert Mode button, which allows the user
to toggle themode.

Mode Description

Overwrite
(default)

(white)

Adds themedia in the timeline, overwriting the existingmedia
from the selected position. In other words, themedia in the
timeline will be removed from the insertion point by the duration
of the addedmedia.

Insert

(colored)

Adds themedia in the timeline without overwriting existingmedia
and pushes further right the existing elements of the timeline
placed after this position.
In this mode, you can only insert themedia on the clip boundaries
which are common to all selected tracks.

2.9. Checking the Edit

When the edit is completed it is possible to check it. Xedio CleanEdit parses the timeline
for possible errors (lack of video, for example) or missing hi-res files (if this has been set in
XedioManager).

To do so, click theCHECK button.

• If a hole is discovered, a dialogue box opens and gives a time reference on the
timeline for where there is no video.

In this case, theR2B button will not become available.
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• If missing hi-res files are discovered, a dialogue box opens and gives the list of
missing files.

In this case, theR2B button becomes available as soon as you click OK to
acknowledge themessage.

A icon is displayed on each lo-res file on the timeline.

• If a fast motion clip is detected, a dialogue box opens via which you can render the
fast motion clip(s). The transcoding codec used for the rendering of a fast motion clip
is set in XedioManager.

If you chooseNo:

◦ TheCHECK button remains enabled, since not-rendered fast motion clips are still
present in the edit.

◦ TheR2B (ready to broadcast) button remains disabled.

If the edit is checked successfully, theCHECK button will be disabled and theR2B
(ready to broadcast) button will be enabled. See section "Checking the Edit in the
Recorder Pane" on page 90.

2.10. Playing out or Exporting an Edit

2.10.1. Introduction
When an edit has been completed, it can either be immediately played out as video or
rendered to a file type for transfer to another system or used by the other Xedio software
suite.
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2.10.2. Playing out the Edit

Introduction
Playing out an edit consists of "outputting" the edit straight to an SDI connection. The
playout option is therefore available only on workstations equipped with an EVS SDI
output board (PCX2 or PCX3).

You can play out an edit from two different "locations":

• from the Xedio CleanEdit application, via the Playout tab.

You use such a solution when you want to playout some edits individually.

This section will cover the playout from Playout tab.

• from the Xedio Playout Organizer.

You use such a solution when you want to manage several edits in your playout,
and/or when a dedicated playout server is installed on your setup.

This section is covered in the Xedio Playout Organizer user manual.

Both playout solutions cannot be used at the same time on the samemachine because
they would both try to attach to the EVS SDI output board (PCX2 or PCX3).

Playout Process from the Playout Tab

Activating the Playout tab
Move themouse pointer over the Playout tab.

Preloading the edit
You can play an edit whether it is ready to broadcast or not.

To preload the edit for the playout, select the edit from the Edit zone in the Projects area
and drag it anywhere onto the Playout tab work area.

The edit is ready to be played out.
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Playing the edit
To play the edit, you can directly use the usual control commands available on the right
part of the window.

See section "Playout Tab" on page 235 for more information on the Playout tab.

2.10.3. Exporting the Edit to a File

Introduction
This section presents how you can export an edit to a file from Xedio CleanEdit, selecting:

• a format from a list of supported codecs

• a destination.

However, Xedio CleanEdit makes it possible to export the final edit to various destination
types:

• to CleanEdit.

This allows you to consolidate an edit and store it as a single clip in the Xedio storage
system and Xedio database.

• to File

This allows you to export an edit to a file that can be read by an external system.

• to Device

This allows you to export an edit to an external device, either a video tape recorder, or
to an EVS server.

• to Target

This allows you to export an edit and to perform a predefined set of operations for
specific workflows.

See section "Exporting an Edit or aMedia" on page 237 for detailed information.

Export Process to a File
When you use the Export to a File feature, you can export the edit to a file in anMpeg2
format, even if the original edit was in amix of many different file types.

This section gives you an overview on the export process:

Activate the relevant Export type
Move themouse pointer over the Export tab and select the To File sub-tab.
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Load the edit to be exported
You can export an edit whether it is ready to broadcast or not.

Drag and drop the requested edit from the Edit zone to the open export sub-tab. The
information group box, as well as the File Name label, is filled with the information related
to the file.

Specify the Export settings
Specify the destination folder where you want to export the edit to and the codec profile,
which will determine the final format of the edit in the destination folder. See section
"Exporting an Edit or aMedia" on page 237 for more information on the Export tab.

Launch the Export Process
Click theStart button to begin the conversion process.

A progress bar above theStart button allows you tomonitor the progress of the process.

20 2. The Basics

EVSBroadcast Equipment SA Issue 4.40.A - November 2013



3. Importing Media

3.1. Introduction

3.1.1. Product Description
In the Xedio suite, theMedia Importer tool offers a way of acquiringmedia files for use
within the system. Authorized users may import, into the Xedio database, media that have
already been recorded and are in a file format that can be used by Xedio. P2, XDCAM and
XDCAM EX, music, graphics or existingmpeg and dv files are some examples.

Once the files are imported and set to "Publish", they become available in theMedia
Manager.

TheMedia Importer tool is available as:

• a separate application: Xedio Importer

• as amodule built in CleanEdit, and available in theMedia Importer tab.

• as amodule built in XedioManager, and available in theMedia category.

Note
The color of some user interface elements may vary with the Xedio skin
installed.
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3.1.2. Importable Media
When you click theMedia Importer tab, theMedia Importer window is displayed in the
work area, allowing you to select media to import.

Different tabs can be displayed, provided that they have been selected from Xedio
Manager: Softwares > Parameter Profiles.

They are used to set the parameters for the different types of media which can be
imported into the system:

• XDCAM, XDCAMEX, P2 and CANON tabs: to import media files recorded on Sony
XDCAM and XDCAMEX, Panasonic P2 and CANON cameras

• Video/Audio/Stills tab: to import media files, images or audio files

• RTD tab: to import video containing transitions

• EVS Server tab: to import media files available on an EVS video server on the same
network as the Xedio suite. In this case, Xedio does not import the file content into the
Xedio storage system, but creates a reference to the server files in the Xedio
database.

Refer to the Xedio Importer user manual for a comprehensive description of the tabs and
fields.

3.1.3. General Import Process and Mandatory
Fields
The import process is similar in all tabs. However, the file-related information you can
provide depends on the file to import.

Themandatory field names are displayed in red in the user interface as long as you do not
define a value for them.

Warningmessages are also displayed at the bottom of the tab to tell the user which fields
should be filled in.

In each tab and for all import sessions, themandatory steps and information are the
following:

1. Specify where theMedia Importer will find the source files to be imported.

2. Specify the Label field, that is to say the name of themedia when it will be imported
into Xedio CleanEdit.

3. Tick thePublished check box tomake themedia available and visible to all users.

4. Click theStart Import Process button at the bottom of the tab.

Once imported, the files will be available in CleanEdit, in theMediaManager tab.
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3.2. Using EVS Servers' Record Train and
Clips

Possible Actions

You have several possibilities to bring the EVS server material as media or clips into a
project, using the EVS Server tab:

• Drag and drop a recorder channel from the Servers list in the EVS Server tab to the
Media area of a project.

This will make the corresponding record train available in the project as amedia.

• Drag and drop a clip from the Clip/Channel area in the EVS Server tab to the Clips
area of a project.

This will make the corresponding clip available in the project as a clip.

• Import the clips created with the given camera or stored in the given page or bank, as
explained here after.

How to Import Clips From an EVS Server
Importing clips from an EVS Server into Xedio does not physically import the clip in the
media server: it creates a virtual location on themedia server, and stores the clip definition
in the Xedio database. Consequently, the connection to the servers needs to be
operational to be able to access thematerial itself.

It is possible to import all the clips created with a given camera, or stored on a given page
or bank into CleanEdit, to make them available in theMediaManager and Edit Manager
tabs.

To import clips from an EVS server, proceed as follows:

1. Select the requested camera, page or bank in the Server Structure area of the EVS
Server tab.

All the clips created with the selected channel or stored on the selected page or bank
are displayed in the Clip/Channel area.

2. Specify the Label field, that is to say the name of themedia when it will be imported
into Xedio CleanEdit. By default, the clip namewill be taken over.

3. Ensure that thePublish check box is ticked tomake themedia available and visible
to all users.

4. Click theStart Import Process button at the bottom of the window.

Once imported, the files will be available in theMediaManager tab of CleanEdit.
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4. Searching for and Managing
Media

4.1. Introduction
Within theWork Area, there are three tabs designed to quickly find and browse the
corresponding elements present within the database, such as media, edits and projects.

• MediaManager Tab

TheMediaManager tab allows you to quickly find and browse the available media
present in the system. This media can be video (including XT clips), audio or still files.

When the direct access to EVS video servers is used, a Xedio service listens to LinX
notifications sent by those servers. So, the Xedio database is notified and updated
each time a server clip is deleted from a third party (LSM remote, IPDirector,…) or a
growing server clip is closed.

Media can be shared between all users and several workstations, enablingmultiple
accesses to browse, select and import media into any project.

• Edit Manager Tab

The Edit manager tab allows users to see and browse through all edits currently in the
database. Edits can be deleted, or undeleted, and shared between users from this tab.

• Project Manager Tab

The Project manager tab allows users to see and browse through all projects currently
in the database.

Projects can be shared between users to enable several workstations to use the same
media, add new media and even open andmodify edits within the project.

The upper part of theWork area gives access to the different filters which can be applied
to the Elements grid.

At least two tabs exist on the left of theWork area.

• The Filter 0 tab: The Elements grid displays the list of all elements present in the
database, or it returns the result of a search applied to the list.

• The Today tab: the Elements grid shows the elements with "creation date = today".

Warning
Those filters can bemodified by the user, so the results could no longer reflect
the tab label.

Additional tabs are displayed when the users have saved filters applied to the database.
See section "Using Saved Filters" on page 38 for more details.

The grid presents columns to display all metadata associated with the elements.
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4.2. Elements Grid

4.2.1. Sorting the Elements in the Grid
You can change the sort order of elements in the grid by clicking the column header for the
parameter according to which you want to sort the elements.

The blue arrow indicates the sorting order. Clicking the column header again changes the
sorting order from ascending to descending or vice versa.

4.2.2. Organizing Columns

Resizing Columns
A column can be resized by using themouse pointer over columns intersection and
dragging it to the right or to the left.

Selecting Columns to Display
To select the columns to display in the grid, proceed as follows:

1. Right-click the column header area.

A menu is displayed.

2. Select Choose Displayed Columns.

The Select Visible Columns window opens and shows the list of columns in the
current order.

3. To select the column(s) you wish to add to the view, do one of the following:

◦ in the left pane, double-click the column(s) you wish to add to the view

◦ select them in the left pane and click theAdd button

4. To select the column(s) you wish to remove from the view, do one of the following:

◦ on the right pane, double-click the column(s) you wish to remove from the view

◦ select them on the right pane and click the left arrow

5. Click OK.

Ordering Columns
To change the columns order, proceed in one of the following ways:

1. Select a column header

2. Drag it to the left or right to the required place.

A vertical line shows the place where the columnwill be dropped.

OR
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1. Right-click a column header.

A menu is displayed.

2. Select Choose Displayed Columns.

The Select Visible Columns window opens and shows the list of columns in the
current order.

3. Select the column name(s) from the Selected pane.

4. Click the appropriate button:

◦ Up: moves the item(s) before the previous one

◦ Down: moves the item(s) after the next one

5. Click OK.

4.2.3. Element Contextual Menu
A contextual menu with the following options is available when you right-click an item in
the list. The options may differ according to the tab selected.

Hidden State
This option is only available for the projects which belong to the user.
• Hidden hides the project from the Projects area. The project will still appear in the

projects list for the user but will show an "H" in the hidden column.
• Not hidden unmarks the selected project as hidden.

Deleted State
This option is only available for the projects and the edits which belong to the user.
• From Project Mgr: Deleted deletes the project and all its contents from the Projects

area, but not from the database. The project will still appear in the projects list for the
user but will show a “D” in the deleted column to indicate it has been flagged as "to be
deleted".

• From Edit Mgr: Deleted deletes the edit from the Edit area, but not from the database.
The edit will still appear in the Edits list but will show a “D” in the deleted column to
indicate it has been flagged as "to be deleted".

• Not Deleted removes the Deletedmark for the selected project or edit.

Play
Opens a new Player window to allow the element to be browsed andmodified. The Player
window is the same as described in the section "Opening a Player to View Media" on page
27.

Render List
Opens the Render List window listing all types of rendering that have been done with the
edit or media.

Archive History
Opens the Archive History window listing the archive and restore processes that were
achieved for the selected edit or media.
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Change Properties
Opens theMedia Properties window which shows the properties for the selected edit or
media. If a default metadata profile has been defined for the edit or media, ametadata tab
is displayed and shows the edit or mediametadata. The users canmodify the edit or
mediametadata values.
See the XedioManager manual for more information on the selection of a profile.

4.2.4. Special Status Display for the Elements
The elements can be displayed with a specific font to reflect a particular status.

Element Display Meaning

Red font Element in recording or importing state. A wrong status may be
displayed when a Xedio Ingest server crashed.

Italic font Virtual media created with Xedio Browse.

Grey font Only hi-res media or lo-res media is available.

4.2.5. Opening a Player to View Media
From theMediaMgr, and Edit Mgr tabs, you can open any item on the Elements grid by
double-clicking it or right-clicking themouse and select Play (orRun Player).

The element opens in a Player window, which is same as the Player area in the Edit tab.
See section "Player Pane" on page 62 for a detailed explanation:

• A jog andmedia bar and a set of transport controls allow themanipulation of the
element in the window.

• Using themouse, you can click wherever you want insidemedia bar, and drag the
mouse to browse through the element.

• Drag and drop operations of clips andmedia are possible from this Player to the Clip
area or Media area of the project.

4.3. Searching for Elements in the List

4.3.1. Introduction
When the database contains large amounts of data, it may become difficult to find a
specific element. The Xedio Suite offers several ways to speed up your search:

• quick text search

• filters on parameters

By default, the columns that are taken into consideration for the Quick Text Search are the
ones currently visible in the grid.
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If you wish to search in other columns, and view the string you are searching for in the
columns, you can:

• add other columns to the Elements grid view

• use Filters, as explained in section "Advanced Search" on page 30.

These search tools are explained in detail below.

An applied filter can be saved for later use. Such a saved filter can then be applied in one
click.

A search can also be facilitated by ordering the Elements grid.

4.3.2. Quick Text Search

Purpose and Context of Use
TheQuick Text Search function is used to perform a search based on free text entered in
theQuick Text Search field. This field is available on the top of the Elements grid.

It allows searching for a string in the displayed columns.

Users can enter a search string in one of the following ways.

• They enter the search string in full in theQuick Text Search field.

TheQuick Text Search option obeys specific rules which can be accessed via the

Help button next to theQuick Text Search field.
See section "Quick Text Search Rules" on page 28 for more details on these rules.

• They click the arrow next to theQuick Text Search field, so the last 10 searches are
displayed, and they select one of them.

Quick Text Search Rules
The string that you enter in theQuick Text Search field is analyzed according to the
following set of rules, which can be accessed via theHelp button next to theQuick
Text Search field.

The free text search is not a case sensitive operation.
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Search String Search Result

Yellow card Searches for the strings "yellow" and "card", even if in two different
fields (columns), for example "yellow" in Name and "card" in
Keywords.
For example a clip named "The Yellow Man" with keywords "Red
Card" will be found, since it has yellow and card in 2 different fields.

"Yellow card" Searches for strings containing "Yellow card".

Yellow | card Searches for "yellow" or "card", even if in two different fields
(columns), for example "yellow" in Name or "card" in Keywords.
Spaces around the | sign aremandatory.

yell* Searches for "yell" at the beginning of a string.

*low Searches for "low" at the end of a string.

Ye*low Searches for strings with "ye" at the beginning and "low" at the end.

Ye*low 123 Searches for strings with "ye" at the beginning and "low" at the end
and which contains "123".

=card Searches for a string exactly equals to "card".
For example, if a field contains "yellow card", the =card condition
will not return any result.

=”yellow card” Searches for a string exactly equals to "yellow card".
The use of quotes is required due to the space between "yellow" and
"card".

How to Perform a Quick Text Search
To perform aQuick Text search, proceed as follows:

1. Display the columns you wish to perform a quick search on.

2. Type a search string in theQuick Text Search field, based onQuick Text search
rules available from theHelp button and detailed in section "Quick Text Search
Rules" on page 28.

3. Click theSearch button to apply the Quick Text Search.

Depending on whether theAutoRefresh Filtering setting is selected or not, youmay
not have to click theSearch button to apply the Quick Text Search. Refer to the tab
Software > Parameter Profiles > General > General in XedioManager.

The search result is displayed in the grid.

4. To clear the applied Quick Text Search, click the red button to the right of the
search field or select <empty> from theQuick Text Search drop-down list.
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4.3.3. Advanced Search

Purpose and Context of Use
The Advanced Search functions are available for more detailed search operations. They
allow searches on projects, edits or mediametadata.

From the Today tab, the filter "creation date = today" is automatically applied.

The Advanced Search fields can be displayed on the top left part of the Elements grid.

Advanced Search Fields Display

Displaying Advanced Search Fields

Show/Hide Filter Button

To display the Advanced Search fields, click theShow/Hide Filter button above the
grid.

The Advanced Search area is expanded as follows:

TheShow/Hide Filter button can be displayed with two different colors:

Button
Display Meaning

(gray)

TheShow/Hide Filter button is gray when all filter criteria are hidden.
Consequently, the filters are inactive.

(colored)

TheShow/Hide Filter button is colored when the Advanced Search area is
visible, even if no filtering criterion is applied.

Criteria Combination Field
The first field under theShow/Hide Filter button lists three options for the combination of
criteria to be taken into account during the filtering operation.
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Option Meaning

ALL criteria
are met

All the criteria selected in the Filter fields displayed under theCriteria
Combination field must bemet.
Themedia displayed in the Elements grid fulfill all the selected filter
criteria.

ANY criteria
is met

At least one of the criteria selected in the Filter fields must bemet.
Themedia displayed in the Elements grid fulfill at least one of the
selected filter criteria.

NO criteria
is met

None of the criteria selected in the Filter fields displayed under the
Criteria Combination field must bemet.
Themedia displayed in the Elements grid fulfill none of the selected filter
criteria.

Search Parameters List
The second field gives access to the list of available advanced search parameters. Click
the arrow next to the field to display the list.

Users are then able to add as many search fields as needed and to enter search criteria for
each of them.

Depending on the type of items (media, edits, clips) displayed in the Elements grid,
different lists of advanced search parameters are proposed.
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The following screenshot is an example of such a list. The options may differ between the
applications of the Xedio Suite. Most relevant parameters are listed at the top of the list,
then, all the other fields are displayed in alphabetical order.

Depending on the type of items (media, edits, clips) displayed in the Elements grid,
different lists of advanced search parameters are proposed.
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The following screenshot is an example of such a list. The options may differ between the
applications of the Xedio Suite. Most relevant parameters are listed at the top of the list,
then, all the other fields are displayed in alphabetical order.

Advanced Search Fields
Once a search parameter has been selected, an entire line is displayed.
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Interface
Element Description

1 Selected search parameter.

2 Various fields used to enter the filter criteria. See section "Advanced
Search Fields Types" on page 34.

Used to remove the corresponding filter line.

Used to add a new filter line.

Hiding Advanced Search Fields

To hide all the Advanced Search fields, click theShow/Hide Filter button again.
Consequently, all the applied filters are removed.

To remove an Advanced Search field from the Advanced Search area and thus clear the

corresponding applied filter, click the button next to the field.

Advanced Search Fields Types
Depending on the selected search parameter, different types of advanced search fields
will be displayed and available to enter criteria.

Timecode or Duration Parameter
Such as TC IN, TC OUT, Duration…

1. Select a logical operator in the first field

2. Enter a timecode or duration value in the second field.

Timecode Range

1. Select an option from the first field

2. Enter a timecode value.

This will include, or exclude, media containing the specified timecode value.
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Date
Such as Creation Date

Several Date Search filters exist.

1. Select a condition or a logical operator in the first field

2. This will condition the next step:

◦ Search based on a specific date (e.g. with =…): a calendar will be displayed for
the selection of a date.

◦ Search based on an interval (e.g. with […] (between)…): two calendars are
displayed for the selection of two dates.

◦ Search based on a specific date calculated from the current date (e.g. with
tomorrow, last month,…): no other field appears.
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Time
Such as Last Rendered Date Time

Several Date Search filters exist.

1. Select a condition or a logical operator in the first field

2. This will condition the next step:

◦ Search based on a specific date and time (e.g. with =…): two additional fields will
be displayed, a calendar for the selection of a date and drop-down list for the
selection of time.

◦ Search based on a specific date and time calculated from the current date and
time (e.g. with next hour, last month,…): no other field appears.

Number
Such as DB Id

1. Select a logical operator in the first field

2. Enter a number in the second field.

Note
<>means "differs from".
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Option List
Such as Video Standard

1. Select a logical operator in the first field

2. Click the button to display the list of options available for the selected filter
parameter.

Example for the Video Standard:

3. Select an option from the list.

Boolean
Such as Published

• Select Yes or No from the single criteria field.

Free Text
Such as Label

1. Select a condition in the first field.

2. Enter free text in the second field.
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How to Perform an Advanced Search
To enter search values in the Advanced Search fields, proceed as follows:

1. Choose the columns you wish to perform a search on.

2. Click theShow/Hide Filter button
The Advanced Search area is displayed:

3. Select a criteria combination from the list:

4. Select a search parameter from the list of parameters.

An entire line, corresponding to the selected filter parameter, is displayed:

5. Enter filter criteria as explained in section "Advanced Search Fields Types" on page
34.

For free text fields, press ENTER to apply the filter.

Otherwise, the Elements grid is automatically filtered and refreshed.

6. If required, click the button to add another advanced search parameter.

4.3.4. Using Saved Filters

Introduction
Once you have defined filters and search terms, youmay want to save them for later use.
You will then be able to apply the same set of filters with a single click.

Saved filters appear as tabs.

At least two tabs exist on the left of the Elements grid.

• The Filter 0 tab: The Elements grid displays the list of all elements present in Xedio
Dispatcher, or it returns the result of a search applied to the list.

• The Today tab: the Elements grid shows the elements with "creation date = today".
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Warning
Those filters can bemodified by the user, so the results could no longer reflect
the tab label.

Saved Filter Contextual Menu
Right-clicking in the Filter 0 tab displays a contextual menu with the following options:

Create New Filter
Allows to create a new filter tab through the Filter Edit Dialog wndow:

Save Filter As
Allows to create a new filter tab in which the current search filter will be saved.

Filter Properties
Allows to change the name and/or description of the selected filter tab.

Reset Filter
Removes all search criteria on the selected filter tab.

Delete Filter
Removes the filter tab.

How to Save Filters
To save filters, proceed as follows:

1. Define the filter or filters combination you wish to save, as explained in section "How
to Perform an Advanced Search" on page 38.

2. Right-click the Filter 0 tab.

3. Select Save Filter As from the contextual menu.

The Filter Edit Dialog box opens.

4. Enter a label for the tab you are going to create and, if required, enter a description.

5. Click OK.

The new filter tab is displayed on the left of the list.

How to Apply a Saved Filter
To apply a saved filter, simply click the corresponding tab.
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5. Managing Projects and Project
Elements

5.1. Project Area

Overview

The Project area is located on the left part of themain CleanEdit window. Its function is to
permit the user to manage a project and all the elements within the projects, multiple edits,
media used within the project and clips andmedia used on the timeline of edits within the
project.
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The Project area contains the projects created by the logged-on editor. The Project area is
divided into four zones to sort the different elements of each project:

• The Project zone contains a list of the projects for the logged on user. The open
project is displayed in bold characters.

• TheMedia zone contains the original media files that are used in the open project.

• The Edit zone contains the list of edits that have been created on the open project.
The edit loaded is displayed in bold characters.

• The Clip zone contains list of clips stored in preparation for the edit.
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Each project only contains the elements that have been deemed to be relevant to it. The
ability to access elements from anywhere in the database of an installation and declare
them relevant to a project, to allow sharing of media amongst several workstations, is a
fundamental part of the structure of CleanEdit.

Hiding and Displaying the Project Area
The project area can be hidden or displayed by clearing or selecting the Bins options from
the View menu in themainMenu bar.

If you want to extend it, move themouse to the border between the Project area and
Work area and left-click themouse when themouse cursor changes to .

If you want to extend it to the whole window, so that you can see information on the
projects, media, edits and clips, move themouse to the border between the Project area
andWork area and right-click themouse when themouse cursor changes to .

To return to the normal display, place themouse over the right hand edge of the window to
see themouse pointer change and drag the frame to the desired size or click with the right
mouse button on it.

Selecting Items in the Zones of the Project Area
The selection of items in the various zones of the Project area is done in the sameway as
inWindows® Explorer:

• Click on an item for a single selection.

• Press CTRL + click on the items for a selection of multiple non-contiguous items.

• Press SHIFT + click on the first and last item for a selection of multiple contiguous
items.

5.2. Project Zone

5.2.1. Introduction

Each time users begin to edit a new body of material, they need to create a new project in
which they will store all the elements to be used in that project. The projects are created
and displayed in the Project zone.
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This area will show all projects created by the user that has logged in. Other user's
projects can only be shown in this area if they have been imported. See section "Importing
a Project" on page 46 for more information on importing a project.

This section presents the various possible actions on a project, either accessible from the
Project contextual menu or in another way.

5.2.2. Opening an Existing Project
To open an existing project, double-click its name in the Project zone list. When the
project opens, the different elements associated to the project are displayed in theMedia,
Edit, and Clip zones of the Project area.

The name of an active (open) project is displayed in bold characters.

5.2.3. Project Contextual Menu
You can perform themain actions on a project via the Project contextual menu. You will
access it by right-clicking on a project in the Project zone:

The following table shows an overview on the commands from the contextual menu:

Command Description

New Opens the New Project dialog box in which you can create a new project.
See section "Creating a New Project" on page 44.

Properties Opens the Project Properties dialog box from which you can change the
project name (label) or description.
The video standard cannot be changed once the project has been created.

Delete Deletes the project from the Project zone. A dialog box will ask for
confirmation.
The project will be deleted from the user's Project zone, but not from the
database (it will bemarked "DELETED"). It can be restored in the Project
Manager tab, by right-clicking the project row and selectingNot Deleted
from the contextual menu.
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Command Description

Hide Hides the project from the Project zone. This is useful when toomany
projects are displayed. A dialog box will ask for confirmation.
The project will be hidden from the user's project zone, but is still available
in the database (it will bemarked "HIDDEN"). You can display back a
hidden project via the Project Manager tab, by right-clicking the project row
and selectingNot Hidden from the contextual menu.

Default
Sort

Allows the user to select how the projects are sorted in the Project zone
among various sorting options. Each sorting option can be combined with
an ascending or descending sort:

Refresh Refreshes the list of projects in the Project zone. This is relevant when
projects are created automatically by the system or by other users.

5.2.4. Creating a New Project

Procedure

You can create a new project via theNew command in the Project contextual menu. This
opens the New Project dialog box in which you define and save the project
characteristics. You need to specify a project name and video standard to be used in your
project, then click OK to validate. The project characteristics are recorded in the
database.
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Project Default Values

By default, the following values are used:

• Project name: Project_XXXX where XXXX corresponds to an incremented number.

The default name can be changed in XedioManager, Software > Parameter Profiles
tool, in the Browser tab.

• Video Standard: at first use, the displayed default value is the one set in Xedio
Manager. Afterwards, it will correspond to the last value selected by the user.

Project Video Standard

The video standard specifies the resolution and frequency that will be used for playing out
or rendering the project. Once a project is created, you cannot modify the video standard.

The default value for the project video standard is set in XedioManager in Software >
Parameter Profiles > General > General tab: DefaultVideo Standard field.

In a project you cannot addmedia with a frequency different from the project video
standard.

But you can addmedia having any video standard, they will be converted to the project
video standard.
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5.2.5. Viewing the Project Data
By moving themouse between the project and the work areas, themouse pointer will
change to . Clicking with the right mouse button will expand the Project area full
screen, so that you can view information on the projects, media, edits and clips.

To return to the normal display, place themouse over the right hand edge of the window to
see themouse pointer change and drag the frame to the desired size or click with the right
mouse button on it.

5.2.6. Importing a Project
If you need to work on another user's project, you can import it from the Project Mgr area.

To import a project, select the project in the Project list of the Project Mgr area and drop it
to the Project zone. The project will be copied and imported to your working environment,
with all the associatedmedia and edits.

In some specific workflows, the users will be asked whether they want to copy the
project, or become the project's owner. In the latter case, the user will work on the original
project.
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5.3. Media Zone

5.3.1. Introduction
TheMedia zone contains the list of media relating to the project. Eachmedia is placed in
this area by dragging it from theMediaManager tab. See section "Searching for and
ManagingMedia" on page 24 for more information on this tab.

This section presents the various possible actions on amedia, either accessible from the
Media contextual menu or in another way.

5.3.2. Opening Media in the Player Area
To view material available in theMedia zone, you can load it to the Player of the Edit tab,
by clicking themedia name or by dragging themedia onto the Player window:
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5.3.3. Media Contextual Menu
You can perform themain actions onmedia via theMedia contextual menu. You will
access it by right-clicking on amedia in theMedia zone:

The following table shows an overview on the commands from the contextual menu:

Command Description

Delete Deletes themedia from theMedia zone. A dialog box will ask for
confirmation.
Themedia will be deleted from the user's Media zone, but not from the
database nor from themedia server. You will still view it in theMedia
Manager tab and be able to drag it to theMedia zone.

Default Sort Allows the user to select how themedia is sorted in theMedia zone
among various sorting options. Each sorting option can be combined
with an ascending or descending sort:

Refresh Refreshes the list of media in theMedia zone.
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5.4. Edit Zone

5.4.1. Introduction
An edit is video and audiomaterial assembled in a timeline, to which effects and several
features may have been added, and that will be played out as a final subject.

The Edit zone contains the list of edits related to the current project.

The edits will be displayed differently depending on their status:

• An open edit is in bold characters.

• A closed edit is displayed in normal characters.

• An edit closed and set as "Ready to broadcast" is displayed in dimmed characters.

This section presents the various possible actions on an edit, either accessible from the
Edit contextual menu, or in another way.

5.4.2. Opening an Existing Edit
To open an existing edit, double-click on its name in the Edit zone.

When an edit is active (open), its name is highlighted in bold characters and the Timeline
area shows the edit. The timeline buttons also become active.
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5.4.3. Edit Contextual Menu
You canmanage your edits via the Edit contextual menu.

If you right click on the Edit zone, the contextual menu shows the commands applicable
to all edits.

If you right click on a specific edit in the Edit zone, the contextual menu will also enable
the commands applicable to the edit.

The following table shows an overview on the commands from the contextual menu:

Command Description

New Opens the New Edit window, from where you can create a new edit.
See section "Creating an Edit" on page 51 for more information on the
fields available in this window.

Properties Opens the Edit Properties window, from where you canmodify some
properties of the edit.
See section "Creating an Edit" on page 51.

Delete Deletes the edit from the Edit zone. A dialog box will ask for
confirmation. Edits which have the R2B status (ready to broadcast)
cannot be deleted.
The edit will be deleted from the user's Edit zone, but not from the
database. It can be restored in the Edit Manager tab, by right-clicking
the edit row and selectingNot Deleted from the contextual menu.

Duplicate Allows creating a duplicate of the selected edit.
See section "Duplicating an Edit" on page 55.
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Command Description

Default Sort Allows the user to select how the edits are sorted in the Edit zone
among various sorting options. Each sorting option can be combined
with an ascending or descending sort:

Make Local
(XT/XS)

Allows the user to archive all XT/XS clips used in the edit to his local
storage. When this option is selected, a confirmation (YES/NO) info
window is displayed.
This option is available only if the parameterAllow to Backup XT/XS
clip is set to true in XedioManager (in Software > Parameter Profiles
> CleanEdit > Cemediaimport).

Refresh Refreshes the list of edits in the Edit zone.

5.4.4. Creating an Edit

How to Create an Edit
To create a new edit in an open project, proceed as follows:

1. Right-click in the Edit zone and select New from the contextual menu.

This opens the New Edit window.

2. Fill in the fields in this window.

3. Click OK.

The new edit will be created with the label and characteristics you have defined. Its
characteristics are stored in the database.

The audio track assignment of the newly created edit corresponds to the audio track
assignment of the previous edit.

See section "Audio Track Selection for the Output" on page 106 for more information on
how to set the output audio tracks.
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New Edit Window

Window Overview

The New Edit window is made of two tabs: General, CustomMetadata.

You need to specify the edit characteristics when you create the edit, via the New Edit
window. You will find below a description of its fields.

Themandatory fields are filled in with default values. The values of some fields can still be
modified when the edit has been created, in the Edit Properties window. This is specified
in the field description.
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Fields in the New Edit Window

General Tab

TheGeneral tab contains the following user interface elements.

Label
Name assigned to the edit (mandatory). The default value for the label is Edit_XXX where
XXX corresponds to an incremented number.
The default name can be changed in XedioManager, Software > Parameter Profiles >
CleanEdit > Browser.

Description
Optional text to describe the edit.

Program ClassList
Category assigned to the edit. The value is selected from predefined classes to classify
an edit as belonging to a particular group or edit type. The tree values and structure are
defined in Tools > Program Class Manager tool, in XedioManager.
Click the down arrow to display the classification tree and select the requested category.

Edit ID
Identifier for the edit can be entered or generated automatically to make it unique. If it is
enteredmanually and it is already used, a warningmessage will appear. Two parameters
Software > Parameter Profiles > (Xedio) CleanEdit > General tab in XedioManager (Read
Only Edit ID, Automatic Edit ID Generation) make it possible to configure how the Edit ID
field will be used.

Standard
Video standard of the edit.

Aspect ratio
Default aspect ratio to be used for the edit.
With HD video standards, the aspect ratio 16:9 is selected and cannot bemodified in
Xedio CleanEdit. This does not prevent from using amedia with a different aspect ratio in
the edit.
With SD video standards, you can choose the aspect ratio between 4:3 and 16:9, and you
canmodify this as long as the edit is empty.
The default value is specified in the Software parameters > General > General tab in Xedio
Manager.

Default conversion type
When a conversion is performed on themedia, this setting allows the user to define a
preferred default from either letterbox or pillarbox/cropped (pan & scan).
• The letterbox effect occurs when film shot in a widescreen aspect ratio is transferred

to standard-width video formats while preserving the film's original aspect ratio. The
resulting image has black bars (mattes) above and below it.

• The pillarbox effect occurs in widescreen video displays when black bars (mattes or
masking) are placed on the sides of the image. It becomes necessary when film or
video was not originally designed for a widescreen display.

• Pan and scan is amethod of adjusting widescreen film images so that they can be
shownwithin the proportions of a standard definition 4:3 aspect ratio television
screen, often cropping off the sides of the original widescreen image to focus on the
composition's most important aspects. (Source: Wikipedia)

USER MANUAL Xedio Suite 4.40 Xedio CleanEdit

5. Managing Projects and Project Elements 53



Start Timecode
Specifies the first timecode for the edit.
The entered timecode is:
• reflected on the timecode bar above the timeline,
• stored in the database,
• used for the playout and rendering process.
Two options are available:
• Get the TC IN of the first edit clip as start TC by selecting the From First Clip option.
• Manually set the start TC by clearing the From First Clip option and entering a

specific timecode in theStart Timecode field.

On Air Date and On Air Time
Allows specifying a date and time when the edit is planned to be played out. The
automatic restore process uses this information when the archive solution is part of the
system.

Custom Metadata Tab

Three cases can occur:

• No default metadata profile has been selected for use with the edits from the Edit
Metadata Profile Association window. Then, the CustomMetadata tab is not
available.

• Only onemetadata profile has been selected for use with the edits from the Edit
Metadata Profile Association window. Then, themetadata fields of this default profile
are displayed in this tab and can be filled in.

• Several metadata profiles have been selected for use with the edits from the Edit
Metadata Profile Association window (one default profile and one or more associated
profiles). Then, the first line displays the name of the default metadata profile and can
be used to select another profile:

The other lines display themetadata fields of the selected profile. Values can be
entered or selected.
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Note
TheAllow Change Edit Properties optionmust have been selected from
XedioManagerSoftwares > Parameters Profiles > CleanEdit > Cefiltermgr
to allow the display and update of CustomMetadata.

5.4.5. Duplicating an Edit
You can duplicate one of your edits using theDuplicate command in the Edit contextual
menu. This opens a dialog box showing the properties of the duplicated edit and
suggesting a name (the old namewith the extension "_Duplicated"). Confirm the operation
with theOK button.

You can also use theCTRL + D shortcut to create a duplicate for the edit that is currently
loaded in the timeline.

Note
When you duplicate an edit, it is not possible to change the audio type of the
duplicated edit.

5.4.6. Copying an Edit
You can also copy an edit from the Edit Manager tab, whatever the user who created the
edit. The result is the same as duplicating an edit, but you perform the action in a different
way, and you can copy other user's edits.

If you want to copy an edit available in the Edit Manager tab, select the edit, drag it from
the Edit Manager tab and drop it onto:

• the Edit zone of the Project area.

In this case, the edit is added to the open project.

• any project name in the Project zone of the Project area.

In this case, it will be added to the project on which you have dropped the edit.
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5.5. Clip Zone

5.5.1. Introduction
The Clip zone is mainly used to store clips in preparation for edits.

It contains the list of clips made in one of the following ways:

• by selecting sections of material from the Player on the Edit tab and dragging them to
the timeline.

• by selecting sections of material from the Player of theMediaManager tab and
dragging them to the timeline.

• by dragging the clips from theMedia Importer, EVS Server tab directly into the Clip
zone.

The clips shown are all relevant to the project open in the Project zone.

Note
See section "Placing Clips onto the Timeline" on page 118 for more information
onmaking clips and placing them on the timeline or in the Clip zone.

5.5.2. Viewing Clips
To view the clip material, you can load the clip onto the Player of the Edit tab:

• by double-clicking the clip name

• by dragging the clip name onto the Player window
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5.5.3. Adding Clips
You can add clips to the clip zone in several ways:

• Drag themedia from the Player to the Clip zone. Thematerial defined between the IN
andOUT points, or mark IN andmark OUT points when defined, will be added to the
Clip zone.

• Drag amedia from theMediaMgr into the Clip zone.

• Select several clips in the edit from different timeline tracks and drop them in the clip
bin: this will create only one clip.

This action is possible only if the selected video and audio edit clips access the same
media with the same timecodes.

5.5.4. Clip Contextual Menu
You canmanage your clips via the Clips contextual menu.

If you right click on the Clips zone, the contextual menu shows the commands applicable
to all clips.

If you right click on a specific clip in the Clips zone, the contextual menu will also enable
the commands applicable to the clip.

USER MANUAL Xedio Suite 4.40 Xedio CleanEdit

5. Managing Projects and Project Elements 57



Command Description

Properties Opens the Clips Properties window, from where you canmodify the
clip label and description and get information on other clip parameters:

Delete Deletes the clip from the Clip zone. A dialog box will ask for
confirmation. The original media is not deleted from the database.
Once deleted, a clip cannot be recovered as the edits can be.

Thumbnails Allows the user to display or hide the clip thumbnails showing the IN
andOUT frames in the Clip zone.

Print Opens a dialog to print the clip details. If the workstation has been set
up and connected to a printer, a list can be printed.

Refresh Refreshes the list of clips in the Clip zone.

Default Sort Allows the user to select how the clips are sorted in the Clip zone
among various sorting options. Each sorting option can be combined
with an ascending or descending sort:
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5.5.5. Assigning Colors to Clips and Filtering on
Colors

Purpose

Above the clip list, theColored Square button and the Filter button allow you to
assign colors to the clips and filter them based on the clip colors.

How to Assign a Color to New Clips
To activate a color to be assigned to clips, proceed as follows:

1. Click theColored Square button to open the Color dialog box.

2. Select a color you want to assign to new clips and click OK.

TheColored Square button will change to the selected color

From then onwards, the bullet in front of the new clips placed in the Clip zone will inherit
the active color.
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How to Change the Color Assigned to Existing Clips
To change the color assigned to clips, proceed as follows:

1. Activate the color you want to assign using theColored Square button and the Color
dialog box.

2. Select the clips for which you want to change the color.

3. Simultaneously press CTRL and click theColored Square button.

The active color will be assigned to the selected clips.

How to Filter Clips Based on Colors
To filter clips to which a given color is assigned, proceed as follows:

1. Activate the color on which to filter using theColored Square button and the Color
dialog box.

2. Click the Filter button to activate the filter

The filter button will turn colored and the clip list will be limited to the clips
corresponding to the selected color.
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6. Main Workspace for Editing

6.1. Edit Tab Overview

Introduction

Clips and edits are created in the Edit tab.

Illustration

The Edit tab contains the areas highlighted on the screenshot below:
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Area Description

The table below refers to the sections where the various parts of the Edit tab are detailed:

Part Name Description

1. Player pane See section "Player Pane" on page 62.

2. AudioMeters and
Trim pane

See section "AudioMeters / Trim Pane" on page
91.

3. Recorder pane See section "Recorder Pane" on page 85.

4. Timeline pane See section "Timeline Pane" on page 93.

6.2. Player Pane

6.2.1. Overview

Introduction

The Player pane is used to load and browsemedia on the Edit tab, create clips to place
onto the timeline or to drag to the clip list area. All types of media and clips can be played
in the Player: video, audio or stills.
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Illustration

The Player pane contains the areas highlighted on the screenshot below:

Area Description

The table below describes the various parts of the Player pane:

Part Name Description

1. Video
Display

It displays the videomaterial loaded on the Player. Everything that
is outside the video content has the skin color. Video such as
letterboxed or pillarboxed video will show black bars as these
mattes are part of the video signal.
Parameters related to the display are available via a contextual
menu.
See section "Video Display Options" on page 66.

2. Track
Selection
buttons

They allow the user to select the tracks to be taken into account
when the loadedmaterial is added to the timeline.
See section "Selecting the Tracks to be Added to the Timeline" on
page 74.
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Part Name Description

3. Jog and
Media bars

They allow the user to navigate in the loadedmaterial, to place IN,
OUT and nowline points, as well as tomodify the playback speed
of thematerial.
See sections "Jog Bar" on page 89 and "Media Bars" on page 67.

4. Clip
Creation
fields

They are used to create new clips, and get the exact timecode of
the nowline, IN andOUT points.
See section "Creating andWorking with Clips in the Player" on
page 72.

5. Log
buttons

The logs make it possible to add reference points to easily identify
positions of interest in the loadedmedia.
See section "Adding Logs to theMedia Loaded on the Player
Area" on page 78.

6. Transport
Control
buttons

They are used to play back the loadedmedia.
See section "Transport Commands in the Player" on page 69.

7. Server
Recorder
selection

The button acts as a toggle switch between the Track

Selection buttons and
the camera selection list

Several cases can occur:
• If the loadedmedia/clip contains more than 8 audio tracks,

only the first 8 tracks are displayed. A first click on the button
allows to display the additional tracks.

• If a record train of an EVS video server is loaded, this allows
the user to load another record train on the given server.

• If a clip belonging to a group of linked clips is loaded (for
example, clips created with ganged channels in IPDirector),
the list displays the various camera angles and allows the
user to select a clip linked to the one loaded.

• If an individual clip is loaded, only its recorder channel is
available.

If a media ingested from an encoder is loaded, the button is
not available.

You can access the various commands of the Player pane, either using the buttons on the
user interface, or dedicated keyboard shortcuts (which are assigned in XedioManager).
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6.2.2. Activating the Player Area
To be able to use the Player and the various commands it features, you need to activate it.

To activate the Player, click on the Player area or press on the keyboard. When you
drag amedia to the Player, it is directly activated.

A colored rectangle displayed around the Player commands indicates that the Player area
is active:

6.2.3. Making the Player Area Full Screen

To view the Player area as a full-screen image, press on the keyboard.

Press the shortcut key again to revert to the normal display.
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6.2.4. Video Display Options
A contextual menu is available when right-clicking the Video Display area. This gives
display options for the video.

Option Meaning

Show
Timecode

This option offers various options to display timecode on the Player
window.
If the loadedmaterial is a file:
• none: does not display timecode.
• Start TC: shows a counter starting with 0 at the first frame of the

media.
• Intra TC: shows the original timecode of themedia.
• Original TC - displays the timecode of the clip in the original

media, before its import. This is only available for clips imported
from Xedio Importer with themerger engine enabled.

Up to two TC options can be selected.
If the loadedmaterial is the record train of an EVS Video Server (not
applicable to the Recorder Video Display):
• none: does not display any timecode
• intra TC (TOD): provides a sub-menu with two options: Timecode,

Timecode and Date.

Aspect Ratio This option offers a choice of aspect ratios for the display: Auto, 4:3 or
16:9.

Show
SafeAreas

This option displays a safe area cage on the window to determine
which areas of the picture will be seen. This allows to check the size of
graphics within themedia for safe display.

Grab Image Grabs the current image, either in low resolution or in high resolution.
The default folder (c:\) where the grab is stored is defined in Xedio
Manager > Software > ParameterProfiles > General Settings:
GrabStillFrameFolder parameter.
The option dos not applies to the Recorder Video Display.

Show Label Displays the name of the loaded item on the top of the Video Display.

6.2.5. Loading Media onto the Player Area

Introduction

The action of "placing" amedia or a clip on the Player pane to preview it, sub-clipping it,
and so on, is called "loading amedia or clip on the Player".

This can be done in different ways.
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How to Load a Clip in the Clip Player

To load amedia or clip on the Player pane, proceed in one of the following ways:

• double-click the requestedmedia or clip from the Bins area

• drag themedia or clip from the Bins area onto the Player area

• select two clips in the edit from different timeline tracks and drop them in the Player to
access amedia and select the correct audio tracks. This is possible only if video and
audio edit clip access the samemedia with the same timecodes.

6.2.6. Moving Within Media Loaded on the Player
Area

Media Bars

Top Bar

The top bar represents themedia, or a portion of it, currently loaded on the Player.

Themark IN, mark OUT and nowline are displayed on this top area.

Middle Bar

Themiddle bar is used to zoom into the loaded element.

Its dark gray zone shows the section of themedia, out of the wholemedia, visible in the
top bar and the relative position of the visible section in the wholemedia.

• When amedia or an edit has just been loaded, the top bar represents the wholemedia.
The dark gray zone covers the whole length of themiddle bar:
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• When amark IN and amark OUT are defined,, double-clicking on the dark gray zone
toggle the section covered by the top bar from the wholemedia length to the clip length
(betweenmark IN andmark OUT), and vice-versa:

The dark gray zone is reduced to represent the clip length and position with regard to
the wholemedia.

• If you position themouse on themiddle bar and rotate themouse wheel up or down,
you respectively increase or reduce the section of themedia visible in the top bar.
Thus, the dark gray zone is enlarged or reduced:

• If you click on the dark gray zone and drag it to the left or to the right, you shift the
section of media visible in the top bar to the beginning or to the end of themedia.

Nowline, Mark IN and Mark OUT

Display

The (mark) IN point, the (mark) OUT point, and the nowline are shown in themedia bar of
the Player paneas vertical lines.

• An IN point, or mark IN point is shown as a green line on themedia bar.

• AnOUT point, or mark OUT point is shown as a red line on themedia bar.

• The nowline, representing the current position within the loaded element, is shown as
a blue line on themedia bar. To place the nowline at a given position, simply click at
the requested position on themedia bar.

Moving Points

Tomove the position of themark IN, mark OUT or nowline, click on them with themouse
and drag them to the desired position.
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Nowline Outside Media Bar

When themedia is being played, the nowlinemoves along the topmedia bar. If only a
section of themedia is visible in the top bar, the nowlinemay disappear. In this case, a red
indicator, on the right side of themedia bar will be displayed. A click on the vertical
indicator (on the right side) will re-center the top bar on the nowline.

Moving themiddle bar to the right or to the left can lead to such a situation, with the
nowline disappearing respectively to the left or to the right of the top bar.

Jog Bar
The bottom bar is the jog bar.

Dragging the speed indicator on the jog bar allows you tomove within themedia at a
variable speed:

The speed varies depending on:

• the position of the speed indicator

• the speed range covered by the jog bar. The default range is set from -200% to
+200%. This is set in XedioManager.

Audio can be heard when using the jog.

Transport Commands in the Player
The following table gives themeaning of each transport operation which can be used with
any loaded item. A button and/or a keyboard shortcut can be used to perform each action.

For a full list of commands activated via a shortcut key, refer to "Appendix 2 – Keyboard
Shortcuts" on page 252.

Note
The user can customize the keyboard shortcuts in XedioManager. The keys
mentioned below are the default settings.
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Button Keyboard Shortcut Function Name and Description

↔ (space bar)

Play/Stop
Start/stops the preview (video and/or
audio) of the loadedmedia.
The button switches to aStop button
when themedia is being played.

+
- "Near Live" Play Mode

Launches the preview at the end of a rush
while digitizing.

↔ Fast Forward
Plays themedia forward at a preset fast
speed.
The button switches to aStop button
when themedia is being played forward.

+
- Fast Forward (with modified speed)

Changes the preset speed to higher speed
value. The speeds are set with the
ShiftSpeedMax parameter from
Parameters > Parameters Profiles >
Media Dispatcher> Default profile >
Player.

↔ Fast Rewind
Plays themedia backward at a preset fast
speed.
The button switches to aStop button
when themedia is being played backward.

+
Fast Rewind (with modified speed)
Changes the preset speed to higher speed
value. The speeds are set with the
ShiftSpeedMax parameter from
Parameters > Parameters Profiles >
Media Dispatcher> Default profile >
Player.

Plays a clip frommark IN tomark OUT

-
+

Plays a clip in loop frommark IN tomark
OUT

- Go to IN
Moves from the current position to the
Mark IN point.

- Go to OUT
Moves from the current position to the
Mark OUT point.

or

Go to Previous Frame
Moves 1 frame before the current position
in Pausemode.
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Button Keyboard Shortcut Function Name and Description

or

Go to Next Frame
Moves 1 frame after the current position in
Pausemode.

-

or

+

Go 10 Frames Backward
Moves 10 frames before the current
position in Pausemode.

-

or

+

Go 10 Frames Forward
Moves 10 frames after the current position
in Pausemode.

The , and keyboard shortcuts are used to navigate (in a combination of
shuttle and scrub at the same time) backwards and forwards in A/V content.

The following table lists their different uses.

Keyboard Shortcut Function Description

Shuttles/scrubs backward at twice the real time speed.
Pressing repeatedly the key will increase the
shuttling/scrubbing speed in a loop: x1, x2, x3, x5, x8 and
then back to x1.

Note

If another key is pressed between the
repetitions, the shuttle/scrub speed is reset.

Stops the preview of the A/V content.

Shuttles/scrubs backward at twice the real time speed.
Pressing repeatedly the key will increase the
shuttling/scrubbing speed in a loop: x1, x2, x3, x5, x8 and
then back to x1.

Note

If another key is pressed between the
repetitions, the shuttle/scrub speed is reset.

Hold + tap
Steps backward 1 frame at a time.

Hold + tap
Steps forward 1 frame at a time.

Hold + hold
Plays backward at 33% of the real time speed.

Hold + hold
Plays forward at 33% of the real time speed.

USER MANUAL Xedio Suite 4.40 Xedio CleanEdit

6. MainWorkspace for Editing 71



Note
The use of ShuttlePRO keys for transport functions is detailed in "Appendix 1 –
ShuttlePRO" on page 251.

6.2.7. Creating and Working with Clips in the
Player

Introduction
When you have defined the portion of themedia you want to place into the timeline, you
can create a clip out of it and either store it in the Clip zone in the Project area and/or place
it directly in the timeline.

To create a clip, you will mainly use the Clip Creation buttons available in the Player area.

Clip Creation Commands
The following table gives themeaning of each clip creation operation. A button and/or a
keyboard shortcut can be used to perform each action.

Button/Field Keyboard Shortcut Operation and Description

or

Mark IN
Sets amark IN point at the nowline position
on themedia bar:
• the timecode value is added inMark IN

TC field.
• a [ sign is shown on the video display
• a greenmark is added at this timecode

on themedia bar.

or

Mark OUT
Sets amark OUT point at the nowline
position on themedia bar:
• the timecode value is added inMark

OUT TC field.
• a ] sign is shown on the video display
• a redmark is added at this timecode on

themedia bar.

Clip Name
Field where the clip name can be entered.
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Time Information Fields
The following time information is displayed as follows next to the transport and clip
creation commands.

Player

Field Meaning

Mark IN TC
Timecode of theMark IN defined on the
loadedmedia.

Mark OUT TC
Timecode of theMark OUT defined on the
loadedmedia.

Nowline TC
Timecode of the nowline position on the
loadedmedia.

TC OUT of the loaded clip.

Duration from the IN point to the OUT point:
• If the clip is loaded from the thumbnail

view, it displays the duration of the
source clip.

• If the clip is loaded from the storyboard,
it displays the duration of the
storyboard clip.

Tomove themark IN, mark OUT or nowline to a given TC, type the timecode in the
corresponding field and press ENTER.

You can edit hours, minutes, seconds or frames separately in the timecode fields:

• Double-click on the hours, minutes, seconds or frames area, and the corresponding
area will be activated for editing.

• Simple-click in the timecode field, the cursor should blink on the right and you can type
the full timecode value.

How to Make a Clip
Using the transport controls listed above, you can create a clip as follows:

1. Select the requestedmedia from theMedia zone and double-click on it or drag it to the
Player area. It will open in the Player.

2. Play themedia using the transport control commands described on page "Transport
Commands in the Player" on page 69.
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3. Position the nowline at the requested position for theMark IN point and click theMark
IN button .

4. Position the nowline at the requested position for theMark OUT point and click the

Mark OUT button .

5. Enter a name in theClip Name field.

6. To save the clip, drag it to Clip zone.

It can then be placed later on in the timeline.

How to Modify a Clip
Tomodify a clip, proceed as follows:

1. Select a clip in the Clip zone and drag it to the Player area.

2. Redefine themark IN andmark OUT in one of the following ways:

3. Set a new mark IN and/or mark OUT using the nowline and the and
buttons. The oldmark IN/OUT will be removed.

4. Drag themark IN and/or mark OUT to the new position in theMedia bar.

5. Do one of the following:

◦ To save the clip as a new clip in the Clip zone, drag the picture from the Player
area to the Clip zone of the Project area.

◦ To save the clip and replace themodified one, press CTRLwhile dragging the
picture from the Player area to the Clip zone, onto the clip to be replaced.

6.2.8. Selecting the Tracks to be Added to the
Timeline

16 Channels in Mono, Stereo and/or 5.1
The Xedio Suite canmanage the reading, the editing and the export of files with up to 16
audio channels. These channels can be grouped in stereo pairs and/or 5.1 groups, or be
mono channels.
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Audio Channel Assignment

The audio channel assignment of the source files depends on how the sourcematerial has
been included into Xedio, and on the audio track assignment defined when the source
material has been imported:

Source material Audio Channel Assignment of the A/V material based
on…

Media imported from
Media Importer

… theDefault Input Audio Track Assignment setting
defined in XedioManager (Software > Parameter Profiles >
General > Audio tab).
The user canmodify the default assignment before importing
the A/V material in Media Importer, via the Setup, Audio
Channels Assignment tab.

Note
Once the audio track assignment has been defined in
Xedio Importer or AutoFile Importer, these values
will be used instead of the default ones on the
workstation.

Media ingested from
a Xedio encoder

… the audio channels defined for the given channel of the
physical encoder. This is defined in XedioManager (Encoders
> Physical Manager > Encoder Channel Profile).

Clip imported from
an EVS server

… theDefault XT Input Audio Track Assignment setting
defined in XedioManager (Software > Parameter Profiles >
General > Audio tab).
The user canmodify the default assignment before importing
the A/V material in Media Importer, via the Setup, Audio
Channels Assignment tab.

Note
Once the audio track assignment has been defined in
Xedio Importer or AutoFile Importer, these values
will be used instead of the default ones on the
workstation.

Record train of an
EVS server loaded
via the direct access
in CleanEdit

… the audio type defined in the EVS server application
launched.
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Possible Audio Configurations

The possible audio configurations aremultiple and are a combination of mono, stereo
and/or 5.1 audio tracks, with amaximum of 16 channels.

Within the general settings of XedioManager, you need to check theEnable 5.1 tracks
parameter to allow themanagement of 5.1 tracks in the Xedio Suite, and theEnable
mono tracks parameter to allow themanagement of mono tracks.

When encoders ingest media, they only use stereo tracks.

When importing files with 2, 4, 8 or 16 audio channels, the assignment must follow the
default parameters set in the database, as explained in section here above. In case the
default assignments cannot be applied, all audio tracks will be considered as stereo pairs.

The A/V content of eachmedia is displayed in the A/V Contents column of theMediaMgr
tab. For each edit, it is displayed in the Audio Type column of the Edit Mgr tab.

Selecting Video and Audio Tracks for Media and
Clips

Overview of the Video and Audio Tracks

The video and audio channels of a loaded source file are represented below the Video
Display of the Player in the form of Track Selection buttons.

Here is an example with 4 tracks of stereo channels:

The different types of audio tracks of a loadedmedia or clip are displayed as follows:

• Amono track is represented by

• A stereo track is represented by .

• A 5.1 track is represented by

Note
If the loadedmedia/clip contains more than 8 audio tracks, only the first 8 tracks

are displayed under the Video Display. A first click on the button allows to
display the additional tracks.

76 6. MainWorkspace for Editing

EVSBroadcast Equipment SA Issue 4.40.A - November 2013



Video and Audio Tracks Selection

When you create a clip to be placed on a timeline, you need to select the video and the
requested audio channels.

Selection of the Video Channel

TheVideo button is clicked to select or remove the video. So the clip made contains,
or not, the video.

Selection of an Audio Channel

The left and the right loudspeaker buttons of an audio stereo track are used to
select or remove respectively the left or the right channel of the corresponding audio track:

Clicking the left audio button will remove the left audio component from the source so that
the clip made has no left audio channel. In this case, the right channel will be output on the
left and right channels.

Clicking both left and right audio buttons will also remove the right audio component so
that the clip made has no audio channel for this track.

A mono track is removed from the selection by clicking the loudspeaker button on the right
of the radio button:

A 5.1 audio track is removed from the selection by clicking the loudspeaker button on the
right of the radio button:

The next table summarizes how the buttons look like depending on the selection:

Selected Removed

Video

Audio
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Selection of the Track for Audio Monitoring

When you create a clip to be placed on a timeline, you need to select the audio track that
will bemonitored when playing the loaded clip.

The radio buttons displayed between each pair of stereo channel buttons or next to a
mono or 5.1 audio channel button allow the selection of one audio track for monitoring:

Note
When you right-click on a 5.1 radio button, a popupmenu appears in which you
can select the 5.1 components that should bemonitored on the left and right
channels. You can choose between the following options: Mixed, L+R, Ls+Rs
or Center (output on L+R speakers).

Audiometers located on the right side of the Video Display represent the audio channels
of themonitored track.

See section "AudioMeters / Trim Pane" on page 91.

6.2.9. Adding Logs to the Media Loaded on the
Player Area

Introduction
The logs are reference points to a specific frame in a video sequence. Their purpose is to
mark points of interest on themedia and to facilitate rapid movement between them. A log
is identified by a TC value, and relates to an action in a given event.

Whenever you want, you can add logs to thematerial loaded in the Player pane
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In CleanEdit, two types of logs can be displayed:

• internal logs are added to themedia by the CleanEdit user

• external logs have been added tomedia in IPDirector before its import into the Xedio
Suite.

Internal and External Logs

Definition and Display

Internal Logs
The internal logs are placed by the user on themedia loaded on the Player.

They are shown on themedia bar as yellow triangles.

When the nowline is on an internal log timecode, a yellow triangle appears at the bottom of
the video display.

Example with a 16:9 aspect ratio:

Example with a 4:3 aspect ratio:

External Logs
The external logs correspond to logs created in and imported from IPDirector, if the
installation is properly set up. An interest level is assigned to them.
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External logs are shown on themedia bar as transparent triangles.

The log will have a different color depending on the interest level assigned in IPDirector:

• White log for no-star rating (default)

• Blue log for 1-star rating

• Green log for 2-stars rating

• Red log for 3-stars rating

There is always a black stripe below the video display when external logs are present on
the loadedmedia/clip. When the nowline is on an external log timecode, a transparent
triangle appears on the left of this black stripe.

Example with a 16:9 aspect ratio:

Example with a 4:3 video aspect ratio display:

Once the nowline is positioned on an external log timecode, the keywords associated to
this log are listed below the video display, next to the log triangle, and are displayed as a
tool tip when you roll themouse over the log on themedia bar:
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Logs Display Selection

When you right-click on a log on amedia bar where the two types of logs are displayed, a
contextual menu appears and let you select the logs that should appear:

Possible Actions on Logs

Adding a Log
1. Place the nowline at the requested position on themedia

2. Click theAdd Log button .

The log is added on themedia as a yellow triangle on themedia bar.

Moving from one Log to the Other
• Click theGo to Prev. Log button tomove to the log positioned on the left of the

nowline.

• Click theGo to Next Log button tomove to the log positioned on the right of the
nowline.

Deleting a Log
When the nowline is positioned on a log (using the , buttons) you can delete it by:

• clickingCTRL+ .
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6.2.10. Creating a Clip on an EVS Video Server from
the Player area

General Process
When themedia loaded on the Player area is a record train from an EVS Server, you can
save the created clip on the EVS Server and in the Xedio database at the same time. To
do this, you will click theSave button next to theClip Name field once you have defined
your mark IN andmark OUT:

This will open the EVS Server Data window in which you can specify the necessary
information to save the clip on the EVS Server and on the Xedio database.

EVS Server Data Window

EVS Video Server Tab

In the EVS Server Data window, the EVS Video Server tab allows you to specify the clip
name, IDs, ranking, type and keywords as it will be saved on the EVS Video Server.

The LSM ID field is the only mandatory in this tab.

You need to select theAdd to Current CE Project option if you want the clip to be added
to the project in the Clip zone, once the clip has been saved.
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CleanEdit Tab

In the EVS Server Data window, the CleanEdit tab allows you to specify the clip label
(name), media class and description as it will be saved in the Xedio database.

The label andMedia Class fields aremandatory fields.

You need to select thePublish option if you want to have access to the clip in CleanEdit.
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Metadata Tab

In the EVS Server Data window, theMetadata tab allows you to specify themetadata for
the clip. This metadata will be stored in the Xedio database.
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6.3. Recorder Pane

6.3.1. Overview

Introduction

The Recorder pane allows you to preview edits and to browse through the timeline. The
commands on the Recorder area are only available when an edit is open. The Recorder
area interacts with the timeline as the two areas are different representations of the same
edit. The timeline provides a graphical representation and the recorder, a visual area to
actually view themedia represented on the timeline.

Illustration

The Recorder pane contains the areas highlighted on the screenshot below:
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Area Description

The table below describes the various parts of the Recorder pane:

Part Name Description

1. Video
Display

It displays the videomaterial loaded on the Timeline. Everything that
is outside the video content has the skin color. Video such as
letterboxed or pillarboxed video will show black bars as these
mattes are part of the video signal.
Parameters related to the display are available via a contextual
menu.
See section "Video Display Options" on page 66.

2. Track
Monitoring
Buttons

They reflect the audio type and tracks of the loaded edit and allow
the selection of the audio track you want to monitor.
See section "Selecting theMonitored Audio Track for an Edit" on
page 90.

3. Jog It allows the users to navigate in the loadedmaterial.
See section "Playing the Edit in the Recorder Pane" on page 87.

4. Edit
Information

These fields provide general information on the loaded edit.
See section "Playing the Edit in the Recorder Pane" on page 87.

5. Transport
Control
Buttons

They are used to play themedia represented in the timeline.
See section "Playing the Edit in the Recorder Pane" on page 87.

6. Validation
Buttons

They are used to check the edit or flag it as ready to broadcast.
See section "Checking the Edit in the Recorder Pane" on page 90.

6.3.2. Activating the Recorder Area
To be able to use the Recorder and the various commands it features, you need to

activate it. To activate the Recorder, click on the Recorder area or press on the
keyboard.

An orange rectangle displayed around the Recorder commands indicates that the
Recorder area is active.

6.3.3. Making the Recorder Area Full Screen

To view the Recorder area as a full-screen image, press on the keyboard.

Press again to revert to the normal display.
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6.3.4. Adjusting the Recorder Video Display
You can adjust the Recorder video display via a contextual menu. You call the contextual
menu by right-clicking the Video Display zone on the Recorder area.

The display options are similar to the ones of the Player Video Display. See section
"Video Display Options" on page 66 for more information.

6.3.5. Playing the Edit in the Recorder Pane

Edit Information
Two fields on the Recorder area highlighted on the screenshot below provide general
information on the edit loaded on the Recorder:

• The upper field specifies the nowline position in the edit.

• The lower field specifies the edit label.

Transport Commands in the Recorder
The following table gives themeaning of each transport operation which can be used in
the Recorder area. A button and/or a keyboard shortcut can be used to perform each
action.

For a full list of commands activated via a shortcut key, refer to "Appendix 2 – Keyboard
Shortcuts" on page 252.

Note
The user can customize the keyboard shortcuts in XedioManager to perform
transport control commands. The keys mentioned below are the default
settings.
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Button Keyboard
Shortcut Function Name and Description

↔ (space bar)

Play/Stop
Start/stops the playback or preview (video and/or audio) of the
editedmaterial on the timeline from the nowline position.
The button changes to aStop button when themedia is being
played.

Go to Beginning
Moves from the current position to the beginning of the edit
loaded on the timeline.

Go to End
Moves from the current position to the end of the edit loaded on
the timeline.

or
Go to Previous Transition
Moves to the previous edit point on the timeline (considering
the selected tracks).

or
Go to Next Transition
Moves to the next edit point on the timeline (considering the
selected tracks).

or
Go to Previous Frame
Moves 1 frame before the current position in Pausemode.

or
Go to Next Frame
Moves 1 frame after the current position in Pausemode.

The , and keyboard shortcuts are used to navigate (in a combination of
shuttle and scrub at the same time) backwards and forwards in A/V content.

The following table lists their different uses.

Keyboard Shortcut Function Description

Shuttles/scrubs backward at twice the real time speed.
Pressing repeatedly the key will increase the
shuttling/scrubbing speed in a loop: x1, x2, x3, x5, x8 and
then back to x1.

Note

If another key is pressed between the
repetitions, the shuttle/scrub speed is reset.

Stops the preview of the A/V content.
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Keyboard Shortcut Function Description

Shuttles/scrubs backward at twice the real time speed.
Pressing repeatedly the key will increase the
shuttling/scrubbing speed in a loop: x1, x2, x3, x5, x8 and
then back to x1.

Note

If another key is pressed between the
repetitions, the shuttle/scrub speed is reset.

Hold + tap
Steps backward 1 frame at a time.

Hold + tap
Steps forward 1 frame at a time.

Hold + hold
Plays backward at 33% of the real time speed.

Hold + hold
Plays forward at 33% of the real time speed.

Note
The use of ShuttlePRO keys for transport functions is detailed in "Appendix 1 –
ShuttlePRO" on page 251.

Jog Bar
The bottom bar is the jog bar.

Dragging the speed indicator on the jog bar allows you tomove within themedia at a
variable speed:

The speed varies depending on:

• the position of the speed indicator

• the speed range covered by the jog bar. The default range is set from -200% to
+200%. This is set in XedioManager.

Audio can be heard when using the jog.
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6.3.6. Selecting the Monitored Audio Track for an
Edit

Number and Type of the Edit Audio Tracks

The output audio tracks are displayed under the Recorder Video Display.

When a new edit has just been created, the number and type of output audio tracks are
taken back from the previously created edit. At this step, no button is available.

Example with 8 stereo tracks:

Once the number and type of output audio tracks have been set and applied from the
Output Channels area of the Audio Output Matrix, they are displayed under the Recorder
Video Display but not available yet.

Note
If more than 8 audio tracks have been set for the output, only the first 8 tracks

are displayed under the Video Display. A click on the button allows to
display the additional tracks.

As soon as clips have been loaded on the timeline, all the output tracks corresponding to
timeline tracks which contain audio are shown as radio buttons.

Selection of the Track for Audio Monitoring

The selection of the audio track you want to monitor is done by clicking one of the radio
buttons.

A set of audiometers are displayed on the left side of the Recorder Video Display.

6.3.7. Checking the Edit in the Recorder Pane
The button allows you to check the edit once it is finalized. The checks
consist of identifying possible blanks in the edit or fast motion clips to be rendered, but
alsomissing hi-res files in the edit. You need to check your edit before you can change its
status to R2B (ready to broadcast). TheR2B button will not become available in case
holes are discovered in the edit or fast motion clips are not rendered.

See section "Checking the Edit" on page 16 for the description of windows andmessages
which are displayed in the different cases.
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The button allows you to change the status of your edit, and set it as "ready
to broadcast". You will do this when you no longer want to modify your edit in CleanEdit. 

Once you click theR2B button, themanager can easily search for the R2B edits in Xedio
Approval to approve or reject them.

Some automatic processes may also be launched when you click theR2B button, such
as restoring the archived hi-res elements corresponding to the lo-res elements of the R2B
edit, or the automatic rendering of the edit to various targets, such as an EVS video
server.

6.4. Audio Meters / Trim Pane

6.4.1. Introduction
The audiometers are located between the Player and Recorder areas in an area shared
with the trim operations possible on the timeline.

Clicking the button will toggle to the audiometer display.

Clicking the button will toggle to the Trim buttons. See section "Trimming Edit
Points on the Timeline" on page 145 for more information on the trim functions.

6.4.2. Audio Meters
The audio display will follow the active window, Player or Recorder, as will the audio
outputs.

When the Player area is active, the audiometers will only display themonitored track.
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mono track monitored stereo track monitored 5.1 track monitored

When the Recorder area is active, all the output tracks set from theOutput Channels area
of the Audio Output Matrix will be displayed in the audiometers.

If more than 8 channels are selected, the first 8 audiometers are visible at a time and two
arrow buttons allow to shift from channels 1 to 8 to channels 9 to 16:
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Db values are displayed on each side. They correspond to the values defined inXedio
Manager > Parameter Profiles > General > Vumeter for the top level, the saturation
level, the warning level and the bottom level. Values for 0, -2, -4, -8 and -16 are shown as
well if they do not overwrite the database values.

6.5. Timeline Pane

6.5.1. Overview

Introduction

The Timeline is the area where, through a graphical representation of the edit in progress,
media can bemanipulated to easily and efficiently make an edited package.

Illustration

The Timeline pane contains the areas highlighted on the screenshot below:

Area Description

The table below describes the various parts of the Timeline pane:

Part Name Description

1. Audio Output
Matrix Button

This button gives access to an Audio Output Matrix used to
define which timeline track will be routed to which output track.
See section "Audio Track Selection for the Output" on page 106.

2. Fill Button When the Fill button is active, themedia dragged to the Clip
zone is automatically placed at the end of the timeline.
See section "Placing Clips onto the Timeline" on page 118.
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Part Name Description

3. Editing
Commands

The Editing buttons allow the users to perform various editing
actions on the edit loaded.
See section "Editing Buttons in the Timeline Area" on page 111.

4. Timecode Bar The Timecode bar gives a graduation of the timecode of the edit.
See section "Timecode Bar" on page 94.

5. TC and
Duration Fields

The timecode and duration fields provide time information on the
position of themark IN, mark OUT, full edit duration, or duration
betweenmarks.
See section "Timecode and Duration Fields" on page 103.

6. Track
Selection and
Audio Settings

The buttons for track selection on the left of the track are used to
select:
• the tracks to be taken into account in an editing operation
• the audio output (andmode) in playout, rendering, and export

actions.
The buttons on the right of the track are used:
• to define the audio routing for stereo tracks
• to zoom the track, and perform fine tuning on the audio

tracks. 
See section "Audio Track Selection and Settings in the
Timeline" on page 104.

7. Timeline
Display

This is a graphical representation of the edit, in which users
execute and visualize the editing actions.
See section "Reference Positions on the Timeline Display" on
page 95.

8. Scale Bar and
Move Bar

The Scale bar andMove bar allow the user to easily navigate in
the timeline.
See section "Scale Bar andMove Bar" on page 95.

6.5.2. Timecode Bar

The timecode bar, located above the timeline display, displays a graduation of the
timecode in the timeline. The timecode of the first framewill start with the timecode
defined when the edit was created.

Themost precise graduation is a graduation by frame, i.e. from frame 0 to 24 in PAL, and
from frame 0 to 29 in NTSC.

The timecode bar displays the tags (graphics) and the cue points (referencemarks).
Right-clicking the timecode bar opens the contextual menu from which you can define
tags and cue points. See sections "Cue Points" on page 135 and "Adding a Logo or
Graphic" on page 208 for more information.
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6.5.3. Scale Bar and Move Bar

Scale Bar

TheScale bar, located below the timeline display on the right hand side, makes it possible
to zoom in and out on the timeline:

• To zoom in, drag the slider to the left or rotate themouse wheel down.

• To zoom out, drag the slider to the right or rotate themouse wheel up.

Move Bar

TheMove bar, located below the timeline display on the left hand side, makes it possible
to move within the timeline when the whole timeline is not displayed in the timeline pane at
the defined scale.

6.5.4. Reference Positions on the Timeline Display

Overview

The followingmarks can be placed to define a specific position in the timeline and to be
used in editing operations:
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Nowline

This is the blue vertical marker that displays the current position on the timeline. It is used
to browse in the timeline or mark an insertion position.

Mark IN / Mark OUT Points

Themark IN point is a green vertical line on the timeline that displays the position of a
mark IN point.

Themark OUT point is a red vertical line on the timeline that displays the position of a
mark OUT point.

You will addmark IN andmark OUT points to help you placemedia in the timeline.

6.5.5. Timeline Element on the Timeline Display

Description
The timeline element is the portion of themedia added to the timeline and displayed as a
block on the timeline. It corresponds to one track of a clip added to the timeline:

Default Displayed Information
The element display on a track can contain up to seven information fields. By default, the
information displayed is the following:

Position Information Displayed

Top left Clip name

Top right Element duration

Bottom left TL TC IN (TC IN of the element in the timeline)

Bottom right TL TC OUT (TC OUT of the element in the timeline)
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Modifying the Default Information
The default information can bemodified via theSettings > Clip Display Settings
command from the Timeline Element contextual menu (available when you right-click in
the timeline display).

This calls the Clip Display Settings window where you can specify which information
should be displayed on the timeline elements:

6.5.6. Color Representation on the Timeline
Display

Overview
To assist in recognizing the processes and different actions that have been performed on
the timeline, various colors and types of shading are used.
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Note
The colors of the tracks can look differently on your screen depending on your
settings. The default colors of the timeline tracks can be changed in Xedio
Manager, via Software > Parameter Profiles > (Xedio) CleanEdit: TL Colors tab.

Colors on the Video Track

Video element with no applied effects

Video element with speed other than 100%

Video element with FX (darker blue element than
normal)

Video element with a freeze frame

Colors on the Audio Track

Normal audio element in sync with an associated
video

Normal audio element with FX

Audio element which has beenmoved out of sync
with its associated video

Normal voice-over element

Voice-over that attenuates the other tracks (on the
same output).
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6.5.7. Contextual Menus for Timeline Elements

Introduction
You can access several commands for timeline elements via a contextual menu.

The contextual menu is available when you right-click on a selected video or audio
element on the timeline.

The commands available in the contextual menu vary depending on:

• Whether you right-click on a video or audio element

• Whether the element is selected or not

• Where themouse cursor is located when you right-click on an element

The various commands available from the contextual menu are shortly presented in the
sections below. However you will find details on some of the commands in the relevant
sections of themanual.

Commands Common to Video and Audio
Elements

Clip Commands

TheClip commands in the contextual menu are available when you right-click on a
selected video or audio element on the timeline. The actions are available for both video
and audio elements, except the Angle option, only present for a video element:

Command Description

Clip > Copy Clip FX Copies the effects defined on the selected element.

Clip > Paste Clip FX Pastes the effects (which have been copied using the Copy
Clip FX command) onto the selected element.
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Command Description

Clip > Resync Resynchronizes a selected desynchronized audio element
with the video element that belongs to the same clip or to a
synchronized group.
See section "Resynchronizing Associated Clip Elements" on
page 132.

Clip > Sync Group Creates a synchronized group with the selected elements.
When one of those synchronized elements will bemoved, the
other elements will appear as being desynchronized.
See section "Grouping Elements in a Sync Group" on page
135.

Clip > Create Clip Saves the selected element as a clip in the Clip zone.

Clip > Delete Deletes the selected elements

Undo/Redo Commands

TheUndo andRedo commands are available on a selected video or audio element on
which an editing action has been performed:

• TheUndo command allows the user to cancel the editing action(s) that have been

performed after the last save. You can also cancel the editing actions by pressing
.

• TheRedo command allows the user to reapply the editing action(s) that have been
cancelled after the last save.
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Settings Commands

TheSettings commands are available when you right-click on a video or audio element on
the timeline, whether it is selected or not. The following actions are available:

Command
Default
Keyboard
Shortcut

Description

Fit to Content When the edit expands beyond the timeline
display, this command fits the whole edit into the
timeline display.

Show out of range
message

- When the command is ticked, the application will
display warningmessages when nomaterial is
available to perform the requested editing action.

Clip Display Settings - Opens the Clip Display Settings window in which
you can define which information will be
displayed on the timeline elements.
See section "Timeline Element on the Timeline
Display " on page 96.

Commands Applicable to Video Elements
TheClip > Angle, Speed, Video Clip FX, Conversion FX, and Left/Right Video
Transition FX commands are only applicable to selected video elements.

For more information on these commands, refer to the section "Replacing Clips by Linked
Clips" on page 128 for the Clip Angle command, to section "Modifying the Playback
Speed of a Clip Using the Speed Command" on page 143 for theSpeed command, and to
the chapter "Advanced Video Editing" on page 150 for the other commands.
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Commands Applicable to Audio Elements
TheAudio Channels, Right/Left Audio Transition, Get Audio Waveform, and
Duplicate Track commands are only applicable to selected audio elements.

TheAudio Channels option is explained in section "Audio Routing, Swaps andMutes"
on page 192.

TheRight/Left Audio Transition options are detailed in section "Adding Audio Transition
Effects on Elements of the Same Track" on page 188.

TheGet AudioWaveform and Duplicate Track features are explained in section
"Miscellaneous Audio Features" on page 197.
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6.5.8. Timecode and Duration Fields
The timecode information displayed on the timeline display is shortly described below.
These fields are not editable.

The following table explains the various TC and duration fields highlighted in the above
screenshot.

Part Name Description

1. Mouse Pointer
TC

When themouse is on the timeline display, the timecode
position of themouse pointer is specified on the left above the
timeline display.

2. IN/OUT/Duration
fields

IN field (Mark IN TC)
The IN field, on the right above the timeline display, indicates
the timecode of themark IN position on the timeline, if any
mark IN point is defined.
A tooltip with themark IN TC is also displayed when you
position the cursor on themark IN green line.
OUT field (Mark OUT TC)
TheOUT field, on the right above the timeline display,
corresponds to the timecode of themark OUT position on the
timeline, if any mark OUT point is defined.
A tooltip with themark OUT TC is also displayed when you
position the cursor on themark OUT red line.
DUR field (Duration IN/OUT)
TheDUR field, on the right above the timeline display,
corresponds to the duration between themark IN andmark
OUT points defined on the timeline.
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Part Name Description

3. Timeline
Duration

The Timeline Duration field, located on the right of the
editing buttons, displays the effective duration of the timeline
loaded, calculated from the start of the first element to the
end of the last element.

- Nowline TC The timecode of the nowline appears as you position the
cursor over the nowline:

This information is however not displayed as a field on the
timeline display.
If you want to position the nowline to a given TC of the
timeline, type this timecode in theNowline TC field of the
Recorder Area and press ENTER.

6.5.9. Audio Track Selection and Settings in the
Timeline

Introduction
In the timeline display, 6 tracks are visible: 1 video track and 5 audio tracks. For each
audio track, buttons are displayed on both sides of the displayed timeline track.

These buttons allow controlling some input and output settings used globally for each
track, although elements placed on a track can always be treated individually.
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Track Name and Audio Type in the Timeline
The top track represents the video track.

The other tracks represent the audio tracks which can be used in the timeline. Up to 5
audio tracks are available.

The upper part of theAudio Track buttons show the name of the audio track facing the
button in the timeline display: from A1 to A5.

The lower part of theAudio Track buttons show the audio type of the timeline track:

• 5.1:

• strereo:

• mono:

A right-click on eachAudio Track button displays a contextual menu from which you can
set the audio track type:

This can be done only if there is no element in the timeline track.

You canmute a track by clicking the correspondingAudio Track button. It will display the
following icon:
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Audio Track Selection for Editing Actions

The Track Selection check box is used to select the tracks to be taken into account
when editing actions are performed (including playout, export and rendering actions).

If one Track Selection check box is cleared before the loading of a clip, you will not be
able to load audio on this timeline track.

Video and Audio tracks can be selected by using the following shortcuts:

Track Activation Shortcut

Video

A1
+

A2
+

A3
+

A4
+

A5
+

All Audio
+

Audio Track Selection for the Output

Introduction

The number and type of the output audio tracks must be set from the Audio Output Matrix.
This matrix is also used to define which timeline track will be routed to which output track.

This is taken into account for playout, rendering and export actions.

The Audio Output Matrix is accessed by clicking theAudio Matrix button .
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Note
TheAudio Matrix button is available only if theShow Audio Matrix Button
parameter has been enabled in XedioManager > Parameter Profiles > CleanEdit
> Timeline.

Overview of the Audio Output Matrix Window

Setting the Number and Type of Audio Output Tracks
The number and type of the audio output tracks is set from theOutput Channels area.

1. Select the number of 5.1 tracks, stereo tracks and/or mono tracks.

If the resulting number of audio channels exceed 16, you will not be able to apply the
selection.

2. Click Apply.

The selection will be reflected under the Recorder Video Display as soon as the
OK button will be clicked.
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Setting the Routing between Timeline Tracks and Output
Tracks
The routing from timeline tracks to output tracks is set from theOutput Matrix area.

The timeline tracks are represented on the left, with their audio type as this has been set
through the contextual menu eachAudio Track button (mono, stereo or 5.1).

The output tracks are represented on the top of thematrix, with their audio type as this has
been set through theOutput Channels area.

To select the output track from which a timeline track will be played, click on an
intersection in the grid.

Each selection is represented by a colored bullet.

Two cases can occur.

• Both the timeline track and the output track have the same audio type. This is
represented with .

Clicking the bullet remove it and thus clear the routing defined.

• The timeline track and the output track do not have the same audio type.

a. This is represented with when the bullet is not selected.

b. This is represented with when the bullet is selected (by clicking a non selected
bullet). The audio conversion rule can therefore be established.

Clicking once a selected bullet, or twice a non selected bullet, remove it and thus clear
the routing defined.

Setting the Audio Conversion Rule
When the timeline track is routed to an output track with a different audio type, a
conversion rule must be set from the Audio Conversion Rule area.

• If the number of output channels is smaller than the number of timeline channels (5.1
to stereo or mono, stereo tomono), you will have to choose one of the conversion
rules as follows:
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• If the number of output channels is larger than the number of timeline channels (mono
to stereo or 5.1, stereo to 5.1), you will have to choose one of the conversion rules as
follows:

Warning
You need to select the check box on the right of theAudio Track button if you
want to output the corresponding audio track. Otherwise, nomaterial will be sent
to the selected output track.
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Audio Routing for Stereo Tracks

TheStereo Routing button allows defining default audio routing options for all new clips
added to a stereo track in the timeline. These default routing options are defined for each
stereo track, and are not available with mono and 5.1 tracks. If the button text is colored, it
means that a routing option has been defined.

To define the audio routing, click the button to open the Default AudioMode dialog box.
Then select one of the possible settings:

Once you have defined the routing options:

• You will be asked whether you want to apply them to the clips present in the timeline
(after confirming your choice).

• The options will automatically be applied to the new clips added to the timeline.

Track Zoom

The Zoom button expands the selected audio track in a Zoom view.

In the Zoom view, you can perform the following actions:

• Adjust cross fades on transitions. See section "Adjusting Audio Transitions" on page
192.

• Adjust audio levels of clips. See section "Audio Level Adjustments" on page 195.

• View the clip wave forms generated via theGet audio waveform command in the
contextual menu. See section "How to Generate theWaveform of an Audio Element"
on page 197.
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6.5.10. Editing Buttons in the Timeline Area

The timeline buttons allow the users to place andmanipulate clips on the timeline. In the
table below you will find a brief description of these buttons but their operation will be
detailed, wherever necessary, in the following sections.

The display of the individual buttons is enabled in XedioManager > Softwares >
Parameter Profiles > CleanEdit > Tl buttons.

Button Keyboard Shortcut Description

+

or

Undo button: to undo the last action
performed on the timeline.
When the button is available, it is colored.

+
Redo button: to redo the last action which
has been undone on the timeline.
When the button is available, it is colored.

+
Cut button: cuts the selected clip(s) from the
timeline.

+
Copy button: copies the selected clips from
the timeline.

+
Paste button: pastes the cut or copied clips in
the timeline, at the nowline position.
The behavior depends on the Insert/Overwrite
mode.

(toggle betweenmodes)

Performing edit actions in Insert mode (white
button) will shift the existing elements in the
edit before the selected clip is placed into the
edit.

(toggle betweenmodes)

Performing edit actions inOverwrite mode
(colored button) means that the result of the
editing action will replace the content of an
existing edit.

When you delete a portion of the timeline with
theDelete & Clear option active (white
button), the area from which the element is
deleted will remain empty after the deletion.

When you delete a portion of the timeline with
theDelete & Shift option active (colored
button), any element located on the right of
the deleted portion will be shifted to the left,
so as to replace the deleted elements.
Only the clips on selected tracks will be
shifted.
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Button Keyboard Shortcut Description

(toggle ON/OFF)

When theBlank Fill button is active in
Overwrite mode, themedia placed into the
timeline will fill in empty areas of the timeline.

- When theAFX button is active, the default
audio transition is automatically added on
each new clip placed into the timeline.
The default audio transition effect is defined
in XedioManager: Software > Parameter
Profiles > (Xedio)CleanEdit > Timeline tab:
DefaultAudioTransFx

- When theVFX button is active, the default
video transition is automatically added on
each new clip placed into the timeline.
The default audio transition effect is defined
in XedioManager: Software > Parameter
Profiles > (Xedio)CleanEdit > Timeline tab:
DefaultVideoTransFx

or

Clicking theMark IN buttonmarks an IN
point at the nowline position on the timeline.

or

Clicking theMark OUT buttonmarks anOUT
point at the nowline position on the timeline.

Clicking theMark Clip button puts themark
IN at the beginning of the first element
selected and themark OUT at the end of the
last clip selected.

Clicking theMark Reset button deletes the
mark IN andmarks OUT points.

+
Clicking the IN OUT Delete button deletes
the content of the timeline between themark
IN andmark OUT on the selected tracks
(check box in front of the track).

TheSelect All button allows selecting all the
timeline elements from the nowline position
on the selected tracks (check box in front of
the track).

+ +
TheCTRL + Select All button allows
selecting all the timeline elements up to the
nowline position on the selected tracks
(check box in front of the track).
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Button Keyboard Shortcut Description

+ +
When amark IN andmark OUT are defined,
theSHIFT + Select All button allows
selecting the elements (whole elements)
between themark IN andmark OUT points
on the selected tracks.

TheSplit button allows dividing the timeline
elements into two parts at the nowline
position.

TheBlank Clear button allows deleting the
common empty zones on the selected tracks
from the nowline, preserving the
synchronization between the different tracks.

- When at least two timeline elements are
selected, the Left button allows aligning the
selected elements on the left.
It will take the last element selected as the
reference position for the left-alignment.

- When at least two timeline elements are
selected, theRight button allows aligning the
selected elements on the right.
It will take the last element selected as the
reference position for the right-alignment.

- TheExtend button allows extending or
shortening a clip on the selected track(s),
modifying its IN or OUT point to a position
defined by amark IN or mark OUT on the
timeline.
See section "Extending or Shortening a Clip"
on page 138 for more information on the
Extend function.

- TheExtend Still button allows:
• extending the IN point of a selected video

element as a still frame (0% motion) up to
amark IN defined before the IN point.

• extending the OUT point of a selected
video element as a still frame up to a
mark OUT defined after the OUT point.

See section "Extending a Clip with a Still
Frame" on page 141 for more information on
the Extend Still function.
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Button Keyboard Shortcut Description

- TheExtend Speed button allows:
• extending the IN point of a clip up to a

mark IN defined, without modifying its
content.

• extending the OUT point of a clip up to a
mark OUT defined, without modifying its
content.

The effect achieved is a slow motion or fast
motion clip.
See section "Extending or Shortening a Clip
by Modifying its Speed" on page 142 for more
information on the function.

- TheColor Insert button allows replacing the
timeline content by a color flash between a
mark IN andmark OUT defined.
The flash duration and color are defined by
right-clicking theColor Insert button and
selectingProperties from the contextual
menu.

- TheAudio/Video Fx button allows:
• inserting colors on the video transition of

the next or previous cut. See section
"Inserting Blocks of Color Frames" on
page 157.

• modifying the audio levels. See section
"Audio Level Adjustments" on page 195.

• creating default audio transitions. See
section "Adding Audio Transition Effects
on Elements of the SameClip" on page
190.
Such audio effects can be performed on
selected clips, on a whole audio track, or
several ones.
When you want to apply the effect on a
whole track, removemark IN or mark
OUT, if any, and place the nowline at the
beginning of the edit, clicking theHome
key.

- TheCue button allows aligning audio or video
events of different tracks on the nowline or to
the cue points defined.
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Button Keyboard Shortcut Description

- The ab button allows inverting the audio clips
between two audio tracks, from the nowline
onwards.
This option is enabled, when you position the
nowline where requested, and select two
audio tracks from the nowline.

- TheS button allows you to render fast motion
clips.
This button is enabled as soon as a fast
motion clip is detected in the timeline.

Note
The use of ShuttlePRO keys for editing functions is detailed in "Appendix 1 –
ShuttlePRO" on page 251.
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7. General Editing

7.1. Marking Positions on the Timeline

7.1.1. Adding Marks
Using the buttons displayed on the screenshot below, you canmark points to edit
accurately on the timeline. You can use thesemarks to place your clips into the timeline,
but also in many other editing actions.

The followingmarks can be defined in the timeline:

Name Description To define the mark, …

Nowline Blue vertical line, which
displays the current
position on the timeline.

click on the timeline ruler where you want
to place the nowline.

Mark IN Green vertical line, which
displays the position of a
mark IN point.

place the nowline at the requested position

and click theMark IN button .

Mark OUT Red vertical line, which 
displays the position of a
mark OUT point.

place the nowline at the requested position

and click theMark OUT button .
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7.1.2. Adding Mark IN and Mark OUT Over Several
Elements

You can also use theMark Clip button to add amark IN and amark OUT points
between selected elements.

Prior to click , click an element before which you want to place themark IN and an
element after which you want to place themark OUT.

7.1.3. Removing Marks

Removing a mark IN

Press on the keyboard.

Removing a mark OUT

Press on the keyboard.

Removing the mark IN and mark OUT

Press on the keyboard or click the in the timeline.

7.2. Selecting Techniques

7.2.1. Selecting a Clip
To select an element of a clip, move themouse onto it and click.

The color of the selected element will change to a dark blue (or as defined in Xedio
Manager, via Software > Parameter Profiles > (Xedio) CleanEdit: TL Colors tab).

To select multiple elements for a common operation, use theCTRL key for non-
contiguous elements andSHIFT key for contiguous elements.
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7.2.2. Selecting Elements Depending on Nowline
or Mark Positions
The following table shows how you can select elements from the nowline, up to the
nowline or between themark IN andmark OUT. In all cases, the selection will be
performed on entire elements, not from themark positions:

To select all elements (entire elements) … Proceed as follows:

from the nowline
up to the end of the edit, Click or press .

from the beginning of the edit
up to the nowline, Click + or

press +

between the mark IN and mark OUT
Click + or

press +

7.3. Placing Clips onto the Timeline

7.3.1. Introduction

Various Methods to Add Clips to an Edit

There aremany different ways to add clips onto your edit. Themainmethods for placing a
clip to your edit are the following ones:

• Dragging the clip into the Clip zone when the Fill button is active.

This adds the clip to the end of the timeline.

• Dragging the clip from the Clip zone to a given position in the edit.

• Dragging the clip from the Player to a given position in the edit.
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Possible Positions of a Clip in an Edit

Depending on the Insert/Overwrite mode you have selected, you can drag a clip to the
following positions into the timeline:

• at the end of the clip

• on a transition

• on the nowline

• on amark IN or mark OUT point

• between amark IN andmark OUT points

• anywhere in the edit

This will be explained in details in the following sections.

7.3.2. Important Prerequisites

Introduction
Before you drag a clip into an edit, you always need to perform the following actions:

1. Select the Insert or Overwrite mode with the Insert/Overwrite button in the timeline:

2. Select the clip tracks to be added to the edit.

Insert and Overwrite Modes
Before you drag a clip onto the timeline, you need to define the way you want to insert it.
Twomodes are available: Overwrite or Insert.

You select themode and toggle between bothmodes by:

• clicking theOverwrite/Insert Mode button

• pressing the keyboard key.
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Mode Description

Overwrite
(default)

(white)

Adds themedia in the timeline, overwriting the existingmedia from the
selected position. In other words, themedia in the timeline will be
removed from the insertion point by the duration of the addedmedia.

Insert

(colored)

Adds themedia in the timeline without overwriting existingmedia and
pushes further right the existing elements of the timeline placed after this
position.
In this mode, you can only insert themedia on the clip boundaries which
are common to all selected tracks. The blank areas are not taken into
account. The possible insertion point is shownwith a red arrow on the top
of the timeline:
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Selecting the Tracks to be Added to the Timeline
and their Audio Type
The following constraints apply when placing a clip on the timeline:

• It is not allowed to drop a clip over the video area of the timeline. This rule does not
apply to a clip containing exclusively a video element.

• Timeline audio tracks must be selected (from the check box).

• Dropping clips into the timeline is only possible between the same types of audio
tracks. You will not be able to drop a stereo track on a 5.1 track. Timeline audio track
typemust have been set according to the clip track audio type: if the clip contains two
5.1 tracks and 2 stereo tracks, they must be set in the timeline.

• The number of clip audio tracks must not exceed the number of available timeline
tracks. A clip with 5 stereo tracks will not be droppable if a 5.1 track has been set in
the timeline, as only 4 stereo tracks will be available.

• Only 5 audio tracks are available in the timeline. It is therefore not possible to place a
clip with more than 5 audio tracks. If the clip contains more than 5 audio tracks:

◦ When you drag a clip from the Player onto the Timeline, only the tracks selected in
the Player with the track selection buttons will be added to the edit:

◦ When you drag a clip from the Clips zone to the timeline, only the active tracks of
the clip will be added to the edit.

7.3.3. Tools to Easily Position Clips in the
Timeline

Clip Shadow During Drag Action

When you place a clip within the timeline, a shadow corresponding to the clip (frommark
IN tomark OUT) is displayed to indicate where the clip will be positioned.
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Magnetic Effect

When you place the clip around amark (whatever themark), a magnetic effect helps you
place the clip precisely at the requested position.

7.3.4. Placing Clips in an Edit Depending on the
Requested Position

Preliminary Steps
Before you drag a clip into an edit, you always need to perform the following actions:

1. Select the Insert or Overwrite mode with the Insert/Overwrite button in the timeline:

2. Select the clip tracks to be added to the edit

This section provides more detailed information on these steps.

Note
When you place clips in Insert mode, you can only use the Fill button, or place
the clip on a transition or at the end of the edit. The other options are not
available.

Automatic Clip Insertion at the End of an Edit (Fill)

If the Fill button is active  (colored display) and the clip is dragged to the Clips zone
of the Project area, it will also be placed on the timeline, at the end of any material
currently on the timeline.

Placing a Clip at the End of an Edit or on a
Transition
To add a clip at the end of the last clip of the timeline or on a transition, drag the clip to the
requested position:

• In Overwrite mode, you can use themagnetic effect to place the clip exactly after the
last frame or on the transition.

• In Insert mode, a colored down arrow appears above the timeline to indicate
where the clip will be placed.
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Placing a Clip Using the Nowline, Mark IN or Mark
OUT
The following table presents themain options to define the position of a clip when it is
added to the timeline using the nowline, themark IN or themark OUT position. These
actions can only be performed in the Overwrite mode.

To position the IN point of the clip … Do the following:

• on the IN point of a clip in the edit
OR

• on the nowline in the edit

Drag and drop the clip straight onto the
transition, or the nowline, and release the
mouse button.

• on themark IN in the edit Drag and drop the clip on the left of the
mark IN, and release themouse button.

• on themark OUT in the edit Drag and drop the clip on the right of the
mark OUT and release themouse button.

To position the OUT point of the clip … Do the following:

• on the nowline in the edit Drag and drop the clip straight onto the
nowline pressing theCTRL key. Then
release themouse button.

• on themark IN in the edit While you press theCTRL key, drag and
drop the clip on the left of themark IN, and
release themouse button.

• on themark OUT in the edit While you press theCTRL key, drag and
drop the clip on the right of themark OUT
and release themouse button.

Placing a Clip Anywhere in the Timeline
To place the clip anywhere in the timeline, drag the clip to the requested position in the
timeline, and release themouse button.

During the drag action, a shadow corresponding to the clip is displayed to indicate the clip
position in the timeline. Moreover, the timecode field on the upper left of the timeline
displays themouse cursor.
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Placing a Clip Between Mark IN and Mark OUT
(Fit to Fill)
A clip (or a portion of a clip between amark IN and park OUT defined in the player) can be
dragged to the timeline between a definedmark IN andmark OUT points. This feature is
also called Fit to Fill or four-point edit.

In case the length of the clip differs from the length between themark IN andmark OUT
points on the timeline, the clip can be inserted in several ways:

• Drag and drop the clip between themark IN andmark OUT points on the timeline:

The IN point of the clip matches themark IN on the timeline and the clip length is
modified.

• Drag and drop the clip between themark IN andmark OUT points on the timeline with
theCTRL key pressed:

TheOUT point of the clip matches themark OUT on the timeline and the clip length is
modified (from its IN point).

• Drag and drop the clip between themark IN andmark OUT points on the timeline with
theALT key pressed:

The clip is placed between themarks on the timeline. The clip length equals the length
set in the player but the speed is calculated automatically and depends on the duration
between the timelinemarks.

7.3.5. Add a Clip To Fill in a Blank Area in the
Timeline

Introduction
TheBlank Fill mode is used to place clips on the timeline to fill in areas of the timeline
where there is nomedia present. Even when the clip is longer than the blank to be filled,
this mode ensures the next clip is not overwritten. This mode will only work in combination
with the Overwrite mode.

To activate theBlank Fillmode, click the button. The button will turn colored.
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Methods
Depending on the expected result, you can proceed in three different ways:

• Drag the clip to be added to the beginning of the blank area:

The IN point of the clip is matched to the beginning of the blank area.

• Drag the clip anywhere in the blank area

The IN point of the clip to be added will be dropped where you have released the
mouse.

• Drag the clip in the blank area, while pressing theCTRL key:

TheOUT point of the clip to be added will bematched to the end of the blank area

• Drag the clip in the blank area, while pressing theALT key:

If the clip is… Then…

greater than the
hole in the timeline

The clip speed will be decreased tomatch the blank area.

smaller than the
hole in the timeline

The clip speed will be increased tomatch the blank area.
The following criteria must bemet:
• the parameter “Can Accelerate” must have been enabled in

XedioManager > Softwares > Parameter Profiles > CleanEdit.
• themaximal speed, set with the “Max Fast Motion Speed”

parameter, must not be exceeded.

Example
The following screenshots show the situation before, during and after the drag-and-drop
operation using the blank fill option. In this case, the clip is dropped at the beginning of the
blank area.

Before
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During

After

7.4. Moving Clips or Elements on the
Timeline

7.4.1. Moving a Clip or Element in the Timeline

Note
TheOverwrite and Insert modes are also applicable tomoving actions.

Tomove a clip freely on the timeline, select it first (see section "Selecting Techniques" on
page 117), and then drag it to its new position.

Themagnetic effect, that "sticks" the elements when near the nowline, mark IN, mark
OUT and the clip edges on the elements already present on the timeline can ease the
movements of the edit elements.
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Note
If an element selected has other elements associated with it (for example the
video element from a clip with the associated audio elements), moving only one
of the elements will desynchronize the other elements. This will show on the
timeline by the associated audio turning red:

See section "Resynchronizing Associated Clip Elements" on page 132 to
resynchronize elements.

7.4.2. Moving an Audio Clip between Tracks
without Modifying its Horizontal Position
You canmove an audio element between tracks without modifying its position compared
to the other elements of the clip. This will prevent from audio desynchronization.

Tomove an audio element between tracks, without modifying its horizontal position,
proceed as follows:

1. Select the clip by clicking once with the left button of themouse.

2. Keep theSHIFT key pressed.

3. Drag the clip to the audio track desired.

7.4.3. Moving Several Elements in the Timeline
You can use the following keyboard combination to cut, copy and paste one or more
elements selected in the timeline.

You can select several elements using or + click on the elements to
be selected.

Action Keys Description

Cut elements
+

Removes the selected elements from the edit
and keep them in the clipboard, in preparation
to pasting them to a new location in the
timeline.

Copy elements
+

Copies the selected elements to the
clipboard, in preparation to pasting them to a
new location on the timeline.

Paste elements
+

Pastes the selected elements on the nowline.
The element which was located furthest left
on the timeline is pasted on the nowline
position, the other ones are pasted further
right, based on their original position
compared to the first element. 
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7.5. Replacing Clips by Linked Clips

7.5.1. Introduction
Linked clips can have been created in several ways, such as:

• clips have been created from ganged recorder channels in IPDirector and then sent to
Xedio Suite,

• clips have been created on several recorder channels on an EVS video server and
then imported from the EVS server tab of Xedio Importer or Media Importer,

• server recorder channels have been ganged from XedioManager (LinX > EVS Video
Server), then a train is dragged from the EVS Server sub-tab of Media Importer to the
Media zone of the Project area. Creating a clip from this train will create a linked clip
on the ganged recorder channel.

When such a clip is used in an edit, it can easily be replaced by one of its linked clips. You
can therefore use a sequence recorded through a different camera angle.

7.5.2. How to Replace a Clip by a Linked Clip
1. Select the clip you want to replace.

2. Right-click on it to access the contextual menu:

3. Select Clip > Angle and then one of the ganged cameras.

The clip is replaced by its linked clip.
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7.6. Deleting Clips or Elements From the
Timeline

7.6.1. Deletion Methods
There are several ways to delete media from the edit on the timeline:

• Deleting selected (entire) elements of an edit.

See section "Deleting Timeline Elements" on page 131.

• Deleting portions of an edit selected using themark IN andmark OUT points.

See sections "DeletionModes" on page 129 and "Deleting Portions of an Edit" on
page 130.

7.6.2. Deletion Modes

To select the Deletionmode and toggle betweenmodes, you can click the button or

press . The following table briefly explains the two deletemodes:

Button Keyboard
Shortcut Description

When you delete a portion of the timeline with theDelete & Clear
option active (white button), the area from which the element is
deleted will remain empty after the deletion.

When you delete a portion of the timeline with theDelete & Shift
option active (colored button), any element located on the right of
the deleted portion will be shifted to the left, so as to replace the
deleted elements.
Only the clips on selected tracks will be shifted.

Note
This mode doesn't take into account the synchronization between the different
tracks and so can easily cause a desynchronization of associated clip
elements.
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7.6.3. Deleting Portions of an Edit

Procedure
To delete a portion of an edit on the timeline, proceed as follows:

1. Select the deletionmode you want to apply, using the button.

2. Place amark IN andmark OUT to define the portion of the edit to be removed.

3. Do one of the following:

◦ Click .

◦ Press + .

The portion of the timeline between themark IN andmark OUT is removed.

The remaining timeline elements on the right of the deleted area are shifted left or not,
depending on the deletionmode selected.

Example
In the example below, the portion of the clip ADL_CLP_091208_1-01 between themark IN
andmark OUT is deleted as you click the IN OUT Delete button. The optionDelete &
Shift is active during the deletion, whichmeans that thematerial on the right of themark
OUT is shifted to the left after the Delete action.
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7.6.4. Deleting Timeline Elements

Procedure
There are various ways of deleting entire element(s) or a whole clip from the timeline.

To delete one or more elements in an edit, proceed as follows:

1. Select the deletionmode you want to apply, using the button.

2. Select the elements to be deleted, usingCTRL orSHIFT + click if you want to select
several elements.

3. Do one of the following:

◦ Press on the keyboard.

◦ Right-click in the edit and select Clip > Delete from the contextual menu.

The selected elements are removed from the edit.

The remaining timeline elements on the right of the deleted elements are shifted left if the
Delete and Shiftmode is active and if a blank area is left on all the tracks after the
deletion.

Example
In the example below, both video and audio elements of a clip are deleted using theDelete
command in the contextual menu. TheDelete & Shift option is active, whichmeans that
thematerial on the right of themark OUT is shifted to the left after the delete action.
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7.7. Tidying Up and Organizing the Edit

7.7.1. Resynchronizing Associated Clip Elements
When an audio element becomes desynchronized from its associated video, it will turn
red (by default) and display the offset value:

Desynchronized Element:

To resynchronize the element, right-click the element and select Clip > Resync from the
contextual menu:
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7.7.2. Removing Blank Areas on a Timeline

Procedure
When the edit contains common empty areas on all the video and audio tracks, you can

remove these using theBlank Clear button . This option keeps the synchronization
between the different tracks.

To remove common blank areas on a timeline, proceed as follows:

1. Ensure that all the tracks are selected in the timeline with the Track Selection check
box in front of each track.

2. Position the nowline on the left of the blank area to be removed.

3. Click theBlank Clear button or press .

The common empty zones are deleted.

Example
In the example below, theBlank Clear button is used to remove the blanks common to all
tracks:

Before
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After

7.7.3. Aligning Elements on a Reference Element

You can align left or right one or more elements on a reference element with the or

:

• A left alignment means you will align the IN point of the elements on the IN point of the
reference element.

• A right alignment means you will align the OUT point of the elements on the OUT point
of the reference element.

The elements which are aligned will overwrite existingmaterial on the timeline.

To right or left align elements on a reference element, proceed as follows:

1. UsingCTRL + click, select:

2. first the elements to align,

3. last the reference element (on which the other elements should be aligned).

4. Do one of the following:

◦ To align left, click the button.

◦ To align right, click the button.

7.7.4. Splitting an Element in the Timeline

Clicking theSplit button or pressing will splits any element at the current
position of the nowline. Only the elements on the tracks ticked with the Track Selection
check box will be split.
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7.7.5. Grouping Elements in a Sync Group

Introduction
If a clip has elements including both video and audio when placed on the timeline,
synchronization between the elements is maintained and any desynchronization is shown
by displaying the audio in red.

However, sometimes it is necessary to synchronize elements on the timeline that has no
previous association, for example to add real time synchronized audio to a slow motion
replay or keep a synchronized relationship between amusic track and certain video
elements.

Procedure
To define a synchronized group of elements, proceed as follows:

1. Select the group of elements to be synchronized.

2. Right click on themouse and select Clip > Sync Group from the contextual menu.

When the group of synchronized elements is defined, the audio elements which are
moved compared to the synchronized video element will be displayed as desynchronized
elements (red).

To see the group of audio elements grouped and synchronized with a video element, press
SHIFT and click the requested video element.

You can remove an element from a sync group by redefining the sync group without this
element.

7.8. Cue Points

7.8.1. Introduction
The cue points are referencemarks that can be placed in the timecode bar wherever
needed in the edit. Their primary goal is to mark the edit with a visual flag and, optionally, a
description of the event, and therefore to ease the access to a precise position on that
edit.

They are represented by a yellow triangle with their number written in them. Each logged
event contains a timecode, a label and a description.
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7.8.2. How To Add Cue Points
To create a cue point, proceed in one of the following ways:

• Position the nowline where you want to place the cue point, press , followed by a
number on the keypad, and then press ENTER.

• Right-click on the timecode bar, and select Add Cue Point from the contextual
menu.

To create a cue point rapidly when an edit is being played, press +

7.8.3. How To Go to and Select Cue Points
To go to a defined cue point:

• Press the cue point number on the keypad, and press ENTER.

To select a specific cue point:

• Click the cue point on theMedia bar.

The cue point will turn purple when selected.
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7.8.4. Contextual Menu for Cue Points
The contextual menu of the timecode bar gives in addition some options for the tags and
cue points, when they are selected.

Tomove the nowline to the cue point on which you have right-clicked, select theSnap
Nowline to Item command. You can also press the number corresponding to the cue
point on the keypad and validate withENTER.

Tomove the cue point on which you have right-clicked to the nowline position, select the
Snap Item to Nowline command.

7.9. Extending or Shortening Clips

7.9.1. Introduction
It is possible to extend or to shorten the duration of a clip previously added to the edit, by
modifying the IN or OUT point. Thematerial from the original media will be used to extend
the clip, if available. TheOverwrite or Insert modes are taken into account in extend
actions.

This can be done in different ways:

• using one of theExtend editing buttons on the timeline: , ,

• dragging themedia on the timeline itself.
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7.9.2. Extend Modes
Different extendmodes are available to achieve slightly different results:

Function Function Name and Description

Extend TheExtend button allows extending or shortening a clip on the
selected track(s), modifying its IN or OUT point to a position defined
by amark IN or mark OUT on the timeline.
See section "Extending or Shortening a Clip" on page 138.

Extend Still TheExtend Still button allows:
• extending the IN point of a selected video element as a still frame

(0% motion) up to amark IN defined before the IN point.
• extending the OUT point of a selected video element as a still

frame up to amark OUT defined after the OUT point.
See section "Extending a Clip with a Still Frame" on page 141.

Extend Speed TheExtend Speed button allows:
• extending the IN point of a clip up to amark IN defined, without

modifying its content.
• extending the OUT point of a clip up to amark OUT defined,

without modifying its content.
The effect achieved is a slow motion or fast motion clip.
See section "Extending or Shortening a Clip by Modifying its Speed"
on page 142.

7.9.3. Extending or Shortening a Clip

Definition and Variations
TheExtend function shortens or extends the duration of an element or a clip to amark IN
or mark OUT defined, using the content of the original media if available.

If the original media does not include additional material, this will not be possible to extend
the selected elements or clip.

You can perform one of the following actions:

• Extend the IN point of a clip

• Extend the OUT point of a clip

• Shorten the IN point of a clip

• Shorten the OUT point of a clip
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How to Extend or Shorten a Clip Using the Extend
Button

Procedure

To extend or shorten selected elements or clip, proceed as follows:

1. If required, change theOverwrite or Insert mode clicking the button.

2. Depending on whether you want to extend or shorten the selected elements or clip on
its IN or OUT point, do one of the following:

3. To extend the IN point, place amark IN before the IN point to be extended.

4. To extend the OUT point, place amark OUT after the OUT point to be extended.

5. To shorten the IN point, place amark IN after the IN point to be shortened.

6. To shorten the OUT point, place amark OUT before  the OUT point to be shortened

7. Select the elements or clip to be extended or shortened.

8. Click theExtend button .

The IN or OUT point of the elements or clip that had to be extended or shortened has been
moved and the possible additional material has been retrieved from the original media.

Note
If there are both, an IN and anOUT point on the edit, a popup window will ask
the operator to choose to whichmark he wants to extend the element selected.

Example

In the example below, you work in Overwrite mode and want to extend the IN point of the
clip called "Clip3".

To do this, you select the clip to be extended and place amark IN where you want the IN
point of the clip to be extended to.
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The screenshot below shows the extended clip:

How to Extend or Shorten a Clip Using a Drag
Operation

Procedure

To extend or shorten selected elements or a clip on the IN or OUT point using a drag
operation, proceed as follows:

1. If required, change theOverwrite or Insert mode clicking the button.

2. Select the elements or clip to be extended or shortened.

3. Position themouse cursor over the 3 lines symbol near the IN or OUT point of the clip
and drag the clip edge to the required position on the timeline.

4. Release themouse.

Example

In the example below, you work in Overwrite mode and want to extend the OUT point of
the clip called "Clip3".
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7.9.4. Extending a Clip with a Still Frame
TheExtend Still function repeats only the first/last frame of a clip up to themodified IN or
OUT point.

To extend a clip with a still frame, proceed as follows:

1. If required, change theOverwrite or Insert mode clicking the button.

2. Select the video element to be extended with a still frame.

3. Do one of the following:

◦ To extend the IN point, place amark IN before the IN point of the selected
element.

◦ To extend the OUT point, place amark OUT after the OUT point of the selected
element.

4. Click theExtend Still button .

The clip is extended and the extended area is filled in with the first frame of the clip (when
the IN point has been extended) or with the last frame of the clip (when theOUT point has
been extended).

Note
Increasing the length of a video element by dragging the element edge and
pressingSHIFT simultaneously will extend the element with a still frame.
This is done in the sameway as the normal Extend operation explained in
section "How to Extend or Shorten a Clip Using a DragOperation" on page 140.
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7.9.5. Extending or Shortening a Clip by
Modifying its Speed
TheExtend Speed function keeps the original length of the clip but modifies the play
speed to fit in themodified IN or OUT point. In this case a rendering is needed.

To extend or shorten a clip by modifying its speed, proceed as follows:

1. If required, change theOverwrite or Insert mode clicking the button.

2. Select the video element to be extended or shortened by modifying the play speed.

3. Do one of the following:

◦ To extend the IN point, place amark IN before the IN point to be extended.

◦ To extend the OUT point, place amark OUT after the OUT point to be extended.

◦ To shorten the IN point, place amark IN after the IN point to be shortened.

◦ To shorten the OUT point, place amark OUT before the OUT point to be
shortened

4. Click theExtend Speed button .

The clip is extended or shortened without adding or removing videomaterial but its play
speed is adapted to fit between themodified IN or OUT point.

Note
Increasing or reducing the length of a video element by dragging the element
edge and pressingALT simultaneously will create a fast or slow motion clip.
This is done in the sameway as the normal Extend operation explained in
section "How to Extend or Shorten a Clip Using a DragOperation" on page 140.
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7.10. Creating Fast Motion Clips

7.10.1. Various Ways to Create Fast Motion Clips
Fast motion clips can be created using one of the followingmethods:

• Defining the speed from the clip contextual menu, with theSpeed command.

See section "Modifying the Playback Speed of a Clip Using the Speed Command" on
page 143.

• Using theExtend Speed button .

See section "Extending or Shortening a Clip by Modifying its Speed" on page 142.

• Dragging the transitions while pressing theALT key.

See section "Extending or Shortening a Clip by Modifying its Speed" on page 142.

• Using the Fit to Fill feature (also called 4-point edit).

See section "Placing a Clip BetweenMark IN andMark OUT (Fit to Fill)" on page 124.

7.10.2. Modifying the Playback Speed of a Clip
Using the Speed Command

Procedure
To change the speed of a clip, select the video element of the clip to change, right-click it,
and select Speed from the contextual menu. You can do one of the following:

• Select a preset speed (for slow motion clips) in the available list

• Click theXX.Y% option and enters the required playback speed in the dialog box that
opens.
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Result
Once the speed has been changed, the length of the video element is adapted accordingly
and will show a square pattern to indicate the clip speed has been adjusted.

Themodified speed is displayed next to the element name:

In Overwrite mode, this may removematerial after the clip.

When the clip speed exceeds 100%, you need to render the clip, using the button.
See section "Rendering Fast Motion Clips" on page 144 for more information on fast
motion clips.

7.10.3. Rendering Fast Motion Clips

You should render fast motion clips: TheRendering button is enabled above the
timeline as soon as a fast motion clip is detected in the timeline.

When you check an edit with fast motion clips that have not yet been rendered, the
followingmessage will be displayed:

SelectingYeswill render the fast motion clips immediately, selectingNowill leave them
as such (not rendered). The transcoding codec used for the rendering of a fast motion clip
is set in XedioManager.

The name of the rendered file follows the pattern below:

FM_IdMediaOrigin_tcInMedia_tcOutMedia_speed_GUID_[lr/ hr].[ext]

where:

IdMediaOrigin = ID of the original media
tcInMedia = TC IN (in HHMMSSFF)
tcOutMedia = TC OUT (in HHMMSSFF)
speed = Speed (in%)
GUID = Unique identifier (GUID)
lr/hr = Resolution: either lr (lo-res) or hr (hi-res)
.ext = File format depending on the codec type
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Note
Before launching a Fast Motion Rendering process, when working with the low
resolution, you need tomake sure the high-resolutionmedia files are also
available on themain storage.
If the high-resolution file is missing, a popup window appears to inform you the
high-resolution file is not available. You need to restore this file from the Archive
before launching the rendering.

7.11. Trimming Edit Points on the Timeline

7.11.1. Definition and Access to Trim Area
The Trim functions (also called Roller functions) consist of adjusting the IN or OUT point
of a timeline element or clip. This function is used to fine-tune transitions between two
elements after you have performed the first rough cuts.

The Trim function will shorten or lengthen the element that is in trim mode. The length of
the following or previous element will be impacted in Overwrite mode.

To display the Trim area, click the button located between the Player and
Recorder areas. If a trim is not allowed at an edit point, the buttons will not be active.

7.11.2. Overview on the Trim Functions
The following table shows an overview on the various buttons available in the Trim area.
See section "Activating the Trim Functions" on page 147 to know how to activate the
functions.

Button Description

The Trim OUT button allows the user to modify the OUT point of the clip
before the transition.

The Trim IN button allows the user to modify the IN point of the clip after
the transition.

This Roll Transition button allows the user to modify both the OUT point
of the clip before the transition AND the IN point of the clip after the
transition.

During a trim operation, the two central counters provide precise
information on the number of frames that will be trimmed.
Themeaning of the figures differs whether you are performing:
• a Trim OUT, Trim IN, Roll Transition on one hand
• a Roll Clip on the other hand
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Button Description

TheSave button confirms and applies the trim operation to the edit.

TheCancel button cancels the trim operation.

TheRoll Clip button allows the user to modify the IN and theOUT points
of the selected clip, leaving its length unchanged.

TheMatch Frame button allows the user to retrieve the original media that
contains the image displayed in the Recorder and load this same image in
the Player.

TheRET button allows the user to load, in the Player, the EVS Server
record train that contains the image displayed in the Recorder.

7.11.3. Trimming or Rolling Around the Clip
Transition

Introduction

The three upper buttons make it possible to trim around a clip transition. The following
table describes what the buttons are used for.

Button Description

The Trim OUT button allows the user to modify the OUT point of the clip
before the transition:
• by adding a frame to it when you click the button.
• by removing a frame to it when you press SHIFT and click the button

simultaneously. 

The Trim IN button allows the user to modify the IN point of the clip after the
transition:
• by adding a frame to it when you click the button.
• by removing a frame to it when you press SHIFT and click the button

simultaneously. 

This Roll Transition button allows the user to modify both the OUT point of
the clip before the transition AND the IN point of the clip after the transition.
This function "rolls" the transition:
• on the right when you click the button.
• on the left when you press SHIFT and click the button simultaneously.
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Activating the Trim Functions
These buttons are only available when the nowline is located on a transition common to all
selected tracks. For each track unused on the transition, the corresponding Track
Selection check box must be cleared.

When you first use one of the Trim functions, it changes the configuration of the Player
and the Recorder preview windows:

• The Player displays the last frame of the clip before the transition.

• The Recorder displays the first frame of the clip after the transition.

How to Trim Around the Clip Transition
To trim around the clip transition, proceed as follows:

1. Place the nowline on the transition you want to trim.

The Trim buttons become active.

2. Click the Trim button corresponding to the requested trim action.

The last frame of the clip before the transition is loaded onto the Player.

The first frame of the clip after the transition is loaded onto the Recorder.

The counters are initialized to 0.

3. Click the requested Trim button as many times as the number of frames you want to
trim the transition.

The upper counter specifies the number of frames that will be added to (move to right)
or removed from (move to left) the end of the clip before the transition.

The lower counter specifies the number of frames that will be added to (move to left) or
removed from (move to right) the beginning of the clip after the transition.

4. Once the trim action has been defined, you can

◦ confirm the trim action by clicking

◦ reinitialize the trim operation by clicking

When you confirm the trim action, it is applied to the relevant clip, the counter information
disappears.
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7.11.4. Rolling a Clip

Introduction

The buttonmakes it possible to roll a clip, whichmeans tomodify the IN and theOUT
points of the selected clip, leaving its length unchanged.

This function "rolls" the clip:

• on the left when you click the button:

This adds frames at the beginning of the clip and removes the same number of frames
at the end.

• on the right when you press SHIFT and click the button simultaneously:

This removes frames at the beginning of the clip and adds the same number of frames
at the end.

Activating the Roll Clip Function
TheRoll Clip button is only available when the nowline is located on a transition common
to all selected tracks, and when the clip to be rolled is selected.

When you first use theRoll Clip button, it changes the configuration of the Player and the
Recorder preview windows:

• The Player displays the first frame of the clip to be rolled.

• The Recorder displays the last frame of the clip to be rolled.

How to Roll a clip
1. Place the nowline before the clip you want to roll and select the clip.

TheRoll Clip button becomes active.

2. Click theRoll Clip button:

The first frame of the clip is loaded onto the Player.

The last frame of the clip is loaded onto the Recorder.

The counters are initialized to 0.
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3. Click theRoll Clip button as many times as the number of frames you want to roll the
clip.

The upper counter specifies the number of frames the IN point of the clip will be
shifted to the left (negative value) or to the right (positive value).

The lower counter specifies the number of frames theOUT point of the clip will be
shifted to the left (positive value) or to the right (negative value).

4. Once the roll action has been defined, you can

◦ confirm the action by clicking

◦ reinitialize the operation by clicking

When you confirm the action, it is applied to the clip, the counter information disappears.

Note
Please refer to the keyboard shortcuts reference chart appended to this user
manual for detailed assignments.

7.11.5. Retrieving the Source of an Edited Image

The images of the edit are previewed in the Recorder area. You can use theMatch Frame
button accessible in the Trim area to display the source of one of those images in the
Player, and to have the entire corresponding original media available.

To retrieve the source of an edited image, proceed as follows:

1. Display the desired image in the Recorder area.

2. Click theMatch Frame button in the Trim area or press theBackspace keyboard key.
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8. Advanced Video Editing

8.1. Introduction
The advanced video editing chapter will cover the effects which can be added to video
clips, either on transitions, or on the clip elements themselves.

All these effects can be defined via the clip contextual menu. The contextual menu is
available when you select a video element, and right-click on it.

8.2. Video Transition Effects

8.2.1. Automatic Video Transition Effects

Once you click the button to activate theVFX function, a default video transition is
added to each new clip placed into the edit. By default, the default video transition is a
mix.

You canmodify the default video transition effect, as described in section "How toModify
the Default Video Transition Effect" on page 151.

8.2.2. Manual Video Transition Effects
You can add transition effects "manually", either to a specific transition or to all transitions
located between a definedmark IN andmark OUT.

The following video transition effects are available: Cut, Mix, Wipe, BorderWipe, Dip to
Color, RTD Effect.

To be able to define transition effects, you will right-click the video elements as follows:

When you right-click… The transition effect will be applied to…

near the IN or OUT point of a clip the transition nearest to themouse cursor.

between a definedmark IN andmark OUT all the transitions between themarks.
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This will give you access to the contextual menu and to the (Left/Right) Video
Transition commands.

You can also remove the previously defined transition effects clicking theClear All sub-
command in the contextual menu.

See section "How to Apply Video Transition Effects Manually" on page 151 for more
information on how to define the transition effects.

See section "Possible Video Transition Effects" on page 153 for more information on the
various types of transition effects.

8.2.3. How to Modify the Default Video Transition
Effect
The default transition is defined in XedioManager: Software > Parameter Profiles >
(Xedio)CleanEdit > Timeline tab: DefaultVideoTransFx.

However, you canmodify the default video transition effect as follows:

1. Right-click the icon and select Properties.

The Video Transition Effect window is displayed.

2. Specify the requested default transition effect

3. Click OK.

The new transition effect is now the default transition associated with your user profile.

8.2.4. How to Apply Video Transition Effects
Manually
To apply video transition effects to one or several transitions, proceed as follows:

1. Select the transitions where to apply the effects in one of the following ways:

◦ To define an effect on a single transition, position themouse cursor next to the
video transition on which you want to add the effect.

◦ To define an effect on several transitions, add amark IN andmark OUT beyond
the relevant transitions.
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2. Do one of the following:

◦ Right-click to access the contextual menu and select the requested effect type in
the (Left / Right) Video Transition command.

◦ Press .

TheVideo Transition Effectswindow opens. In this window, you can still select
another effect. The fields will be adapted according to the selected effect. The
definition of the transitions where the effect will be applied, in the Area group box,
cannot bemodified.

3. In theVideo Transition Effectswindow, fill in the transition parameters to specify the
duration, position and specific configuration of the transition effect.

4. Click OK.

A yellow vertical line is added on the transition where the effect has been added:
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8.2.5. Possible Video Transition Effects

Introduction

The various video transition effects can be selected from the contextual menu. For all
effects, a specific VideoTransition Effectwindow will be displayed to specify the
various parameters, such as duration, position, and possibly other configuration
parameters.

None
This option resets the transition into a cut.

Mix
TheMix transition provides a dissolve effect from the clip to the left of the joint to the clip
to the right of the joint.

This option will open a dialog box to determine the parameters for theMix effect.

You need to define:

• the duration in frames

• the position of themix:

◦ before cut: on the clip before the joint

◦ centered: centered on the joint

◦ after cut: on the clip after the joint
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Wipe
TheWipe transition is a gradual spatial transition from one video source to another, in
which a vertical or horizontal border moves across the screen, to gradually replace the last
images of the first clip with the first images of the next clip.

This option will open a dialog box to determine the parameters for theWipe effect:

In addition to the effect duration and position, you need to specify:

• the transition width, i.e. the thickness of the line which separates the clip before and
after the joint.

• the direction, i.e. from and to where the last image of the first clip will be wiped by the
first image of the next clip.
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Border Wipe
This is a wipe effect, on which a colored border is added to delimit the wipe effect on the
image.

This option will open a dialog box to determine the parameters for the BorderWipe effect:

You can specify:

• the border width in the Transition Width field

• the border color, using a color chart, which opens when you click the colored rectangle
in the Line Color field.
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Dip To Color
TheDip to Color blends the first clip into a selected color, and then blends the color into
the next clip. A typical use would be tomix to white in between clips in an interview or as a
dip to black in an edit.

This option will open a dialog box to determine the parameters for the Dip to Color effect:

In addition to the effect duration and position, you need to specify:

• the color to be used in the transition from a basic color palette, which opens when you
click the colored rectangle in theColor field.

• the length of the effect applied on the first clip (Length In field) and on the second clip
(Length Out field).

Custom
This allows the selection of a transition between the clips with a graphic “keyed” over it as
in the example below.

When the custommenu is selected, it shows a submenu either to choose an effect
already used on the timeline, or to find an effect file to load using a normal windows type
file search.
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Note
The files for the custom wipes must already have been imported into the
database. See the RTD section of Media Importer tab to do this.

8.2.6. Removing Transition Effects
You can remove the transition effects that have been defined in the sameway as you
have defined them, that is to say:

1. Select the transitions on which to remove the effects in one of the following ways:

◦ To remove an effect on a single transition, position themouse cursor next to the
video transition on which you want to clear the effect.

◦ To remove the effects on several transitions, add amark IN andmark OUT
beyond the relevant transitions.

2. Right-click and select (Left / Right) Video Transition > Clear All from the
contextual menu.

8.2.7. Inserting Blocks of Color Frames
You can insert one or more frames of a selected color between two clips.

To do this, proceed as follows:

1. Select the transitions on which to insert colored frames:

◦ To select a single transition, position themouse cursor next to the relevant video
transition.

◦ To select several transitions, add amark IN andmark OUT beyond the relevant
transitions.

2. Select the button.

This opens the Audio/Video Fx window.

3. In the Audio/Video Fx window, select the Color Insertion tab.
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4. In this tab, select:

◦ the requested color

◦ the number of frames for the color insertion

◦ the transitions where the insertion should be applied

5. Click OK.

8.3. Video Clip Effects

8.3.1. Introduction
Up to four different video effects can simultaneously be applied on the video clips of an
edit. You can define them via theVideo Clip FX command in the contextual menu you
access when right-clicking a selected video element in the timeline:

Some of video effects can be applied to a group of clips.

Other video effects (highlighted in the selection list with an asterisk *), can only be placed
on a single clip at a time, as they involve setting a time within a clip to apply the effect
(keyframe effects).

From the contextual menu, you can also remove the video effects using theReset
command.
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8.3.2. How to Apply a Video Clip Effect
To apply video clip effects to one or several clips (for non key frame effects), proceed as
follows:

1. Select the clips where to apply the effects in one of the following ways:

◦ To define an effect on a single clip, position themouse cursor next to the video
transition on which you want to add the effect.

◦ To define an effect on several clips, add amark IN andmark OUT points to cover
the clips to which the effects should be applied. The effects will be applied from
the first clip where themark IN point is defined, up to and including the last clip
where themark OUT is defined.

2. Right-click to access the contextual menu.

3. In the contextual menu, select theVideo Clip FX command, then the number of the
effect you want to define, and finally the effect type you want to define.

If specific parameters have to be defined for the effect, the dialog box related to the
selected video clip effect is displayed. Otherwise, the effect is directly applied to the
clip.

4. Fill in the requested parameters for the video clip effect.

5. Click OK.

The effect is applied to the video clip element, which turns to a darker blue color in the
timeline display:

One or more clip effects can be copied from a clip to another one as explained in section
"Copying and Pasting Video Clip Effects" on page 167.

Note

You can use the keyboard shortcut to directly access the Clip Effect
window. By default, the Video Effect window of the last created effect opens.
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8.3.3. Simple Video Clip Effects

Grey, Horizontal Mirror and Film Effect
The following video clip effects are applied directly to the selected clips or to the clips
betweenmark IN andmark OUT points as no additional settings need to be defined.

If you have definedmarks, a dialog box will be displayed to allow you to change the clips
on which the effect should be applied:

Video Clip Effect Description

Grey (B&W) This effect removes the color from a selected element.

Horiz(ontal) Mirror This effect flips the image to a horizontal mirror of the original.

Film Effect This effect adds a film like quality to moving pictures.

Color Fade
This effect allows the addition of a fade up at the beginning of a clip and a fade out at the
end of a clip to a selected color. When you select this effect in the contextual menu, the
window below is displayed.

The Fade from color parameters allow specifying the color fade up at the beginning of
the clip.

The Fade to color parameters allow specifying the color fade out at the end of the clip.
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Color Correction
This effect makes it possible to change the RGB parameters to adjust the color of an
image. When you select this effect in the contextual menu, the window below is
displayed.

To adjust the color, you need to slide the selectors for the three colors. You can also
modify the brightness, contrast, black level, and white level.
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8.3.4. Video Clip Effects With Key Frames

Introduction

These four options on the Video FX menu only appear for a single clip selection as they
require keyframes to be added to the video element selected.

A keyframe is a drawing that defines the starting and ending points of a video effect. The
addition of keyframes is a similar operation for all four effects and is detailed after briefly
describing them.
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Highlight
This option allows an object within the clip to be tracked over a period of time using a
highlighted shape.

Blur
This option allows an area within the clip to masked using a blurring effect. The area can
be tracked over the period required.

Pixel Mask
This option allows an area within the clip to bemasked using a pixelation effect. The area
can be tracked over the period required.
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Zoom Linear
This option allows an area within the clip to be zoomed or enlarged over the period required
within a clip.

8.3.5. Adding Key Frames for an Effect
Each effect window varies slightly to offer the necessary parameters, but the principal of
operation and basic layout is the same for all.

To add an effect with key frames (Highlight, Blur, Pixel Mask, Zoom Linear), proceed as
follows:

1. Select the clip on which you want to define effects.

2. Right-click to access the contextual menu. Then select theVideo Clip FX
command, the number of the effect you want to define, and finally an effect type you
want to define.

The relevant window is displayed. By default, the Designmode is active. This is the
mode to be used to define the effect.
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3. Define how the effect should start on the first image as follows:

4. Using the transport commands, browse to the first image on which the effect should
be applied.

5. In the Tools group box, select the shape you want to use for the area of the image to
be highlighted, blurred, pixelated or zoomed.

6. Dragging themouse, draw the shape on the image, with the requested size and
position.

7. Click theAdd button in the center of the window.

The data related to the effect on this timecode is added to the right part of the window.
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8. Define how the effect should end on the last image as follows:

9. Browse to the last image on which the effect should be applied.

10. Adapt the position and size of the shape on the image to your needs.

11. Click theAdd button.

The data related to the effect on this timecode is added to the right part of the window.

12. Specify the parameters related to the effect.

13. For the Highlight effect, you can change the default offset (contrast between
highlighted area and surrounding area).

14. For the Pixel Mask effect, you can change the default size of the pixel blocks.

15. For the Blur effect, theBlur Amount can be set from 0 to 100. The Feather value
determines the transition between the clear and the blurred image and can be used on
oval forms only.

16. When the effect is defined, you can select thePreview radio button, and use the
transport commands to have a preview of the defined clip effect.

17. Click OK to save the effect.
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8.3.6. Copying and Pasting Video Clip Effects

Introduction
The same video clip effect (or set of effects) can be applied to several video clips in the
timeline using the Copy and Paste functions.

The following principles apply to the Copy and Paste actions:

• The video clip effects that are copied are only those that:

◦ are available in the Video clip FX contextual menu AND

◦ do not require a keyframe effect.

The other effects such as Speed or Conversion are not copied either.

• The Paste action resets and removes all existing effects already applied to the
destination clips.

How to Copy a Video Effect
To copy a video effect, proceed as follows:

1. Select the clip with the already configured effects

2. Right-click to open the contextual menu

3. Select Copy Clip FX.

How to Paste a Video Effect
To paste these copied video effects, proceed as follows:

1. Select the clip you want to apply the copied effects to or set amark IN andmark OUT
points to cover the clips to which the effects should be pasted.

2. Right-click to open the contextual menu

3. Select Paste Clip FX.
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8.4. Conversion Effects

8.4.1. Introduction
Each clip can be converted by the software in Xedio CleanEdit to match the format that
the timeline is using. Conversion can be from and to 4:3 and 16:9 with Pan & Scan and
Letterbox modes supported.

When you have created the Edit, you have selected the aspect ratio for the edit (or it was
non-editable, as for 16:9 with HD video standards). Depending on the aspect ratio for the
edit, you have selected a default conversion type.

You can change themode used for the selected conversion type (for example PS, instead
of the default conversion type which was LB), by adding a conversion effects to a clip or to
several clips between amark IN andmark OUT. You will not be able to change the
conversion type itself since it is set at the beginning and has to remain unchanged in the
whole edit.

8.4.2. Changing the Mode for the Conversion Type
To change themode for the conversion type for one or several clips, proceed as follows:

1. Select the clips where to apply the effects in one of the following ways:

◦ To define an effect on one clip, click the requested clip

◦ To define an effect on several clips, add amark IN andmark OUT that covers the
first and the last clip.

2. Right-click to access the contextual menu.
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3. Select Conversion FX and the required effect.

The Clip Effect window opens:

4. In the Config. group box, select themode to be used for conversion type.

5. In PS mode, you can additionally select a Vertical Offset in 16:9 and also a Horizontal
Offset in 4:3.

6. Click OK.

Themode and offset defined will be applied to the selected clips.
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9. Editing in Place

9.1. Overview

Introduction

The Edit in place feature allows the user to access and edit recorded A/V material directly
from a camcorder, a drive or a VTR like a Sony XDCAM, a Panasonic P2 or a CANON
Compact Flash inside CleanEdit without any delay or file transfer after connecting the
device to his workstation or laptop. This feature is available through the Devices tab of the
CleanEdit work area.

The Devices tab provides automatically the list of connected devices to the workstation.
Selecting one or several devices should display their corresponding content (clips) in a
specific workspace from where the user is able to browse and choose the desired A/V
material for further editing.

Illustration

The Devices tab contains the areas highlighted on the screenshot below:
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Area Description

The table below describes the various parts of the Devices tab:

Part Name Description

1. Source
Device

This area displays the plugged-in devices and themedia that has
been automatically detected on the devices, as well as media from
drives and folders which have been scanned by the users.
See section "Source Device Area" on page 171.

2. Workspace This is the working area where youmainly perform the following
actions:
• Searching for the requested clips, potentially by applying search

filters.
• Loading, playing and editing the source clips to create sub-clips

that will be added to a storyboard.
See section "Workspace Area" on page 173.

9.2. Source Device Area

Introduction

When you open Xedio CleanEdit, the application automatically detects the plugged-in SD
or HD devices (CANON, P2, XDCAM or XDCAM EX supports), and searches for media
present on these supports.

USB devices and XF drives, containingmedia backed up from EVS video servers on an
event location, can be scanned, so their content is available for browsing, logging, rough-
cut and export.

General Description
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The Source Device area displays:

• the identified devices as the root branches of an expandable tree view and the
detectedmedia below the device on which it is stored. The path where themedia is
located is specified.

• the folders scanned by users and their sub-folders.

The check-boxes are used to specify themedia to be displayed in the Thumbnail view and
in the List view of theWorkspace. See section "Selecting Relevant Media" on page 180.

Contextual Menus

Contextual menus with the following options are available when you right-click an item in
the Device area.

Scan All Device Sources
Scans all the sources from the Devices node.

Scan CANON / P2 / XDCAM / XDCAMEX Media Sources
Scans the selectedmedia sources.

Add and Scan Folder
Allows to add a folder to scan under the selected folder.

Root Folder Display
Allows to change the root folder display
Several display options are available:
Device Label
This corresponds to the device name given during the Add & Scan Folder operation.
Folder Name
This corresponds to the name of the folder/volume.
Full Path
This corresponds to the folder full path (folder and its subfolders).
Folder – Path
This displays the folder name followed by the folder path.

Add Scan Folder...
Allows to add a folder to scan under the selected folder.

Rescan [Name] Folder
Re-scans the selected folder.

Change [Name] Folder
Allows to change the properties of the selected folder.

Delete [Name] Folder
Deletes the selected folder.

172 9. Editing in Place

EVSBroadcast Equipment SA Issue 4.40.A - November 2013



9.3. Workspace Area

9.3.1. View Modes in the Workspace Area
TheWorkspace area can display different views depending on the step you are working
on in the process.

You can select the requested view by clicking one of the view buttons at the bottom left of
theWorkspace area:

View Description

Thumbnail
view

The Thumbnail view shows a thumbnail for each source clip of the
media present on the selected device.

List view The List view displays the list of source clips from themedia
present on the selected device and gives. It provides different
filters which can be applied to restrict the list of clips displayed.

Clip
Player
view

The Clip Player view allows playing source clips and adding logs to
them.

9.3.2. Overview of the Workspace in Thumbnail
View

Introduction

This view can be useful to select the cameras source clips you want to edit.

General Display

The Thumbnail view shows the thumbnails for the various source clips of themedia
selected in the Source Device area:
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For each clip, the followingmetadata is displayed:

• the clip name (above the thumbnail)

• the TC IN, TC OUT, and duration of the clip in the sourcemedia (below the thumbnail)

Display of Spanned Clips from a Single File

When the duration of a single shot record exceeds the capacity of the P2 card or when the
resulting file exceeds 4GB, the camcorder goes on recording on another P2 card. This
results in multiple contiguous media files which are highlighted in the Thumbnail view of
Xedio CleanEdit by yellow rectangles on the right and/or the left sides of the clip
thumbnails.

When the duration of a single shot record exceeds the capacity of the P2 card or when the
resulting file exceeds 4GB, the camcorder goes on recording on another P2 card. This
results in multiple contiguous media files which are highlighted in the Thumbnail view of
Xedio CleanEdit by yellow rectangles on the right and/or the left sides of the clip
thumbnails.

Display of 3D Clips

When themedia sources are P2-3D cards, media from the left and right cards will be
transferred as two separate files to the selected target.

The limitation is that themedia from one cardmust be transferred before the second card
is plugged in Xedio CleanEdit workstation.
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In the Thumbnail view, the clip name is followed by 3D-L or 3D-R. Thumbnails always
refer to themedia from the first P2-3D that has been plugged.

9.3.3. Overview of the Workspace in List View

Introduction

The List view displays the list of all clips present in the selectedmedia, and their
associatedmetadata. Elements are presented in rows and all their associated parameters
andmetadata are in columns. Different filers can be applied to restrict the list. The
Elements grid also returns the result of a search applied with a filtering tool to the
elements of the List view.

You will preferably use this view to see the clips metadata when you work with drives /
folders in the Device area.
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Illustration

The List view of the workspace contains the areas highlighted on the screenshot below:

Area Description

The table below describes the various parts of the List view.

Part Name Description

1. Search
tools

Provides aQuick Text Search field andAdvanced Filters fields to
restrict the list to specific data.
See section "Searching for Elements in the List" on page 27.

2. Saved
Filters
tabs

Allows to save filters and to apply them later on.
See section "Using Saved Filters" on page 38.

3. Elements
grid

Displays the list of clips corresponding to the selected source in the
Device area, or returns the result of a search applied to the list.
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9.3.4. Selecting Techniques
Several source clips can be selected tomove them at once to a project (amongst the
media or the clips or in an existing edit). You can select them thanks to the usual
commands:

• Press CTRL + click on the items for a selection of multiple non-contiguous items.

• Press SHIFT + click on the first and last items for a selection of multiple contiguous
items.

• Press CTRL + A to select all the items from the Thumbnail view or the List view.

9.3.5. Overview of the Clip Player

Introduction

The Clip Player is used to browsemedia or clips selected from the Thumbnail view or the
List view. Its clip creation pane provides the functions to create sub-clips to be added to a
project.

The Clip Player is accessible via theClip Player button .
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Illustration

The Clip Player view contains the areas highlighted on the screenshot below:

Note
The color of some user interface elements may vary with the Xedio skin
installed.
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Area Description

The various elements of the Clip Player user interface from the Devices tab are similar to
those present in the Player area of the Edit tab. See section "Player Pane" on page 62 for
detailed information.

The table below describes the various parts of the Clip Player view.

Part Name Description

1. Video Display
& Audio
Meters

The Video Diplay displays themedia loaded on the Player.
Parameters related to the display are available via a contextual
menu.
See section "Video Display Options" on page 66.
The audiometers are used for audiomonitoring.

2. Track
Selection
buttons

The Track Selection buttons (little camera and triangle buttons)
are used to select the video and audio channels to include in the
clip/sub-clip.
The radio buttons are used to select the audio track tomonitor
when the loaded clip is being played in the Clip Player.

3. Jog andMedia
bars

TheMedia bar represents the clip currently loaded on the Player.
The jog bar is used to navigate within the loaded item at a
variable speed.

4. Editing and
Transport
commands

The transport functions are used to navigate within the loaded
item and play it.
See section "Transport Commands in the Player" on page 69.
The editing functions are used to create new clips.
See section "Clip Creation Commands" on page 72.
Logs buttons are used to add logs to the clip loaded in the player
and to navigate between the logs.
See section "Adding Logs to theMedia Loaded on the Player
Area" on page 78. Note that logs from the Devices tab behave as
external logs.

5. View Mode
buttons

These buttons are used to change the information displayed in
theWorkspace: available media, clip player.
See section "View Modes in theWorkspace Area" on page 173.

6. Next/Previous
Clip buttons

These buttons are used tomove to the next or previous clip
available in the Thumbnail view.
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9.4. Selecting Relevant Media

9.4.1. Introduction
Users can use clips directly available from a device or a folder, or they can create a sub-
clip from an existing clip.

Connected devices are automatically displayed in the Device area. Other folders,
corresponding to USB devices and XF drives, can be added to the Device area and their
content scanned.

In theWorkspace area, two views are available to display the content of devices or
folders selected in the Device area: the Thumbnail view and the List view.

9.4.2. Adding and Scanning a Folder in the Source
Device Area

Introduction

XF drives or USB devices containingmedia backed up from EVS video servers on an
event location can be used in Xedio CleanEdit.

How to Add and Scan a Folder

To display a folder content, proceed as follows:

1. In the Source Device area, right-click the Folders line.

A contextual menu appears.

2. Select Add & Scan Folder.

A window opens.

3. Type a device name.

4. Browse for the device folder to scan.

5. Click OK.

The folder is added to the Source Device area and its content is scanned and can be
displayed in theWorkspace area.
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9.4.3. Listing Clips in the Workspace Area

Displaying the Source Clips in the Thumbnail
View
First, select the check box corresponding to a device or a folder in the Source Device
area.

Then, click the button to select the Thumbnail view.

Thumbnails for each source clip present in this device or folder are displayed on the
Workspace area.

Listing the Source Clips in the List View
First, select the check box corresponding to a device or a folder in the Source Device
area.

Then, click the button to select the List view.

The list of source clips present in this device or folder and their associatedmetadata are
listed on theWorkspace area.
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9.5. Searching for Clips within the List
View
The List view of the Devices tab is similar to the tabs used for searching for media (Media
Manager, Edit Manager and Project Manager tabs). So, you will findmore information and
the search tools in section "Searching for andManagingMedia" on page 24.

9.6. Loading a Source Clip on the Clip
Player

Introduction

The action of "placing" amedia or a clip on the Clip Player to preview it, sub-clipping it,
and so on, is called "loading amedia or clip on the Player".

This can be done in different ways.
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How to Load a Clip in the Clip Player

To load source clip on the Clip Player, proceed in one of the following ways:

• double-click the source clip from the Thumbnail view.

• double-click the source clip from the List view.

• right-click a clip or a thumbnail ans select Play from the contextual menu.

The clip boundaries displayed are the ones of the source clip.

When you load a clip in the Clip Player, the Clip Player becomes automatically active, and

theClip Player button is selected .
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10. Advanced Audio Editing

10.1. Overall Audio Track Settings
The table below gives an overview of themain steps involved in the audiomanagement in
CleanEdit.

Step See Section…

Set the audio type of each timeline track "Track Name and Audio Type in the
Timeline" on page 105.

Set the number and type of output audio
tracks by means of the Audio Output matrix

"Audio Track Selection for the
Output" on page 106.

In the Player area, select the audio
channels/tracks to be loaded in the timeline

"Selecting Video and Audio Tracks
for Media and Clips" on page 76.

In the Recorder area, select the output track
to be monitored

"Selecting theMonitored Audio
Track for an Edit" on page 90.

10.2. Audio Transition Effects

10.2.1. Ways to Add Audio Transition Effects
You can add audio transition effects using different methods:

• Adding the default audio transition effect to all new audio clips placed into the timeline.

See section "Adding Automatically Default Audio Transition Effects" on page 185.

• Adding a transition effect on one or more contiguous audio elements of a track.

See section "Adding Audio Transition Effects on Elements of the Same Track" on
page 188.

• Adding a transition effect on one or more audio elements of the same clip.

See section "Adding Audio Transition Effects on Elements of the SameClip" on page
190.

If you add an effect on a transition where an audio transition effect has already been
defined, the initial effect will be replaced by the new one.
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10.2.2. Adding Automatically Default Audio
Transition Effects

Once you click the button to activate theAFX function, a default audio transition is
added to each new clip placed into the edit. The cross fade is the default audio transition
initially defined in Xedio.

10.2.3. Modifying the Automatic Default Transition
Effect
The default transition effect is defined in XedioManager: Software > Parameter Profiles >
(Xedio)CleanEdit > Timeline tab: DefaultAudioTransFx.

However, you canmodify the default audio transition effect as follows:

1. Right-click the button and select Properties.

The Audio Transition Effect window is displayed.

2. Specify the requested default transition effect

3. Click OK.

The new transition effect is now the default transition associated with your user profile.

10.2.4. Possible Audio Transition Effects
When you select the audio transition effect you want to apply, you have the choice
amongst four types of audio transitions effects. They are described and illustrated below
by a zoomed display of the audio transition effect:
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Cut
No transition effect is performed. The audio of the second clip replaces the sound of the
first clip instantly. No blue line (which reflects a transition) is shown at the joint when a cut
is present.

This is represented by the icon in the Audio Transition Effect window.

Fade out
The sound of the first clip fades out progressively while the audio of the second clip starts
instantly from the transition point.

This is represented by the icon in the Audio Transition Effect window.
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Fade in
The sound of the first clip disappears instantly at the transition point while the audio of the
second clip starts progressively.

This is represented by the icon in the Audio Transition Effect window.

Cross fade
The sound of the first clip fades out while the sound of the second clip fades in.

This is represented by the icon in the Audio Transition Effect window.
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10.2.5. Adding Audio Transition Effects on
Elements of the Same Track

Introduction
Youwant to add audio transition effects to:

• a selected element OR

• contiguous elements

on a given audio track.

In this case, you will use the (Left/Right) Audio Transition commands in the contextual
menu available on audio elements in the timeline. 

See section "Possible Audio Transition Effects" on page 185 for more information on the
various types of transition effects.

The following audio transition effects are available: Cut, FadeOUT, Fade IN, and Cross
Fade.

How to Apply Audio Transition Effects On
Elements on the Same Track
To apply audio transition effects to one element or contiguous audio elements of the same
track, proceed as follows:

1. If you want to define a transition effect on several contiguous transitions, set amark
IN andmark OUT points to cover the clips on which the effects should be applied.

Otherwise, the transition effect will be defined on the nearest transition to the position
of themouse cursor.
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2. Right-click themouse on the track where you want to define the transition effect
either:

◦ near the clip transition OR

◦ between the definemark IN andmark OUT

The contextual menu is displayed:

3. Select the requested effect type in the (Left / Right) Audio Transition command.

The Audio Transition Effect window opens. In this window, you can still select another
effect. The definition of the transitions where the effect will be applied, in the Area
group box, cannot bemodified.

4. In the Audio Transition Effect window, fill in the transition parameters to specify the
duration and position of the transition effect.

5. Click OK.

A blue vertical line is added on the transition where the effect has been added:
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Once you have assigned the basic type of audio transition, you can zoom and adjust the

audio transition on the timeline, by clicking the Zoom button on the right hand side of
the required track. The track will then expand vertically across all of the audio tracks to
show the transition.

Note

You can also use the shortcut key + to directly call the Audio
Transition Effect window.

10.2.6. Adding Audio Transition Effects on
Elements of the Same Clip

Introduction
You can add an audio transition effect on one or more audio elements of the same clip.

In this case, you will use the Audio/Video FX window, accessed via the button.

See section "Possible Audio Transition Effects" on page 185 for more information on the
various types of transition effects.

The following audio transition effects are available: Cut, Cross Fade, Fade IN, and Fade
OUT.
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How to Apply Audio Transition Effects On Audio
Elements of the Same Clip
To apply an audio transition on one or more audio elements of the same clip, proceed as
follows:

1. Position the nowline on the clip for which you want to adjust the audio transitions.

2. Click theAudio/Video FX button to open the Audio/Video FX window and
select the Audio Fade tab.

3. In the upper group box, specify the following:

4. Tick the type of transition you want to apply

5. Type the number of frames the transition effect should last

6. Select the location of the transition around the clip joint.

7. For a cross fade, select whether you want to apply the effect at the beginning of the
clip (previous cut), or at the end of the clip (next cut) on which the nowline is
positioned.

8. Select the tracks on which you want to apply the transition effect.

9. Click Proceed.
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10.2.7. Adjusting Audio Transitions
To adjust manually audio transitions on a specific track, proceed as follows:

1. Click the Zoom button located on the right hand side of the audio track on which
you want to adjust transitions.

2. In Zoommode, identify the transition tomodify.

3. Click the white nodes that correspond to the audio transition effect andmove them to
graphically display the required transition.

10.2.8. Removing Audio Transitions
You can also remove the previously defined transition effects by right-clicking the track on
which you want to remove the transition effects and selectingAudio Transitions >Clear
All in the contextual menu.

10.3. Audio Routing, Swaps and Mutes

10.3.1. Default and Specific Audio Routing
You can define default audio routing, as well as swaps andmutes on the audio channels

of a stereo track via theAudio Routing button . This is explained in section "Audio
Routing for Stereo Tracks" on page 110. These options will be valid for each new clip
added to the edit.

You can also define specific audio routing, swaps andmutes on an audio element of a
stereo track. These functions are available as you right-click on the selected element and
chooseAudio Channels from the contextual menu.
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10.3.2. Possible Audio Channel Functions
The functions available via theAudio Channels command are divided into four groups of
sub-commands. A mark is displayed in front of the commands applied to the selected
elements:

Group of Sub-
Commands Description

These commands allow specifying the source track you want
to be applied to the selected element.

These commands allow the user to specify whether the track
should be output as amono or as a stereo track.

These commands allow the user:
• to route the left or right audio channel to both stereo

channels
• to mix both stereo channels into one audiomono channel

These commands allow the user:
• to mute the left or right audio channel
• to swap the left and right audio channels
• to swap the left and right channels andmute one of them.
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Note
SelectingStereo from theAudio Channels commandwill reset the audio
channel effects.

10.3.3. Copying and Pasting Audio Routing Actions
The audio effects defined on one element using theAudio Channels command can be
copied and pasted to several audio elements and audio tracks in the timeline, via the Copy
and Paste functions:

The following principles apply to the Copy and Paste actions:

• The audio effects that are copied are only those that are available in theAudio
Channels command of the contextual menu. The source selection is not copied.

• The Paste action resets and removes all existing effects already applied to the
destination clips.

To copy and paste an audio effect, proceed the sameway as for the video effects. See
section "Copying and Pasting Video Clip Effects" on page 167 for a detailed procedure.
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10.4. Audio Level Adjustments

10.4.1. Introduction
In Zoommode the level of the audio clips in the edit are also displayed. The horizontal line
on the expanded audio clip represents its audio level. The original audio level of the source
clip is referred to as the 0db level:

10.4.2. How to Adjust the Audio Level on a Single
Clip
To adjust the audio level on a single clip, proceed as follows:

1. In Zoommode, position themouse on the horizontal line (audio level) of the clip to be
adjusted.

2. When themouse pointer shows a double headed arrow, click and hold on the left
button of themouse.
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3. Move the audio level line up or down to respectively increase or decrease the audio
level of the clip:

The db increase compared to the original audio level is specified on the audio level line
as youmove it.

4. Release themouse when you have reached the requested audio level.

10.4.3. How to Adjust the Overall Level of a Track
To adjust the audio level of a whole track, proceed as follows:

1. Click on theAudio/Video FX button .

The Video/Audio FX window opens with the focus on the Audio Level tab:

2. Tick theSource Channel check boxes corresponding to the tracks whose audio level
you want to adjust.
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3. In the Level Adjust box corresponding to each track, select how many dbs you want
to add to or remove from audio level of the track.

4. Select the adjustment mode as follows:

5. If you want to apply the specified db value to the current audio level, tick theRelative
radio button.

6. If you want to apply the specified db value to the original audio level (0db), tick the
Absolute radio button.

7. Click OK.

The audio level of the whole track is adjusted according to the defined value and
adjustment mode.

10.5. Miscellaneous Audio Features

10.5.1. How to Generate the Waveform of an Audio
Element
You can generate the waveform for audio element(s) of an audio track as follows:

Generating the waveform of a stereo element
1. Right-click on the element for which you want to generate the waveform.

2. Select Get audio waveform from the contextual menu:
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Generating the waveform of a 5.1 element
1. Right-click on the element for which you want to generate the waveform.

2. Select Get audio waveform from the contextual menu and the channels for which
you want to get the waveform:

The followingmessage will display while the application is generating the waveform:

Once the waveform has been generated, click the Zoom Track button to view it:
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10.5.2. How to Remove an Audio Waveform
To remove the audio waveform on an audio element, right-click on this element and select
Remove audio waveform from the contextual menu:

10.5.3. How to Duplicate an Audio Track
You can copy and paste a full audio track to another track. If the destination track is not
empty, its content will be replaced by the copied track.

To duplicate an audio track, proceed as follows:

1. Right-click on an audio track and select Duplicate Track in the contextual menu.

TheDuplicate Audio Trackwindow opens.

Only the tracks with the same audio type as the copied track are displayed in the
Select Target Track field group.

2. In theSelect Target Track field group, tick the track to which you want to duplicate
the copied track.
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3. In theApply Default Audio Channel field group, do one of the following:

◦ If you want to apply the default Audio Channel settings (that is stereo), select
"Yes"

◦ If you want to apply the Audio Channel settings of the copied track, select "No".

The audio track is copied to the destination track.
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11. Voiceover, Logo, Graphics, Text
or Subtitles

11.1. Adding Voiceover

11.1.1. Introduction
CleanEdit provides a tab entirely dedicated to the recording of voiceover on a specific
audio track over one or several parts of the edit. The current section describes the
voiceover process managed with CleanEdit.

Some users prefer to record voiceover with an external audiomixer. This process,
schematized hereafter, is supported by CleanEdit as well. Then, the audiomixer stereo
output is used as input for the CleanEdit audio board.

As the use of digital audio capture devices could cause a variable delay between the
recorded audio and the video, this can be corrected thanks to the Latency Delay Offset
setting in XedioManager > Softwares > Parameter Profiles > CleanEdit > Voiceover.
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11.1.2. Voiceover Tab Overview

Illustration

The VoiceOver tab contains the areas highlighted on the screenshot below:
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Area Description

The table below describes the various parts of the Voiceover tab:

Part Name Description

1. Text Editor The text area allows the addition of the voiceover script on the
display. A script can be typed or added using Copy & Paste
commands from another application. It can also be retrieved
from aMOS story through EVS ActiveX component or from
the Xedio Cutter application.

2. Audiometers The audiometers provide an indication of the input audio level
for themicrophone when recording a voiceover.

3. Recorder pane This display area is similar to the Recorder pane on the Edit
tab in that the transport controls are the same, but has some
different features to record the voiceover.
The description of the common transport buttons and fields
can be found in section "Playing the Edit in the Recorder
Pane" on page 87.
The other buttons and fields, specific to the Voice Over tab,
are described in the next sections.

4. Timeline pane This area contains the edit to which voiceover is added..

Audio Meters

Underneath themeter is aCfg button that displays the audio level configuration to adjust
the settings.
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The audio card fitted to the workstation being usedmay offer more choices in configuring
the recording parameters, please consult the user manual for the device used for more
details.

TheAdvanced button from theWaveOutput area gives access tomore controls:

Note
The Digigram board controls the configuration for the audio inputs and outputs of
the workstation. It is therefore recommended to configure the Digigram board as
shown on the screenshots from "Appendix 3 – Digigram Hardware Settings" on
page 253.

11.1.3. Voiceover Process

Process Overview
The voiceover recording process includes four steps:

1. See section "Defining the Area to Record the Voiceover" on page 205.

2. See section "Recording the Voiceover" on page 205.

3. See section "Checking the Recorded Voiceover" on page 206.

4. See section "Attenuating other Tracks when Using Voiceover" on page 207.
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Defining the Area to Record the Voiceover

Mark In

or or

Place the nowline in the timeline where the voiceover should start, then click theMark IN
button in the timeline or recorder area to define the IN point of the recording area for the
voiceover.

The timecode of themark IN point will be displayed in the recorder panel next to the IN
button.

Mark Out

or or

Place the nowline in the timeline where the voiceover should end, then click theMark
OUT button in the timeline or recorder area to define the OUT point of the recording area
for the voiceover.

The timecode of themark OUT point will be displayed in the recorder panel next to the
OUT button. The duration of the voiceover will also be shown on the recorder area.

Note
It is possible to start a voiceover recording without adding anOUT point. In this
case, the voiceover recording would continue until you stopmanually the
recording clicking theRecording button.

Recording the Voiceover

Launch the recording process by clicking theRec button.

…1 (count down)

When the user selects theRec button whenmark IN andmark OUT have been set, a
countdown starts and is shown on the button itself. It indicates the number of seconds
before the IN point of the voiceover and allows to user to get ready for the recording.
During the countdownCleanEdit will play the edit leading up to the IN point for the
voiceover.

Note
The Preroll value for a voiceover can be set in XedioManager. Please refer to
the XedioManager user manual for further details.
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When the countdown is over, theRec button displays a red button .

The edit is played and the system keeps recording until the OUT point is reached or until
the user clicks theRec button again to stop recording.

The track where the voiceover clip will be placed is the first stereo track that is selected
looking from the bottom of the timeline. A dialog box will open to ask which track to place
the recorded voiceover on if this would overwrite some elements already present on the
timeline.

Only the stereo tracks can be selected.

Checking the Recorded Voiceover

Go to Voiceover Mark IN

Clicking theGoto Mark IN button, located below theRec button, moves the current
position of nowline to the IN point corresponding to the beginning of the last voiceover
recording.

+

This button when combined with theCTRL key from the keyboard, moves the nowline to
the some seconds (Preroll value) before the beginning of the last recording, and directly
launches a playback to enable the recording to be checked.
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Go to Voiceover Mark OUT

Clicking theGo to Mark OUT button, located below theRec button, moves the current
position of nowline to the OUT point corresponding to the end of the last voiceover
recording.

+

This button when combined with theCTRL key from the keyboard, moves the nowline to
some seconds (Preroll value) before the end of the last recording and launches a playback
to enable the voiceover OUT point to be checked.

Attenuating other Tracks when Using Voiceover
Using a right click on a voiceover track brings up a contextual menu offering the choice to
add attenuation to any audio elements that are vertically adjacent to the recorded
voiceover section. This means that the audio tracks will fade to a lower level for the
duration of the voiceover.

When attenuation is present, the voiceover element color changes to a darker shade to
indicate that the attenuation is switched on. See section "Color Representation on the
Timeline Display" on page 97.

Note
The level of attenuation and other settings such as fade in and out values are set
in the Software > Parameter Profiles area of XedioManager. Please refer to the
related user manual for more details.
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11.2. Adding a Logo or Graphic

11.2.1. Introduction
Youwill use tags to add a logo or still graphic. Tags are reference points marked on the
timecode bar to trigger an event, such as the insert of a graphic or logo. Tags are created
andmanaged via the TagManager window.

11.2.2. Accessing the Tag Manager Window
To access the TagManager window, you can:

• right-click on the Timecode bar in the timeline display and select Add Tag from the
contextual menu.

• press the keyboard shortcut . In this case, the tag position is defined based on the
Mark IN andMark OUT points, or nowline position. For more information, refer to the
description of the TC in and TC Dur fields in section "Fields in the TagManager
Window" on page 209.

11.2.3. Possible Actions in the Tag Manager
Window
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The TagManager window allows the user to perform various actions:

Action See Section …

Inserting a logo or still graphic from a TC
IN to a TC OUT (IN andOUT points of
the tag), with a fade in and fade out.

"How to Insert a Logo or Graphic using
Tags" on page 210.

Changing the tag position on the timeline. "Moving Tag Points" on page 212.

Changing the tag order when several tags
are defined.

"Fields in the TagManagerWindow" on
page 209 (TagOrder group box).

Deleting a tag. "How to Delete Tags" on page 213.

11.2.4. Fields in the Tag Manager Window
The following table describes in details the various fields in the TagManager window:

Field/Button Description

Properties group box

TC In Spin box to type the tag IN point, in other words the timecode from when
the graphic will be displayed (on the top of the video).
When you use the contextual menu to call the TagManager window, the
value for the tag IN point corresponds to the position of themouse on the
Timecode bar when you right-click on themouse.

When you use the keyboard shortcut to call the TagManager
window, the tag IN point and duration values will be retrieved from the
timelineMark IN andMark OUT points if they are defined. Otherwise,
the nowline position will be used as the tag IN point with the default
duration of 4 seconds.

TC Dur
check box

Check box to specify whether you want to define how long the graphic
should be displayed:
• If it is not ticked, the graphic will be displayed until the end of the

edit.
• If it is ticked, you can specify how long the graphic should be

displayed in the TC Dur field. By default, the duration is 4 seconds.

TC Dur
(field)

Spin box to type how long the graphic will be displayed from the tag IN
point.

Logo Insertion Tab

Label Drop-down box to select the file containing the graphic or logo to be
inserted. The TIFF or TAG files already included in the project will be
displayed in drop-down list.
If the requested file is not available in the drop-down list, you first need to
import it, using the Import button.

Import Button that opens the KM Importer dialog box, from where you can
browse to and import the requested graphic file.
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Field/Button Description

Fades Check box to specify whether you want the graphic to appear and
disappear using a fade effect:
• If it is not ticked, the graphic will be fully displayed and will disappear

in cut mode.
• If it is ticked, you can specify below the duration of the fade in and

fade out for the graphic display.

In: X frames Field to specify the duration, in frames, of the fade in effect when the
graphic will appear on the clip.

Out: X
frames

Field to specify the duration, in frames, of the fade out effect when the
graphic will disappear.

Link Check box to synchronize the fade in and fade out durations.

Tag Order group box

Tag List (00,
01, 02, …)

List of the tags defined in the timeline. You can select one or more tags
at a time.

Up Button tomove the selected tag higher in the tag list.

Down Button tomove the selected tag lower in the tag list.

Prev Button to select the previous tag in the tag list.

Next Button to select the next tag in the tag list.

Delete Button to delete the selected tag(s).

11.2.5. How to Insert a Logo or Graphic using Tags

Note
The logo or graphic to be inserted are usually TIFF or TGA file with a key layer.
The file is either already present in the current project or can be imported as you
define the tag for the graphic insertion.

See section "Fields in the TagManagerWindow" on page 209 for additional information on
the various fields referred to in the procedure.

To insert a graphic or logo by defining a tag, proceed as follows:

1. Right-click on the Timecode bar at the position where you want the graphic to be
inserted, and select Add tag to open the TagManager window.

2. If necessary, modify the timecode where the graphic should be inserted by typing the
requested timecode in the TC In field.
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3. If you want to specify how long the graphic should be displayed, tick the check box in
front of the TC Dur field and specify the duration for the graphic display in the TC Dur
field.

Otherwise, the graphic will be displayed until the end of the edit.

4. If the graphic is already present in the project, select the file directly from the Label
drop-down field.

If the graphic is not available in the project, click the Import button to be able to select
and import it via the KM Importer dialog box.

5. If you want the graphic to appear and disappear in a fade in and fade out, tick the
Fades check box, and specify the duration (frames) for the fade in and fade out effect.

Otherwise, the graphic will appear and disappear in cut mode.

6. Click OK.

When successfully added, the tag will show on the timecode bar with a number.
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11.2.6. Moving Tag Points

Possible Methods
You canmove one or more tags in one of the following ways:

• by selecting the tag points on the Timecode bar and dragging themouse tomove the
selected tag points.

This method is less precise, but allows you tomove several tags at the same time.

• by editing directly the position and the duration of a tag in the TagManager window.

This method is more precise, but only allows you tomove one tag at a time.

How to Move the Tag Points in the Timeline
Display
Tomove the tags points directly in the timeline display, proceed as follows:

1. Select the tag point(s) you want to move by clicking on the tagmarker on the
Timecode bar.

To select several tag points, keep theCTRL key pressed while clicking on the tag
markers. To deselect a tag point, click again on the tagmarker.

Themarkers of the selected tags become purple: .

2. Position themouse over the selected tags, drag the selected tag point(s) to the
requested position and release it/them.

During the drag action, a rectangular shadow on the Timecode bar shows the new
position of the selected tag which is themost on the left in the timeline:

How to Move the Tag Points in the Tag Manager
Window
Tomove the tags points in the TagManager window, proceed as follows:

1. Right-click on the Timecode bar and select Tag Properties from the contextual menu.
The TagManager window opens.

2. In the TagOrder group box, click the number of the tag you want to move.

3. In the Properties group box, modify the values of the TC In and/or TC Dur fields
depending on the requestedmove.

4. Click OK.
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11.2.7. Duplicating a Tag

Possible Actions

Tags used to insert a logo or a graphic in the timeline can be quickly duplicated
somewhere else in the timeline.

Tags used by the Character Generator tool can be duplicated in the sameway.

How to Duplicate a Tag

To duplicate a tag, proceed as follows:

1. Select the tag you want to duplicate by clicking one of the tagmarkers on the
Timecode bar.

Themarkers of the selected tags are highlighted in purple:

2. Place the nowline where you want the duplicated tag to be added.

3. Right-click the Timecode bar.

4. Select Duplicate Tag from the contextual menu.

The duplicated tag is added to the Timecode bar.

11.2.8. How to Delete Tags
To delete a tag, proceed as follows:

1. Right-click on the Timecode bar and select Tag Properties from the contextual menu.
The TagManager window opens.

2. In the TagOrder group box, click the number of the tag you want to delete.

3. Click Delete.

4. Click OK.

No warningmessage will be displayed to confirm the delete action, but you will still have
the possibility to undo the action using the keyboard shortcut

+ .
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11.3. Adding Integrated Text and Graphics
or Subtitles

11.3.1. Introduction

Purpose

The Character Generator (CG) tool allows users to place text anywhere on the video
image and to combine it with a graphics layer. The combination of text and graphics can
be saved as template which can then be re-used later on.

The Character Generator tool can also be used to add subtitles to an edit.

This tool is available from the Text tab of CleanEdit.

Character Generator Processes

Integrated Text and Graphics

The text and graphics integration process includes the following steps:

1. "Defining the Area to Insert Text/Graphics" on page 216.

2. "Adding Text andGraphics to the Edit" on page 217.

3. "Saving a Template of Character Generator Page" on page 223.

4. "Applying a Transition Effect to the CGArea" on page 225.

5. "Checking the Integrated Text andGraphics" on page 225.

6. "Editing the Character Generator Page Properties" on page 228.

Subtitles Import

The addition of subtitles to an edit is described in the following step:

"Importing a Subtitle File" on page 226.
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11.3.2. Text Tab Overview

Illustration

The Text tab contains the areas highlighted on the screenshot below:

Area Description

The table below describes the various parts of the Text tab:

Part Name Description

1. Character
Generator
area

This pane is used to define the Character Generator (CG) tags and
associate integrated text and graphics to them, or it can be used to
import subtitles files into the edit.

2. Player
Pane

This pane is used to preview the edit and see the integrated text and
graphics or the subtitles.

3. Graphical
Timeline

This area is a graphical representation of the edit. It shows the areas
where integrated text and graphics or subtitles are added to the edit.
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11.3.3. Defining the Area to Insert Text/Graphics
When an edit is loaded in the timeline, you will first have to define the area to insert
text/graphics. This can be viewed like creating a Character Generator page.

You have the possibility to:

• Define the area from the nowline position for a default duration of 4 seconds: put the
nowline at the required position and then click theCreate New Page button.

• Define the area between aMark IN and aMark OUT: click theMark IN andMark
OUT buttons and then theCreate New Page button on the top of the Page List tab.

The CG tags are listed in the Page List sub-tab:

They appear in the timecode bar above the timeline in the form of numbered gray tags.

Note
Nested areas can be defined.
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11.3.4. Adding Text and Graphics to the Edit

Overview of the Text Properties Tab
As soon as theCreate New Page button has been clicked, the Text Properties tab is
displayed allowing you to add text, add a picture, save a Character Generator template.

You have the possibility to:

• Use a pre-defined text & graphics template from theBase Template field. See
section "Applying a Template" on page 224.

• Define new text and graphics as explained in next sections.
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Adding Text Area and Defining Text Properties

How to Add Text

To enter text, proceed as follows:

1. Click the button from the Text Properties tab.

A text box appears in the Video Display:

2. Enter your text in the text box.

3. Define the text properties through the five sub-tabs of the Text Properties tab.

4. Click the button to validate your text.

Note
You can repeat steps 1 to 4 to associate several text areas to the same tag
area. They will then be displayed next to the same tag number in the tag list.

Possible Actions on the Text Area

You canmove or resize the text area by dragging the area to the desired position and
dragging the edges to increase the box size.

The following buttons are present on the text area:

Button Description

Deletes the text area.

Validates the text and its properties. The text area is then surrounded by a thin
black line to identify it.

Cancels the editing performed since the last Validate action.
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How to Define Text Properties

Five sub-tabs are available in the Text Properties tab to define the text properties.

If no text is selected, changing properties will be applied to all the text in the area.

If some text is selected, changing properties will be applied to the selection only.

Text Sub-tab
The Text sub-tab provides options which define the properties of the text itself, such as
style, alignment, font, color, size and opacity.

The antialiasing option is selected by default. This is used tominimize the distortion
artifacts.

Example with italic, centered and turquoise options:

Edge Sub-tab
The Edge sub-tab is used when you want to add a border to the text.
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Example with a blue edge of size 1 and 100% opacity:

Shadow Sub-tab
The Shadow sub-tab is used when you want to apply a shadow to the text.

To apply a shadow to the text, define the following settings:

• Select theSet a Shadow option.

• Choose a color for the shadow by clicking the Color box, selecting a color from the
palette and then pressing theOK button.

• TheOffsetX parameter defines the horizontal size of the shadow.

• TheOffsetY parameter defines the vertical size of the shadow.

Example of a white shadow with Offsets of 5:

Spacing Sub-tab

The Spacing sub-tab defines the spacing between lines (Interline option) and between
letters (Tracking).
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Example with an interline of 1.5 and a tracking of 15:

Background Sub-tab

The Background sub-tab is used to apply a color background in the text area.

Example with a light orange background with 50% opacity:

Adding Graphics

Prerequisite

Provided that theEnable Import Picture option has been enabled in XedioManager
(Software > Parameter Profiles > CleanEdit > Cg), an Import Picture button is displayed
at the bottom of the Text Properties tab.
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How to Add Graphics

1. Click the button.

The KM Importer Dialog bow opens:

2. Click theBrowse button to select the picture file (.tif) to import.

3. Associate aMedia Class to the picture from theMedia Class field

4. Press OK.

The picture is added to the Video Display:

Note that the picture cannot bemoved or resized once imported.
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11.3.5. Working with Template of Text and
Graphics

Saving a Template of Character Generator Page
To save a template, proceed as follows:

1. Click the button

The Save As Template dialog box opens

2. Enter a Name in the Label field.

3. Associate a Class to the template from theClass field.

4. If required, assignMetadata from theMetadata button.

5. Click theSave & Publish button.

The template name is available from the Base Template list in the Text Properties tab.

Templates are stored in the database and are listed in theMediaManager, under the CG
template category.
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Applying a Template
You can apply a saved text & graphics template to a Character Generator page being
created in one of the following ways:

• select it from the Base Template list in the Text Properties tab

• select it in theMediaManager and drag it onto theMedia Pane bin and then drag it
onto the Text properties tab:

Text and graphics are then automatically applied to the page.
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11.3.6. Applying a Transition Effect to the CG Area
During playout, the text and graphics can appear and/or disappear without transition or
with a Fade transition effect. This is defined from the Page List tab.

To define the effect for the IN point of the CG area, select it in the In effect field from the
Properties group box.

To define the effect for the OUT point of the CG area, select it in theOut effect field from
the Properties group box.

With a Fade effect, you will have to set its duration in the correspondingDuration field.

11.3.7. Checking the Integrated Text and Graphics
You can check the result of the text and graphics integration by playing the edit from the
Player area.

To place the nowline on a specific tag, select it in the tag list from the Page List tab and
select the Jump to in or the Jump to out radio button. This will place the nowline on the
first frame or on the last frame of the tag area.

When a fade effect is defined, selecting theOutside transition FX option will place the
nowline within the tag area, on the first frame after the In effect (jump to in) or before the
Out effect (jump to out).

Example: Jump to Out without the Outside transition FX option
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Example: Jump to Out with the Outside transition FX option

11.3.8. Importing a Subtitle File

Introduction

Subtitles files can be imported into CleanEdit and associated to an edit from the Character
Generator tool (Text tab).

The file must contain the information of the start timecode (TC IN) and the end timecode
(TC OUT) of each subtitle sentence and the subtitle text. An empty linemust be inserted
between each set of subtitle information. Such a subtitle set is considered as a CG tag in
CleanEdit.

The first timeline frame is considered to be at timecode 00:00:00:00. So, TC IN and
TC OUT of each subtitle is calculated relatively from this timeline start timecode.

Supported File Format and Example
The supported file format must be UTF-8 coded and in the form of:

TC IN - TC OUT CRLF
Text line 1 CRLF
Text line 2 CRLF
CRLF

The Subtitle Edit software can be used to generate files in a format supported by
CleanEdit.

Here is an example of the way subtitles must be written in the file:

00:28:41:17 - 00:28:45:09
Subtitle 1 Sentence 1
Subtitle 1 Sentence 2
[empty line]

00:28:45:13 - 00:28:48:06
Subtitle 2 Sentence 1
Subtitle 2 Sentence 2
[empty line]
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00:28:48:10 - 00:28:50:20
Subtitle 3 Sentence 1
Subtitle 3 Sentence 2
[empty line]

00:28:50:24 - 00:28:53:06
Subtitle 4 Sentence 1
Subtitle 4 Sentence 2

Prerequisites
• TheEnable Subtitle File Import settingmust have been selected in XedioManager

(Softwares > Parameter Profiles > CleanEdit > Cg) for the Import Subtitle File
button to be displayed.

• A template of text properties (font, style, ...) must have been defined as described in
section "Saving a Template of Character Generator Page" on page 223.

Limitations and Constraints
• It is not possible to use any other CleanEdit function during the file import.

• No check, such as edit check, should be performed during the import.

• No update of timeline or list and no backup should be performed during the import.

• The subtitle file import cannot be undone with the Undo function.

How to Import a Subtitle File
To import a subtitle file into an edit, proceed as follows:

1. On the Page List sub-tab of the Text tab, click the Import Subtitle File button.

The Subtitle File Import window opens:

2. Select a template of text properties in the Template field.

3. Click theBrowse button next to the Filename field to select the subtitles file.

4. Click OK.
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Each subtitle set is displayed as CG tags in the Page List sub-tab and in the timecode bar
above the timeline.

Checking the Imported Subtitles in the Edit
You can check the result of the subtitles integration by playing the edit from the Player
area.

11.3.9. Editing the Character Generator Page
Properties

Editing Area Duration

How to Edit a Tag Area Duration

1. Select the tag in the tag list from the Page List tab

2. Modify the duration in theDuration field from the Properties group box

3. Press ENTER.

How to Remove the Mark OUT of a Tag

1. Select the tag in the tag list from the Page List tab

2. Select theNo Out option
The corresponding text and graphics will then be applied until the end of the edit.
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Editing Page Properties

How to Edit the Properties of the Text Area

1. Double-click the selected tag in the tag list from the Page List tab

The Text Properties tab opens. Text area(s) related to the current tag are surrounded
with a thin black line.

2. Double-click in the text area.

3. Modify the required properties.

4. Click the button.

How to Modify the Selected Picture

• Browse for a new picture from the Import Picture button

OR

• Select None from theBackground Picture field to un-assign picture.

Possible Actions from the Page List Tab
When you right-click a tag line in the Tag List from the Page List tab, the following
contextual menu is displayed:

Menu Item Meaning

Enable Enables the selected tag if it has previously been disabled.

A is displayed next to the tag number in the tag list.

Disable Disables the selected tag area, so it will not be displayed during edit
playout.

A is displayed next to the tag number in the tag list.

Duplicate Duplicates the selected tag area and places the new tag area just after
the selected one.

Delete Deletes the selected tag area.

Note
CG tags can be quickly duplicated somewhere else in the timeline, like a
tag. See section "Duplicating a Tag" on page 213.
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12. Header Maker

12.1. Introduction
The Header Maker tab provides a tool to insert a still clip at the beginning of an edit. This
still is created automatically and is based on information defined in a XML file. Besides
this predefined information, you can also enter custom information (like feed, location,
source, audio) in the Data editing area.

A specific (editable) profile describes the way in which the still clip has to be generated
(components and positions) as well as its length in the timeline.

The Header Maker tool supports 4:3 and 16:9 edits and takes care of the video aspect
ratio.
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12.2. Header Maker Tab Overview

Illustration

The Header Maker tab contains the areas highlighted on the screenshot below:

Area Description

The table below describes the various parts of the Header Maker tab:

Part Name Description

1. Header Preview
Area

This pane also contains a data editing area.

2. Recorder Area This pane is used to browse the loadedmedia and select an
image.

3. Timeline Area This area contains the edit to which a still is added.

The Recorder area and the Timeline area are similar to the ones on the Edit tab.
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12.3. Operations
Tomanually enter data in the dedicated fields in the Data Editing area, select the field and
type the value or select a value from the drop-down list. If you want to remove the values
from these fields, click on theClear button.

By clicking on theCreate button you create the still clip at the beginning of the edit.

On this still clip you can perform a couple of operations, as you would do on any other clip
in the timeline, such as:

• Enlarging the clip,

• Reducing the clip,

• Moving the clip,

• Deleting the clip,

• Applying video clip effects,

• Adding video transitions between the still clip and an adjacent one.
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13. Final Stages in the Editing
Process

13.1. Checking the Edit
When the edit is completed it is possible to check it. Xedio CleanEdit parses the timeline
for possible errors (lack of video, for example).

If a hole is discovered a dialog box opens and gives a time reference on the timeline for
where there is no video.

If a fast motion clip is detected a dialog box opens via which you can render the fast
motion clip(s).

If you chooseNo:

• TheCheck button remains enabled, since not-rendered fast motion clips are still
present in the edit.

• TheR2B (ready to broadcast) button remains disabled.

If the edit is checked successfully, theCheck button will be disabled and the R2B (ready
to broadcast) button will be enabled.

See section "Checking the Edit" on page 16 for more information.
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13.2. Playing Out an Edit

13.2.1. Introduction
You can play out an edit from two different "locations":

• from the Xedio CleanEdit application, via the Playout tab.

You use such a solution when you want to playout some edits (or a clip or edit)
individually.

This section will cover the playout from Playout tab.

• from the Xedio Playout Organizer.

You use such a solution when you want to manage several edits in your playout,
and/or when a dedicated playout server is installed on your setup.

This section is covered in the Playout Organizer user manual.

You can obviously not use both playout solutions at the same time on the samemachine.

Note
The playout option is available only on workstations equipped with an EVS SDI
output board (PCX2 or PCX3).

13.2.2. Playout Process from the Playout Tab

1. Activating the Playout tab:

Move themouse pointer over the Playout tab

2. Preloading the edit:

You can play an edit whether it is ready to broadcast or not.

To preload the edit for the playout, select the edit from the Edit zone in the Projects
area and drag it anywhere onto the Playout tab work area.

The edit is ready to be played out.
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3. Playing the edit:

To play the edit, you can directly use the usual control commands available on the
right part of the window.

See section "Playout Tab" on page 235 for more information on the Playout tab.

For each clip that is part of the edit, if the corresponding hi-res media file is missing, the
system will access the corresponding proxy file. The proxy image will automatically be
resized tomatch the hi-res resolution and the proxy file will be processed as the hi-res file
would be, regarding the effects, overlapping graphic layers and transitions.

13.2.3. Playout Tab

Overview

Illustration

The Playout tab contains the areas highlighted on the screenshot below:

Area Description

The table below refers to the sections where the various parts of the Playout tab are
detailed:

Part Name Description

1. Information Zone See section "Information Zone" on page 236.

2. Control Zone See section "Control Zone" on page 236.

3. Media Bar See section "Media Bar" on page 237.
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Information Zone
The information zone displays general details of the edit (like type, label, system,
duration, date).

The text field below this general information shows a log confirming when the edit was
loaded correctly and is ready for playout.

Control Zone
The buttons in the control zone allow you to:

Go to the beginning of the edit

Preload the edit

Play the edit

Stop the edit

Go to the previous frame

Go to the next frame

The following functions are available:

Item Description

Goto Timecode Entering a timecode value in this field allows to jump to this
specific timecode.

Start Timecode Entering a timecode value in this field allows the edit to be
played out from this specific timecode.

Enable Play Shuttle When this option is selected, the Play function can be
activated from the Shuttle Pro.

Stop Warning If this option is selected when you click Play and thenStop, a
warningmessage is displayed:
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Media Bar
The video will be visible on the SDI output of Xedio CleanEdit.

TheMedia Bar displays the following information:

• a progress indicator (blue vertical line), which shows the current playout position.

• On the left, the time elapsed from the beginning of the edit up to the current playout
position.

• On the right, the duration from the current position until the end of the playout.

13.3. Exporting an Edit or a Media

13.3.1. Introduction
Once your edit is finalized, you can export it to multiple destinations and inmultiple
formats at the same time.

Xedio CleanEdit makes it possible to export the final edit/media to various destination
types. The Export tab provides four subtabs, for each destination type:

• to Xedio

This allows you to consolidate an edit/media and store it as a single clip in the Xedio
storage system and Xedio database.

• to File

This allows you to export an edit/media to a file that can be read by an external
system.

• to Device

This allows you to export an edit/media to an external device, either a video tape
recorder (XDCAM, XDCAM SxS or P2), or to an EVS server.

• to Target

This allows you to export an edit/media according to a predefined Export Target profile
(RTProf) or to a predefined Xsquare target.
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13.3.2. Exporting to Xedio, to File, to Device

Overview of the To Xedio, To File, To Device
Subtabs

Illustration

The To Xedio, To File and To Device subtabs present a similar layout with threemain
areas. These areas are highlighted on the screenshot below for the To Xedio sub-tab:
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Area Description

The table below describes the various parts of the Export tab, for the To Xedio, To File and
To Device subtabs:

Part Name Description

1. Information
Zone

This zone displays general details on the edit/media (like type,
label, creation date, TC IN, duration) to export.

2. Destination
Zone

This zone defines the properties of the export, such as
transcoding codec. The properties differ between the sun-tabs.
See section .

3. Export
Information
Zone

This zone is used to initiate the export process.
See section "Setting the General Export Properties" on page 244.

How to Export an Edit or Media to Xedio to File or
to Device
To export an edit or amedia to Xedio, to a file or to a device, proceed as follows:

1. Select the To Xedio, To File or To Device subtab from the Export tab.

2. Add an edit or amedia to the subtab by drag-and-drop operation from the Projects
zone:

The edit or media information is displayed in the Export tab.
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3. Set the export properties specific to the selected destination from the Destination
zone.

4. Set the general export properties. See section "Setting the General Export Properties"
on page 244.

5. Click Start at the bottom of the Export tool.

The export process begins and a progress bar allows the user to monitor the progress of
the process.

At the end, amessage informs the user that the process has been successfully
completed:

Note
"40% playout rate" means that the encoding process was 40% slower than real
time (100% means real-time, 200% means 2 times faster than real time).

Setting the Export Properties To Xedio
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To consolidate an edit and store it as a single clip in the Xedio storage system and Xedio
database, complete the following fields before clicking on theStart button. The rendering
process allows creating hi-resolution files and lo-resolution files, if desired, in one step.

Field Description

Label Name you give to the exported edit/media (mandatory)

Shooting Date Date you can assign to give indication on when the edit/media
has been rendered.

Class Class categorizing the edit/media as defined in the Class
Manager.

Publish Allows other users to see the exported edit/media.

External Ref Reference which can help to identify the edit/media such as a
barcode from a VTR tape.

Description Optional text to describe the edit/media.

Low-res transcoding
codec

Low-res file type for the final exported edit/media.
See the corresponding Release Notes document for the
comprehensive list of supported rendering codecs and
formats.

Hi-res transcoding
codec

Hi-res file type for the final exported edit/media.

Additional
Parameters

This window can be reached by clicking the button in the
Transcoding Codec zone.
This allows you specify parameters for the new file, such as
clip name, keywords, UmID or VarID.

Click theConfig button to open the Config window where you can specify the hi-
res and low-res media servers to send the edit to:
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Setting the Export Properties To File

To export an edit/media to a file that can be read by an external system, complete the
following fields before clicking theStart button.

Field Description

Label Name you give to the exported edit/media (mandatory).

Folder Destination folder where you want to export the edit/media to.

Transcoding
Codec

Codec profile, which will determine the final format of the
edit/media in the destination folder.

Additional
Parameters

This window can be reached by clicking the button in the
Transcoding Codec zone.
This allows you to specify parameters for the new file, such as
clip name, keywords, UmID or VarID.

Rendering from
Low-res

When selected, the edit is rendered from the low-res file. This
can save some time.
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Setting the Export Properties To Device

To export an edit/media to an external device, such as a XDCAM disk, a SxS card, a P2
card or an EVS server, select the device type (XDCAM, SxS, P2 or EVS XT) and
complete the fields described in the table below, beforte clicking theStart button.

Field Description

Common Fields

Label Name you give to the exported edit/media (mandatory).

Transcoding Codec Codec profile, which will determine the final format of the
edit/media in the destination folder.
The available codecs depend on the type of device selected.

Additional
Parameters

This window can be reached by clicking the button in the
Transcoding Codec zone.
This allows you to specify parameters for the new file, such as
clip name, keywords, UmID or VarID.
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Field Description

To Device EVS XT

XFile Gateway Name of the hardware device hosting the XFile application
used to transfer the edit/media.

XT nr, Page, Cam XT number, page and camera to send the edit/media to.

To Device XDCAM, SxS or P2

Local Drive Location where the edit/media will be sent to.

Setting the General Export Properties
The following settings are available at the bottom of the To Xedio, To File and To Device
sub-tabs:

Item Description

Start
Timecode

You can specify the edit/media timecode from which the export process
will begin.

Enable
Video View

When selected, a small video view is displayed during the export
process:

Config
Button

Available only in the To Xedio tab.
This opens a Config window where you can specify the hi-res and low-
res media servers to send the edit to:

When you click theStart button, the export process begins and a progress bar allows the
user to monitor the progress of the process.
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At the end, amessage informs the user that the process has been successfully
completed:

Note
"71.4% playout rate" means that the encoding process was 71,4% slower than
real time (100% means real time, 200% means 2 times faster than real time).
71,4% means that the encoding process of a 1min edit takes about 1min 30
sec.

13.3.3. Exporting to Target

Introduction
The To Target subtab is used to export an edit/media according to a predefined Export
Target profile (RTProf) or to a predefined Xsquare target.

An Export Target Profile (also called "RTProf") is an .xml file that contains the definition
for rendering the storyboard created in Xedio Dispatcher into a single file on a given
destination or into a clip on a given EVS server.

The Export Target Profile mainly includes the definition of the destinations, and of the
codecs in which the file or clip need to be generated.

The Export Target Profiles can be defined and customized to your needs by the EVS
Project Manager. However, you can also create your own Export Target profiles using the
Target Wizard.
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Overview of the To Target Subtab

Illustration

The To Target subtab contains the areas highlighted on the screenshot below:

Area Description

The table below describes the various parts of the To Target subtab under the Export tab:

Part Name Description

1. Target field This zone lists all the available targets:
• RTProf target profiles (xml files)
• Xsquare targets available for the logged user.

2. Export list This zone provides detailed information on all the exporting tasks
that have been added to the export list in the current session by
the logged user, would they be scheduled, on-going, finished or
failed.

3. Export and
Monitoring
buttons

This zone provides buttons to initiate or cancel the export
process, to clear the Export list.
TheMonitor button is used tomonitor the Export status.
See section "Monitoring the Export Process to a Target" on page
248 and See section "Monitoring Tasks" on page 248.
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How to Export to Target
To export an edit or amedia to a predefined target, proceed as follows:

1. Select the To Target subtab from the Export tab.

2. From the Target field, select an export target profile (RTProf) or an Xsquare target.

3. Add an edit or amedia to the To Target subtab by drag-and-drop operation from the
Projects zone to the subtab.

The edit or media name is added to the list of export jobs.

4. Click Start at the bottom of the tab.

The edit or media is exported as defined in the selected target profile.

The progress of the export job to an RTProf target is displayed in the List of export jobs:

The edits or media added to the list will remain available in the list, whether they have
been exported or not, until the end of the user session.

The progress of the export job to an Xsquare target can bemonitored by clicking the
Monitoring button.

Other Possible Actions on Export Jobs

Deleting an item in the list of export jobs
Right-click the item in the list that you want to remove, and select Delete Selected Item
from the contextual menu

OR

Select the item and press theDelete key.

Clearing the list of export jobs
To clear the list of export jobs, already exported or not, click theClear List button at the
bottom of the Export Tool area.

It does not clear the output of export jobs stored on the various destination folders.

Moving an item in the list of export jobs
Tomove an item within the export list, drag it to required position. A thin red line indicates
the drop position.
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Renaming an item in the list of export jobs
To rename an item within the export list, select theName field and type a new name.

Monitoring the Export Process to a Target
TheMonitor button is used tomonitor the export status.

TheMonitoring window contains several tabs:

• one tab per Xsquare server, provided that Xsquare servers have been configured from
XedioManager.

• one tab for the Task Engine, provided that a Xedio Task Engine has been configured.

13.4. Monitoring Tasks

13.4.1. Introduction
The Task Viewer is used tomonitor the tasks sent to the TaskEngine by the user logged
on the CleanEdit workstation.

Only the tasks related to the user logged are displayed.

13.4.2. User Interface

Overview of the Task Viewer
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Tasks Grid
The Task grid displays the list of all the tasks and their associated data.

The columnwidth can be adjusted using standard computer commands.

TheMachine column displays the IP address of the Task Enginemachine handling the
task.

The tasks can be sorted in ascending or descending order by clicking the header of a
column.

Task Contextual Menu
A contextual menu is available when you right-click on an item in the grid.

Menu Item Description

Expand all Groups Expands all the tasks and displays them on several lines.

Collapse all Groups Displays only one line per task.

Properties Opens the Task Properties dialog box. It displays all the
information from the database regarding the selected task.

Reload all Reload all the tasks from the database.

Display Setup Opens the Display Setup dialog box.

13.4.3. Filtering Tasks
Different filers can be applied to restrict the list. Filters are available from the Display
Setup dialog box. Right-click in the list and select Display Setup to open it.
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State Selection

Selecting one, or several, of the options will restrict the list of tasks to the ones with the
corresponding status.

By default, all values are checked.

Date Selection

The date range allows you to filter tasks on their creation dates.

By default, the fields are empty.

Max Items

This value defines themaximum items to be displayed in the grid. Once this value has
been reached, the oldest item disappears from the list so only the lore recent items are
shown.

Machine IP Address

This field allows you to filter tasks based on the IP address of the Task Enginemachine
handling them.

Several IP addresses can be entered andmust be separated with “;”.

By default, the field is empty.
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14. Appendix 1 – ShuttlePRO
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15. Appendix 2 – Keyboard
Shortcuts
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16. Appendix 3 – Digigram Hardware
Settings

Settings for a Stereo Board
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Settings for a 5.1 Board
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